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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and 
networks. Systems, machines and components should only be connected to the enterprise 
network or the internet if and to the extent necessary and with appropriate security measures 
(e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit:

http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends to apply product updates as soon as available and to always 
use the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under

http://www.siemens.com/industrialsecurity.

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 9



Security information

Maintenance Station
10 Function Manual, 05/2017, A5E41291135-AA



Preface 2
Purpose of this documentation           

This documentation informs you about the software components, areas of application, 
configuration options and commissioning of Maintenance Station for SIMATIC PCS 7.

It answers the following key questions:

● What is the Maintenance Station?

● What software components belong to the Maintenance Station?

● What hardware and software requirements apply and which licenses are required for 
installation?

● What are the intended areas of application for the Maintenance Station?

● How are diagnostics performed with the Maintenance Station?

● What are the intended areas of application for the Maintenance Station for the various 
versions?

Maintenance Station
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Options for accessing PCS 7 documentation
The documentation required for PCS 7 includes the following types:

● PCS 7 Readme
The readme file is available in two versions:

– PCS 7 Readme (offline)
This version is installed by PCS 7 Setup. The file only contains general information and 
links to documents on the Internet.

– PCS 7 Readme (online)
This is the version which contains all information on the installation and use of PCS 7 
in the format you are already familiar with. The file is only available on the Internet so 
that we can keep it up to date. 

Note

The information provided in the PCS 7 Readme (online) on the Internet takes 
precedence over all other PCS 7 documentation. 

Please read this PCS 7 Readme carefully; it contains important information and 
amendments on PCS 7.

● PCS 7 System Documentation
System documentation includes documents that cover several products, such as 
configuration manuals and Getting Started manuals. This documentation serves as a 
guideline for the overall system and explains the interaction between the individual 
hardware and software components.
Read the information on "PCS 7 Documentation Portal Setup" in the product overview 
Process Control System PCS 7; PCS 7 Documentation; section "Options for accessing the 
documentation".

● PCS 7 Product Documentation
Product documentation contains information about specific hardware and software 
components. The individual documents provide detailed information on the specific 
component.

Full versions of the documentation are available from the "Technical Documentation SIMATIC 
PCS 7" website:
www.siemens.com/pcs7-documentation (http://www.siemens.com/pcs7-documentation)

You can find additional information in the product overview Process Control System PCS 7; 
PCS 7 Documentation; section "Options for accessing the documentation".

Required basic knowledge
This documentation is aimed at anyone who is involved in configuring, commissioning and 
operating automated systems based on SIMATIC PCS 7.

A certain amount of basic knowledge is assumed and readers are expected to know how to 
use a PC/PG and the Windows operating system in general. You should be familiar with the 
SIMATIC PCS 7 functions and configurations.

Preface
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This manual assumes that users are familiar with the following knowledge from the specified 
manuals:

● Process Control System PCS 7; Engineering System
● Process Control System PCS 7; Operator Station
● Process Control System PCS 7; OS Process Control

Conventions
In this documentation, the names of elements in the software interface are specified in the 
language of this documentation. If you have installed a multi-language package for the 
operating system, some of the designations will be displayed in the base language of the 
operating system after a language switch and will, therefore, differ from the designations used 
in the documentation.

Preface
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Using the Maintenance Station 3
3.1 Application, version and configuration

Application   
Maintenance Station focuses on "Plant Asset Management" and enables preventive and 
predictive diagnostics and maintenance of the plant. 

In parallel with process control, the Maintenance Station makes available consistent 
maintenance information and functions for the system components (assets).

While the plant operator receives all process-relevant information and can intervene selectively 
in the process via the operator system (OS), the maintenance engineer inspects the 
automation system hardware and processes the associated diagnostic messages and 
maintenance demands via the Maintenance Station.

The basis for a Maintenance Station is always an OS that provides this maintenance 
functionality. 

The OS that has maintenance functionality and the mode in which the Maintenance Station 
that is operated is determined in the plant hierarchy of the SIMATIC Manager.

You can find basic information on engineering, configuration and process control in the 
following documentation:

● Process Control System PCS 7; Engineering System
● Process Control System PCS 7; Operator Station
● Online help for WinCC

Versions         
The Maintenance Station can be used in the following versions:

● Maintenance Station Basic (integrated in the PCS 7 project)

– Is referred to as MS Basic in the document    

● Maintenance Station Standard (integrated in the PCS 7 project)

– Is referred to as MS Standard in the document    

● SIMATIC PDM Maintenance Station (stand-alone project)

– Referred to as SIMATIC PDM MS in the document    

Note

If you are running a Maintenance Station in the plant, the sign-of-life monitoring with "Lifebeat 
Monitoring" must be disabled.

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 15



Differences between the versions
The following table shows differences.

 MS Basic MS Standard SIMATIC PDM MS
Information dis‐
played

● Overview screen
● Area overview screen

– AS/system
– Network objects
– PC stations

● Status information of the 
individual components

● Overview screen
● Area overview screen

– AS/system
– Field devices
– Network objects
– PC stations
– User objects

● Status information of the 
individual components

● Detailed information on 
individual components

● Hierarchical picture structure
● Global functions
● Component-specific functions

● Overview screen
● Area overview screen

– Field devices
– Network objects (optional)
– PC stations (optional)

● Status information of the 
individual components

● Detailed information on 
individual components

● Hierarchical picture structure
● Global functions
● Component-specific functions

Generation of 
the diagnostics
structure

Automatic generation from the SIMATIC PCS 7 hardware project Automatic generation
from the SIMATIC PDM stand-
alone project (network view)

Setup of the di‐
agnostics
structure

● Area overview screen
– AS/system
– Network objects
– PC stations

● Symbolic representation of 
the components with 
diagnostic status

● No hierarchical picture 
structure

● No calling of faceplates

● Area overview screen
– User objects
– AS/system
– Field devices
– Network objects
– PC stations

● Symbolic representation of the 
components with diagnostic 
status

● Hierarchical screen structure for 
AS/system components

● Hierarchical screen structure for 
field components

● Hierarchical picture structure for 
user components

● Calling of faceplates

● Area overview screen
– Field devices
– Network objects (optional)
– PC stations (optional)

● Symbolic representation of the 
components with diagnostic 
status

● Hierarchical picture structure 
for field bus components with 
connected field components

● Calling of faceplates

Message
 assignment

Area by area Component by component

Diagnostics
 update

● Cyclically by the system
● Event-driven

● Cyclically by the system
● Event-driven
● Manual
● Cyclic polling

● Manual
● Cyclic polling

Using the Maintenance Station
3.1 Application, version and configuration
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 MS Basic MS Standard SIMATIC PDM MS
Detailed 
information (1)

Not available ● Electronic rating plate 
(identification data)

● Component-related messages
● Detailed information in 

accordance with SNMP profile
● Component status in 

accordance with EDD 
information (3)

● Detailed information in 
accordance with EDD 
information

● User notes
● Redundancy status
● CPU utilization/

cycle utilization
● Calling device-specific 

condition monitoring functions 
(e.g. Diagnostics Monitor)

● Electronic rating plate 
(identification data)

● Component-related messages
● Detailed information in 

accordance with SNMP profile 
(optional)

● Component status in 
accordance with EDD 
information

● Detailed information in 
accordance with EDD 
information

● User notes
● Calling device-specific 

condition monitoring functions 
e.g. Diagnostics Monitor 
(optional)

Components 
with diagnostics 
capability

You can find additional information about this in the section "Components with diagnostics capability 
(Page 18)".

Global functions Not available ● Complete export of electronic rating plate including maintenance 
status of all components

● Filter functions in relation to the component state or component 
selection

● Filter functions in relation to contents of the electronic rating plate
● Manual/cyclic parameter data export 
● Use of standard functions of the PCS 7 Operator Station, e.g. report 

generation in process control
● Parameter synchronization for field devices
● Export of parameters and status data of selected components for 

further processing in the higher-level EAM systems.
Component
-specific func‐
tions (2)

Not available Calling HW Config online Not available
Call
● Component-specific Web portals
● Web portals configured in Engineering
● SIMATIC PDM for EDD-based components
● Diagnostics Monitor for IPC objects

Licenses Not required Quantity and function-dependent

(1) Dependent on component used

(2) Dependent on component type used and use of an MS Client in the multiple-station system.

(3) Electronic Device Description

In the rest of the documentation, any differences are pointed out. 
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Configuration   
The MS Basic and MS Standard versions of the Maintenance Station can be configured as 
MS single-station system or as MS multiple-station system.

You can find more information on this in the sections "MS single station system (Page 25)" 
and "MS multiple station system (Page 26)".

SIMATIC PDM MS can only be configured as an MS single-station system.

You can find additional information about this in the section "SIMATIC PDM MS (Page 30)".

Operating and monitoring on a PCS 7 Web client     
You can use a PCS 7 Web client to operate and monitor an MS single-station system and MS 
multiple-station system. Any existing limitations are described in the respective sections of the 
manual.

Note

This function is not available for SIMATIC PDM MS.

3.2 Components with diagnostics capability

Which components can be monitored? 
The components with diagnostics capability are displayed in the process control in the areas 
subordinate to the diagnostics area.   

The area-specific tables show examples of which components can be monitored with which 
version of the Maintenance Station:

● "PC stations" area (Page 19)

● "Network objects" area (Page 20)

● "AS/System" area (Page 20)

● "Field devices" area (Page 22)

● "User objects" area (Page 24)

Where is the information displayed?
You can find information on the states of individual PCS 7 components with diagnostic 
capability in the Maintenance Station diagnostics screens.

The diagnostics screens only display data made available by the component or the project.

You can find information on the diagnostics screens in the section "Operator control and 
monitoring (Page 105)".

Using the Maintenance Station
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3.3 "PC stations" area

Which components are monitored?

Diagnostics for ... MS Basic MS Standard SIMATIC 
PDM MS

● Siemens industrial PC, for example
– Operator stations
– BATCH stations
– Route Control stations
– Process Historian
– SIMATIC PCS 7 BOX

● Premium Server for SIMATIC PCS 7 / 
PCs from third-party suppliers

X - 

What is monitored?

Monitored components Constraints and displayed information
Siemens Industrial PC (IPC) with Diagnostics Monitor 
diagnostics program configured for the IPC (ES, serv‐
er, client, other computers) and available via SNMP

● Monitoring for failure
● Fan speed with limit values
● Hard disk utilization with CCPerfmon limit 

values
● Redundant power supply
● Temperature, CPU, Board, etc.
● Failure of a hard disk using RAID1
● Failure of a connection
● OS deactivated
● Terminal adapter failure
● Watchdog
● Revision alarm

Premium Server for SIMATIC PCS 7 via SNMP
PC from third-party supplier via SNMP

● Identification data according to the SNMP 
profile MIB-II

● Monitoring for failure
PC from third-party supplier without SNMP ● Identification data via WMI monitoring for 

failure

Using the Maintenance Station
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3.4 "Network objects" area

Which components are monitored?

Diagnostics for ... MS Basic MS Standard SIMATIC 
PDM MS

● Switches, e.g. SCALANCE
● OSM
● ESM
● Other components that support SNMP services

e.g. printers, bridges, routers

X - 

What is monitored?

Monitored components Constraints and displayed information
● Scalance Produkte der Familien

X200, X200 RNA, XB200, XC200, XF200, XP200, 
X300, X400, XM400, X500, W700; W700 ab 
Firmware 6.1

● OSM/ESM

● Group fault for monitoring the power supply 
error (red. supply)

● Port error
● Ring redundancy error
The monitoring functions must be enabled in 
the components.

Other components that support SNMP services
e.g. printers, bridges, routers

Monitoring for failure, with support of the SNMP 
profile MIB-II

3.5 "AS/System" area

Which components are monitored?

Diagnostics for ... MS Basic MS Standard SIMATIC 
PDM MS

● SIMATIC S7-4xx series CPU
● CP in central section
● WinLC RTX of a SIMATIC PCS 7 BOX
● SIMATIC PCS 7 central processing units
● Interface module (IM) of the ET 200 series

(ET 200M, ET 200S, ET 200SP, ET 200iSP, 
ET 200pro, ET 200SP HA)

● Link modules 
(DP/PA-Link, Y-Link, FF Link, Compact FF Link)

X -

Using the Maintenance Station
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What is monitored?

Monitored components Constraints and displayed information 
SIMATIC S7-4xx series CPU ● Diagnostics information on CPU utilization

● Utilization OB3x, OB8x and OB1
● Reduction ratio of the OB3x in cases of 

overload
● Display of the electronic rating plate based 

on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status
● Diagnostic buffer
● LED display
The information is dependent on the firmware 
version of the CPU.

CP in central section ● Display of the electronic rating plate based 
on the PNO specification
If data cannot be read from the 
components, the data (if any) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status
● Diagnostic buffer

WinLC RTX of a SIMATIC PCS 7 BOX ● Display of the electronic rating plate based 
on the PNO specification
If data cannot be read from the 
components, the data (if any) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status
● Diagnostic buffer
● LED display

SIMATIC PCS 7 central processing units/
Interface module (IM) of the ET200 series/
Link modules

● Display of the electronic rating plate based 
on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status

Using the Maintenance Station
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3.6 "Field devices" area

Which components are monitored?

Diagnostics for ... MS Basic MS Standard SIMATIC 
PDM MS

● Interface module (IM) of the ET 200 series
● Input and output modules of the ET 200 series
● Link modules
● PROFIBUS devices
● PROFINET devices
● Field devices (HART, PROFIBUS PA, ...)
● Diagnostics-capable coupler
● Compact Field Unit (CFU)

-
 
 

X
   
 

  X(1)

● Fail-safe modules
● Diagnostic repeaters
● EDD objects that can be detected by SIMATIC 

PDM

-

(1) Diagnostics described by the EDD

What is monitored with the "MS Standard" version?

Monitored components Constraints and displayed information 
SIMATIC PCS 7 standard I/O ● Display of the electronic rating plate based 

on the PNO specification
If data cannot be read from the 
components, the data (if any) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status

PROFIBUS DP/PA field devices (integrated via EDD) ● Detailed device-specific/EDD-based 
diagnostics

● Display of the electronic rating plate based 
on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status
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Monitored components Constraints and displayed information 
FF field devices (integrated via EDD) ● Process access via APL channel blocks

● Detailed device-specific/EDD-based 
diagnostics

● Display of the electronic rating plate (I&M 
data)

● Detailed error messages
● Detailed maintenance status

PROFIBUS DP/PA standard slaves (field devices in‐
tegrated via GSD)

● Failure monitoring
● Display of the electronic rating plate based 

on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Maintenance status "Good" and 
"Maintenance alarm"

PROFINET standard slaves (field devices integrated 
using GSDML)

● Failure monitoring
● Display of the electronic rating plate based 

on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Maintenance status "Good" and 
"Maintenance alarm"

HART field devices (integrated via EDD into SIMATIC 
PCS 7 standard I/Os)

● Detailed device-specific/EDD-based 
diagnostics

● Display of electronic rating plate (based on 
specification of 
HART Communication Fundation - HCF)

● Detailed error messages
● Detailed maintenance status
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Monitored components Constraints and displayed information 
SIMATIC TIA objects ● Failure monitoring

● Display of the electronic rating plate based 
on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Maintenance status "Good" and 
"Maintenance alarm"

SIMATIC PCS 7 add-on objects (field devices inte‐
grated via EDD)

● Detailed device-specific/EDD-based 
diagnostics

● Display of the electronic rating plate based 
on the PNO specification
If data cannot be read from the 
components, the data (if existing) from the 
project is displayed.

● Detailed error messages
● Detailed maintenance status

What is monitored with the "SIMATIC PDM MS" version?

Monitored components Constraints and displayed information
Field devices ● PROFIBUS DP/PA field devices (integrated 

via EDD)
● PROFIBUS DP/PA Remote I/Os 

(integrated via EDD)
● Ethernet field devices (integrated via EDD)
● HART field devices (integrated via EDD)
● Wireless HART field devices (integrated via 

EDD)
● Modbus field devices (integrated via EDD)

3.7 "User objects" area

Which components are monitored?

Diagnostics for ... MS Basic MS Standard SIMATIC 
PDM MS

User objects for which diagnostics can be generated 
by an application

- X - 
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What is monitored?

Monitored components Constraints and displayed information
User objects ● Not communicative accessible components

● Indirect diagnosed objects
● Results of state monitoring functions
● Components from the process device 

network view that are not configured in HW 
Config, e.g., wireless HART field devices

3.8 MS single station system

MS single-station system in the OS single-station system
The maintenance station is operated on the engineering station.

Plant configuration       
The MS single-station system has the following functionalities:

● Operator station (OS)

● Engineering station (ES)

● Maintenance Station (MS)

● SIMATIC PDM

The complete operator control and monitoring functionality for a PCS 7 project (plant/unit) is 
located in one station. The OS areas and the "Diagnostics" area of the MS are displayed in 
the overview area of the process control. 

The "Diagnostics" area visualizes the diagnostics state via diagnostics screens, providing the 
required operator control and monitoring functions.

The MS single-station system on the plant bus can be used in parallel with additional single-
station or multiple-station systems. 
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Plant configuration
The figure below shows an example plant configuration.

Rule
The maintenance station is disabled during configuration.

Software and licensing
If monitoring of intelligent field devices is required, install the SIMATIC Process Device 
Manager product with the SIMATIC PDM Server and SIMATIC PDM Logon options on the 
engineering station.

You can find more information on software in the manual Process Control System PCS 7; PCS 
7 PC Configuration.

For information on the current graduated licenses available for the various components of the 
process control system and the correspondingly plant sizes that can be realized, refer to the 
installation manual Process Control System PCS 7; Licenses and Quantity Structures.

3.9 MS multiple station system

MS multiple-station system in the OS multiple-station system
In distributed systems, the maintenance station is integrated into a client/server architecture.
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Plant configuration         
The MS server 

● Either configured on a separate PC station or on a PC station together with the OS server

● Can be configured redundantly

● Processes the process control messages which are visualized on the OS/MS client and/or 
MS client

● Can monitor network components via the OPC server at the plant bus if there is a connection 
to the plant bus

The MS client can be configured as follows:

● MS client on a PC station
The MS client visualizes the diagnostic status in the diagnostic area using diagnostic 
screens and provides the required operator control and monitoring functions.

● MS client and OS client on a PC station (OS/MS client)
The OS/MS client has the same functionality as an MS client on a PC station and the same 
functionality as an OS client.
In addition to the diagnostic area, the overview visualizes the technological areas for 
process control.

● MS client on the engineering station
The MS client on the engineering station has the same functionality as an MS client on a 
PC station.
In addition, the online view of the hardware configuration editor can be opened.
The MS client that is operated on the engineering station is disabled during configuration.

Using the Maintenance Station
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Plant configuration
The figure below shows an example plant configuration.

Required server data   
● On the MS or OS/MS client

You can find information on this in the section "Assigning the server data and downloading 
of a client (Page 96)".

● On the MS server
The server data of all OS servers in the multiproject/project are automatically downloaded 
to the MS server when the diagnostics structure is generated.

Software and licensing
If intelligent field devices have to be monitored, install the SIMATIC Process Device Manager 
(SIMATIC PDM) on the engineering station.

You can find more information on the software in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

For information on the current graduated licenses available for the various components of the 
process control system and the correspondingly plant sizes that can be realized, refer to the 
installation manual Process Control System PCS 7; Licenses and Quantity Structures.
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3.10 MS in plant configuration with multiple OS single-station systems

Plant configuration with multiple OS single-station systems
Configurations with OS single-station systems are possible in SIMATIC PCS 7.

The figure below shows an example of the configuration:

Configuration:

● 1 redundant OS single-station system (single-station system + single-station system 
standby)

● Optional: Up to 6 non-redundant OS single-station systems (as reference OS from the OS 
single-station system)

● MS as separate PC station

The MS server obtains the data from the AS over the redundant OS single-station system.

If the redundant OS single-station system is disabled, the AS data is no longer displayed.

Note

Messages generated locally on a reference OS are not displayed in the diagnostics pictures. 
Affected are e.g. messages for self diagnostics.

If the reference OS is unavailable via the terminal bus, it is visualized on the MS server, 
however.

For the diagnostic information to be displayed on the OS single-station systems, a Web server 
must be configured on the MS server.

The OS single-station system can be accessed with Web browser control.

Using the Maintenance Station
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You have two options for accessing the MS server from the OS single-station system:

● Option 1
Create a user picture on the OS single-station system in the "Graphics Designer".
Insert a "WinCC WebBrowser Control" in the user picture.
In the process control, you can access the MS via the "WinCC WebBrowser Control" in the 
user picture.

● Option 2
Launch the Web Client function via Internet Explorer.

Additional information
Process Control System PCS 7; PC Configuration manual

3.11 SIMATIC PDM MS

Plant configuration
SIMATIC PDM MS is a single-station system pre-configured as an IPC Microbox 427x. It is 
designed for stand-alone use and is independent of the automation solution used. 

The display type and functionality of SIMATIC PDM MS are similar to that of a SIMATIC PCS 
7 maintenance station. All operator control and monitoring functions are executed locally on 
this PC station.

SIMATIC PDM MS uses diagnostic screens to visualize the diagnostic status in the diagnostic 
area and provide the required operator control and monitoring functions.

The diagnostic states of field devices are determined by SIMATIC PDM. Assigned messages 
are generated in the integrated AS RTX. Both items of information are visualized on the 
SIMATIC PDM MS.
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Plant configuration
The figure below shows an example plant configuration.

SIMATIC 

S7-15xx

SIMATIC 

S7-3xx

SIMATIC 

S7-4xx

SIMATIC 

S7-4xxH

PROFIBUS DP

PROFIBUS PAPROFIBUS PA

PROFIBUS DP PROFIBUS DP

(1) When connected to high-availability automation systems, the IP protocol must be 
additionally enabled or else the ISOon TCP protocol is used

(2) As of SIMATIC PDM MS V3.0

Rule
SIMATIC PDM MS is disabled during creation or change of the project structure. 
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Software and licensing
● Provided restore software, no installation via media package

● Update and upgrade packages are provided separately for the PDM MS. 
We recommend you enter into a Software Update Service (SUS) contract.

The configuration limit of the SIMATIC PDM MS is designed for a maximum of 500 field devices. 
A license is required for each field device and each gateway component. Licensing takes is 
performed with PDM TAG licenses.

Information on the individual products is available in the documents accompanying the product 
release in the Industry Online Support:

Internet link (http://support.industry.siemens.com/cs/ww/en)
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Additional documentation 4
Additional documentation   

The following table lists documentation in which you can find additional information. All content 
of the electronic manuals (PDF) can also be found in the online help (CHM).

Documentation Purpose
Online help:
Help on PCS 7,
Configuration - Engineering System
Manual:
Process Control System PCS 7
Engineering System

The documentation supports you during configuration 
with the SIMATIC Process Control System PCS 7 on 
an engineering station.

Online help:
Help on PCS 7, Configuration - Operator Sta‐
tion
Manual:
Process Control System PCS 7
Operator Station

The documentation supports you during configuration 
with the SIMATIC PCS 7 Process Control System on 
an operator station.

Manual:
SIMATIC Logon,
SIMATIC Electronic Signature

This documentation supports you when setting up cen‐
tral access authorization administration with SIMATIC 
Logon.

Online help and manual:
Process Control System PCS 7
PCS 7 Basic Library 

This documentation describes the functions and block 
I/Os of diagnostic blocks.

Online help and manual:
Process Control System PCS 7
PCS 7 Advanced Process Library

This documentation describes the functions, block I/Os, 
and input/output fields of the associated faceplates.

Online help:
WinCC Information System

The documentation supports you in configuring the op‐
erator stations and in operating the operator stations in 
the process control.

Manual:
Process Control System PCS 7
SIMATIC PDM

This documentation offers support during installation, 
commissioning of the software, configuration of net‐
works and field devices, commissioning and using run‐
time functions.

Manual:
SIMATIC NET
S7 CPs for Industrial Ethernet (part BL1)

This documentation describes the configuration, instal‐
lation and commissioning of an IE/PB Link PN IO.

Manual
Process Control System PCS 7
Licenses and Quantity Structures

The document offers information on the latest grading 
of licenses for the different components of the process 
control system and the plant size you can achieve with 
them. 
Section "Calculating the asset tags (hardware compo‐
nents) for the maintenance station" of the document of‐
fers information on which diagnostics-capable compo‐
nents within a PCS 7 project are counted as asset tags.
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Documentation Purpose
Manual
Process Control System PCS 7 
PC Configuration

The document provides information about hardware 
and software requirements and about the configuration 
options of a PC station.

Manual
Process Control System PCS 7
Software update with utilization of new func‐
tions

The "Maintenance Station" section of the documents 
provides information on migrating a Maintenance Sta‐
tion.

Manual
Process Control System PCS 7
Software update without utilization of new 
functions 

Additional documentation
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Configuring the maintenance stations 5
5.1 MS single station system overview

The following table lists the topics that include information and configuration instructions. The 
sequence in the table corresponds to the recommended configuration sequence.   

What? MS
Basic

MS
Standard

General settings in the multiproject/project (Page 38) X X
Configuring the PC station for MS single station system (Page 39) 
Configuring the monitoring of industrial PCs and network objects (Page 54) 
Creation of the diagnostics structure (Page 60) 
Advanced diagnostics settings (Page 65) -
Configuring the user diagnostics (Page 82) 
Setting up SIMATIC PDM (Page 89) X
Overview of complete export (Page 89) 
Overview of individual export (Page 90) 
Engineering for maintenance (Page 91) -
Creating/updating the diagnostic screens (Page 93) X
Compilation and downloading of the Maintenance Station (Page 95) 
Integration by the Alarm Control Center (Page 251) -
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5.2 MS multiple station system overview

5.2.1 MS Server overview
The following table lists the topics that include information and configuration instructions. The 
sequence in the table corresponds to the recommended configuration sequence.   

What? MS
Basic

MS
Standard

General settings in the multiproject/project (Page 38) X X
How to configure a PC station for an engineering station (Page 40) 
How to configure a PC station for an MS server (Page 41) 
Configuring the monitoring of industrial PCs and network objects (Page 54) 
Creation of the diagnostics structure (Page 60) 
Advanced diagnostics settings (Page 65) -
Configuring the user diagnostics (Page 82) 
Setting up SIMATIC PDM (Page 89) X
Overview of complete export (Page 89) 
Overview of individual export (Page 90) 
Engineering for maintenance (Page 91) -
Creating/updating the diagnostic screens (Page 93) X
Compilation and downloading of the Maintenance Station (Page 95) 
Integration by the Alarm Control Center (Page 251) -

5.2.2 Redundant MS server overview
The following table lists the topics that include information and configuration instructions. The 
sequence in the table corresponds to the recommended configuration sequence.     
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What? MS
Basic

MS
Standard

General settings in the multiproject/project (Page 38) X X
How to configure a PC station for an engineering station (Page 40) 
How to configure a PC station for an MS server (Page 41) 
How to configure a PC station for the redundant partner (Page 43) 
Configuring the monitoring of industrial PCs and network objects (Page 54) 
Creation of the diagnostics structure (Page 60) 
Advanced diagnostics settings (Page 65) -
Configuring the user diagnostics (Page 82) 
Setting up SIMATIC PDM (Page 89) X

 Overview of complete export (Page 89) 
Overview of individual export (Page 90) X
Engineering for maintenance (Page 91) -
Creating/updating the diagnostic screens (Page 93) X
Compilation and downloading of the Maintenance Station (Page 95) 
Integration by the Alarm Control Center (Page 251) -

5.2.3 MS client or OS/MS client overview
The following table lists the topics that include information and configuration instructions. The 
order in the table corresponds to the recommended configuration sequence.     

What? MS
Basic

MS
Standard

How to configure a PC station for an MS or OS/MS Client (Page 44) X X
Assigning the server data and downloading of a client (Page 96) 

5.3 Overview of SIMATIC PDM MS

Information and configuration instructions
The following table lists the topics that include information and configuration instructions. The 
order in the table corresponds to the recommended configuration sequence.   

A sample project "PDM_MS20" is provided for the PDM MS. Retrieve the sample project. Use 
the project as a basis for further configuration.

What? Configuration
SIMATIC PDM MS

General settings in the multiproject/project (Page 38) X
Sample project as a project basis (Page 45)
How to create a project without using the sample project (Page 48)
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What? Configuration
SIMATIC PDM MS

Configuring an IE/PB Link PN IO (Page 52) Optional
Creation of the diagnostics structure (Page 60) X
Setting up SIMATIC PDM (Page 89) X
Overview of complete export (Page 89) 
Overview of individual export (Page 90) 
Creating/updating the diagnostic screens (Page 93) 
Compiling and downloading SIMATIC PDM MS (Page 95)
Integration by the Alarm Control Center (Page 251) Optional

Additional information
Information on creating a project for SIMATIC PDM MS is available in the section "Creating a 
project for SIMATIC PDM MS (Page 45)".

5.4 General settings in the multiproject/project

MS single-station/multiple-station system overview     
To monitor components with the maintenance station, check the settings specified in the 
following table and adapt if necessary.

Setting Location Comment
Regional language and
language for display devices

SIMATIC Manager Set a language in which the WinCC project is to be operated in 
process control.

AS station name (1) SIMATIC Manager ● <=14 characters
● No spacesDesignation of components (1) HW Config

S7 program (1) SIMATIC Manager ● Message number range must be the same for all S7 programs 
in the multiproject/project

● The name of an S7 program may not be assigned twice
Diagnostic blocks (1) The diagnostic blocks must be at least version V6.1.

Use a corresponding library, if necessary.
OS compilation mode Area-oriented
Plant hierarchy setting (1) The settings of the plant hierarchy must be the same in all projects 

of the multiproject/project.
WinCC project type single-sta‐
tion project (2)

WinCC Explorer The single-station project type must be selected in project prop‐
erties. 

Group display hierarchy (1) When user diagnostics is used, the group display hierarchy must 
be automatically created.

(1) Only applies to MS Basic and MS Standard
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(2) Only applies to SIMATIC PDM MS

Note

There is only one MS server within a multiproject/project.

Additional information
For more information about this, refer to the Process Control 
System PCS 7 Engineering System  manual and the Process Control System PCS 7; Operator 
Station manual.

5.5 Configuring the PC station for MS single station system

Introduction
If you are already using an existing ES/OS single station system in the multiproject/project you 
do not need to execute the following steps.

Requirement     
The multiproject/project has been created.

Procedure
1. In the component view of the SIMATIC Manager, select the project into which you want to 

insert the MS single station system.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows computer name in the "Computer name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.
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11.If you want to monitor PC stations and/or network objects, under "SIMATIC PC Station > 
User application > OPC server" in the hardware catalog select the OPC server and drag it 
into the configuration table.

12.If you want to use SIMATIC PDM, under "SIMATIC PC Station > PDM" in the hardware 
catalog, select the PDM application and drag it into the configuration table.

13.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

14.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab. 

15.Select the menu command Save and Compile Station and close HW Config.

16.In the component view of the SIMATIC Manager, select the "[OS(*)]" object below the 
SIMATIC PC station in the "WinCC Appl." hierarchy folder.
* is a number assigned by the system.

17.Select the menu command Edit > Object Properties.
The "Properties – OS: [Name of the OS]" dialog box opens.

18.In the "Name:" input field, enter a name for the WinCC project of the MS single station 
system.

19.Select the "Target OS and Standby OS" tab.

– Enter the path to the target OS computer in the "Path to target OS computer" input box.

– Enter a symbolic computer name in the "Symbolic computer name" input box.

– Select ">none>" from the drop-down list box in the "Standby OS" area.

20.Click "OK".

5.6 Configuring of PC stations for MS multiple station system

5.6.1 How to configure a PC station for an engineering station

Introduction
If you have already configured an Engineering Station (ES) in the multiproject/project and are 
using SIMATIC PDM, you only have to execute the steps as of step 12.

Requirement     
The multiproject/project has been created.
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Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the ES.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the ES in the "Computer Name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.

11.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

12.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab.

13.If you are using SIMATIC PDM, under "SIMATIC PC Station > PDM" in the hardware 
catalog, select the PDM application and drag it into the configuration table.

14.Select the menu command Save and Compile Station and close HW Config.

15.Download the component configurator.

5.6.2 How to configure a PC station for an MS server

Introduction
If you are already using an existing OS server as MS server in the multiproject/project, you do 
not need to execute the following steps.

Requirement     
The multiproject/project has been created.
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Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the MS server.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the computer in the "Computer Name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.

11.If you want to monitor PC stations and/or network objects, under "SIMATIC PC Station > 
User application > OPC server" in the hardware catalog select the OPC server and drag it 
into the configuration table.

12.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

13.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab.

14.Select the menu command Save and Compile Station and close HW Config.

15.In the component view of the SIMATIC Manager, select the "[OS(*)]" object below the 
SIMATIC PC station in the "WinCC Appl." hierarchy folder of the MS server.
* is a number assigned by the system.

16.Select the menu command Edit > Object Properties.
The "Properties – OS [name of OS]" dialog box opens.

17.In the "Name:" input field, enter a name for the WinCC project of the MS server.

18.Select the "Target OS and Standby OS" tab.

– Enter the path to the target OS computer in the "Path to target OS computer" input box.

– Enter a symbolic computer name in the "Symbolic computer name" input box.

– Select the following from the drop-down list box in the "Standby OS" area:
If you not configure the MS server redundantly, select ">none>".
If you configure the MS server redundantly, select the redundant partner. You can only 
select the partner if it has been configured.

19.Click "OK".

Configuring the maintenance stations
5.6 Configuring of PC stations for MS multiple station system

Maintenance Station
42 Function Manual, 05/2017, A5E41291135-AA



5.6.3 How to configure a PC station for the redundant partner

Introduction
If you are already using the redundant partner of an OS server in the multiproject/project, you 
do not need to execute the following steps.

Requirement     
The multiproject/project has been created.

Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the redundant partner.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the computer in the "Computer Name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
(stby) and drag it into the configuration table:

11.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

12.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab.

13.Select the menu command Save and Compile Station and close HW Config.

14.In the component view of the SIMATIC Manager, select the "[OS(*)_StBy]" object below 
the SIMATIC PC station in the "WinCC Appl." hierarchy folder (Stby.).
* is a number assigned by the system.

15.Select the menu command Edit > Object Properties.
The "Properties – Standby OS: [Name of the OS]" dialog box opens.

16.Select the "Target OS and Master OS" tab and enter the path to the target OS computer.

17.Click "OK".
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5.6.4 How to configure a PC station for an MS or OS/MS Client

Introduction     
You can operate the MS Client or OS/MS Client on the Engineering Station or a separate PC.

Requirement
The multiproject/project has been created.

Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the MS client.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the name in the "Computer name" input field.

– If you are running the MS client on a separate PC station, enter the Windows computer 
name of the target computer.

– If you are operating the MS client as MS client on the engineering station, enter the 
Windows computer name of the engineering station.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
client and drag it into the configuration table.

11.Insert other components.

12.Select the menu command Save and Compile Station and close HW Config.

13.In the component view of the SIMATIC Manager, select the "[OSC]" object underneath the 
MS client's SIMATIC PC station.

14.Select the menu command Edit > Object Properties.
The "Properties – Client OS: [Name of the OS]" dialog box opens.

15.In the "Name:" input field, enter a name for the WinCC project of the MS client.

16.Click "OK".
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5.7 Creating a project for SIMATIC PDM MS

5.7.1 Sample project as a project basis

Introduction
The SIMATIC PDM MS is connected directly to the plant bus through which the automation 
stations communicate.

Multiple SIMATIC PDM MS stations can be used in an automation plant. Each station can 
process selected field devices of the project based on the task.

The easiest way to integrate the SIMATIC PDM MS into an existing automation system is to 
create a project using the supplied sample project with the name "PDM_MS".

The station import function can be used to directly transfer communication and device 
information from the SIMATIC PCS 7 project to the project of SIMATIC PDM MS.

Additional information
You can find information on using the sample project in the section "How to use the sample 
project".

5.7.2 How to use the sample project

Requirements
● The image is imported into the Microbox.

● The licenses, including the required PDM TAG licenses that have to be purchased 
separately, have been transferred.

● The SIMATIC PDM device description library has been imported (if it was not already 
included in the image).

● The Ethernet interface used for the plant bus is configured with an available address within 
the address range on the plant bus of the SIMATIC PCS 7 project.

● The Ethernet interface for the terminal bus (if desired) is either configured for a different 
address range or the IP settings are set to "Obtain an IP address automatically".

● The SIMATIC PDM MS station is connected to the plant bus.

● The intended user accounts have been created under <Control Panel > User Accounts > 
User Accounts > Manage.

● The project administrator is a member of the local user group "Logon_Administrator" under 
<Computer Management > System > Local Users and Groups > Groups/
Logon_Administrator>.
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● All intended users are members of the local user group "Siemens TIA Engineer" listed under 
<Computer Management > System > Local Users and Groups > Groups/Siemens TIA 
Engineer>.

● You have access (local disk or network) to the automation project via the Windows Explorer 
of PDM MS.

● The IP protocol or ISO on TCP protocol is enabled in the AS stations (H-machines) of the 
SIMATIC PCS 7 project.

Procedure 
1. Open SIMATIC Manager.

2. Select the menu command File > Open... .

– Select the Sample project tab.

– Select the sample project.

– Click "OK".

3. Select the menu command File > Save as... .
Assign the name and storage location for the project.

4. Select the menu command Options > SIMATIC PDM > Settings... .

– Select the "General" tab.
Enter the path for "Asset export files".

– Select the "Communication" tab.
If HART auxiliary variables are cyclically transmitted in at least one remote I/O station, 
do not enable SHC mode.

– Select the "Download" tab.
When this function is managed by the automation system, or the "Synchronization field 
device parameters" function is used on a SIMATIC PCS 7 Maintenance Station, do not 
enable the "Configuration Flag Reset" function.

– Select the "Maintenance Station" tab.
Assign the current project.
Select the "Transfer maintenance alarm to MS station" check box.

– Select the "Change log" tab.
If you want to save the changes, enable the function.

5. Select the menu command Options > SIMATIC PDM > Roles management... .
Administer the function rights.
You can find information on roles management in the "Roles management" section.

6. Select the PC station

7. Select the menu command Edit > Open Object.

– Configure the selected IP address for the connection to the plant bus in IE General.

– Compile and download the station

8. Select the menu command View > Process Device Network View.

9. Select the "ETHERNET network" communication network
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10.Select the menu command Edit > Object properties... .

– Select the "Communication" tab.

– Enter the subnet ID of the plant bus.
You can find the subnet ID in HW Config in the properties of the interface for the plant 
bus of each AS station or directly in the properties of the plant bus in NetPro.

11.Select the "ETHERNET network" communication network.

12.Select the menu command Edit > SIMATIC PDM > Import from HWC station.

– Select the user project.

– Select the AS stations.
The AS stations can be selected individually.

– To import the field devices from the SIMATIC PCS 7 project, click on the "Import" button.

13.Adapt the project according to the task at hand.
Add field devices or remove field devices.

Note

When the same station is imported again, the station is not overwritten in the process device 
network view. Instead, it is added to the existing stations.

14.Select the menu command View > Plant view.

15.Select the menu command Options > Plant hierarchy > Advanced diagnostics settings... .
Configure the advanced diagnostic settings if you wish.

16.Select the Options > Plant hierarchy > Create/update diagnostics screens menu command.

17.Select the menu command View > Component view.

18.Select the project node.

19.Select the menu command PLC > Compile and Download Objects    .
Run the "Compile and Download Objects" function with the following settings:

– Compile and download charts

– Compile OS

20.Start OS process control.

Result
SIMATIC PDM MS is ready for operation.

Additional information
You can find the description of how to operate the process control in the section "Operator 
control and monitoring (Page 105)".
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5.7.3 How to create a project without using the sample project

Requirements
● The image is imported into the Microbox.

● The licenses including the required PDM TAG licenses have been transferred.

● The SIMATIC PDM device description library has been imported (if it was not already 
included in the image).

● The Ethernet interface used for the plant bus is configured with an available address within 
the address range on the plant bus of the SIMATIC PCS 7 project.

● The Ethernet interface for the terminal bus (if desired) is either configured for a different 
address range or the IP settings are set to "Obtain an IP address automatically".

● The SIMATIC PDM MS station is connected to the plant bus.

● The intended user accounts have been created under <Control Panel> User Accounts and 
Family Safety > Manage User Accounts > Manage Accounts>.

● The project administrator is a member of the local user group "Logon_Administrator" under 
<Computer Management > System > Local Users and Groups > Groups/
Logon_Administrator>.

● All intended users are members of the local user group "Siemens TIA Engineer" under 
<Computer Management > System > Local Users and Groups > Groups/Siemens TIA 
Engineer>

● You have access (local disk or network) to the automation project via the Windows Explorer 
of PDM MS.

● The IP protocol or ISO on TCP protocol is enabled in the AS stations (H-machines) of the 
SIMATIC PCS 7 project.

Procedure
1. Open SIMATIC Manager.

2. Select the menu command File > New...  

– Assign the name and storage location for the project.

– Use "Project" as the project type to create an individual project.

3. Select the project node and select the menu command Insert > Station > 4 SIMATIC PC 
station.

4. Select the SIMATIC PC station and select the menu command Edit > Object Properties... .

– Enter the name for the PC station in the "Name" text box.

– Enter the Windows computer name in the "Computer name" text box.

– Click "OK".

5. Select the SIMATIC PC station

6. Select the menu command Edit > Open Object.
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7. Select the desired "WinLC-RTX" in the hardware catalog under "SIMATIC PC 
station > Controller > WinLC RTX" and drag it into the configuration table.

Note

Only one WinLC RTX can be added.

If the hardware catalog is not visible, select the menu command View > Catalog.

8. Select the "WinCC application" in the hardware catalog under "SIMATIC PC station > HMI" 
and drag it into the configuration table:

9. Select the "PDM application" in the hardware catalog under "SIMATIC PC station > PDM" 
and drag it into the configuration table:

10.Select the network card "IE General" in the hardware catalog under "SIMATIC PC station > 
CP Industrial Ethernet".
Configure the selected IP address for the connection to the plant bus in IE General.

11.Select the menu command Station > Save and compile and Station > Close.

12.In the SIMATIC Manager, select the menu command Options > SIMATIC PDM > Settings... .

– Select the "General" tab.
Enter the path for "Asset export files".

– Select the "Communication" tab.
If HART auxiliary variables are cyclically transmitted in at least one remote I/O station, 
do not enable SHC mode.

– Select the "Download" tab.
When this function is managed by the automation system, or the "Synchronization field 
device parameters" function is used on a SIMATIC PCS 7 Maintenance Station, do not 
enable the "Configuration Flag Reset" function.

– Select the "Maintenance Station" tab.
Assign the current project.

– Select the "Change log" tab.
If you want to save the changes, enable the function.

13.Select the menu command Options > SIMATIC PDM > Roles management... .
Administer the function rights.
You can find information on roles management in the "Roles management" section.

14.Select the menu command View > Process Device Network View.

15.Select the menu command Insert > SIMATIC PDM > 2 networks.

16.Select the "Networks" node

17.Select the menu command Insert > SIMATIC PDM > 4 Communication networks.
Assign the device type "ETHERNET network" and close the dialog by clicking "OK".

18.Select the "ETHERNET network" communication network

19.Select the menu command Edit > Object properties... .

– Select the "Communication" tab.

– Enter the subnet ID of the plant bus.
You can find the subnet ID in HW Config in the properties of the interface for the plant 
bus of each AS station or directly in the properties of the plant bus in NetPro.
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20.Select the "ETHERNET network" communication network

21.Select the menu command Edit > SIMATIC PDM > Import from HWC station.

– Select the user project.

– Select the AS stations.
The AS stations can be selected individually.

– To import the field devices from the SIMATIC PCS 7 project, click on the "Import" button.

22.Adapt the project according to the task at hand.
Add field devices or remove field devices.

Note

When the same station is imported again, the station is not overwritten in the process device 
network view. Instead, it is added to the existing stations.

23.Select the menu command View > Plant view.

24.Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings     
Configure the advanced diagnostic settings if you wish.

25.Select the Options > Plant hierarchy > Create/update diagnostics screens menu command.

26.Select the menu command View > Component view.

27.Select the project node.

28.Select the menu command PLC > Compile and Download Objects... .
Run the "Compile and Download Objects" function with the following settings:

– Compile and download charts

– Compile OS

29.Start OS process control.

Additional information
You can find the description of operating in process control in the section "Operator control 
and monitoring (Page 105)".

5.7.4 SIMATIC Logon Role Management

Introduction
Access protection via "SIMATIC Logon Role Management" controls access to device 
management, parameter assignment and field device diagnostics. 

The following roles have been created for SIMATIC PDM in SIMATIC Logon Role Management 
by the system:

● PDM command interface

● Service technician
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The roles created by the system can be assigned Windows user groups/users of the local 
computer or the domain.

You can add new roles. Assign "Groups and users" and "Function rights" to the roles you have 
added.

The function rights are specified by the system. They cannot be deleted, edited or amended.

Function rights and roles
The table below shows the assignment of function rights to the roles created by the system.

Function rights "PDM command inter‐
face" role

Service technician

Access to PDM command interface X -
Operation of "Parameter view" menu command - X
Operation of "Device" menu command - X
Operation of "View" menu command - X
Operation of "Diagnostics" menu command - X
Operation of "Service" menu command - X
Operation of "Write to device" menu command - X
Operation of "Read from device" menu command - X
Online access to the device - X
Operation of "Import" menu command - X
Operation of "Save" menu command - X

Additional information
You can find information about SIMATIC Logon Role Management in the manual SIMATIC, 
SIMATIC Logon.

You can find information about configuring a role in the section below "How to configure a 
'role'".

5.7.5 How to configure a "role"

Requirements
● Groups and users are created in Windows

● Groups and users are members of the "TIA Engineer" group

● At least one user account has administrator rights
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Procedure
1. In the SIMATIC Manager, select the menu command Options > SIMATIC PDM > Roles 

management... .

2. Select the "Roles" folder.

3. Select the "New role" menu command.

4. Enter a name in the "Role name:" text box.

5. Click "OK".

6. Open the folder with the newly created role.

7. Select the "Groups and users" folders associated with the role.

8. Select the "Edit" menu command.

9. Assign "Groups and users" to the role.

10.Click "OK".

11.Select the "Function rights" folders associated with the role.

12.Select the "Edit" menu command.

13.Assign "Function rights" to the role.

14.Click "OK".

Result
An additional role has been created.

5.8 Configuring an IE/PB Link PN IO

Introduction
If it is not possible to communicate with the field devices via a SIMATIC AS station, the IE/PB 
Link is used. 

The IE/PB Link PN IO link module connects the two network types, Industrial Ethernet and 
PROFIBUS.

Requirement
The project has been created.

Step 1 - Create a SIMATIC 300 station
1. Select the project into which you want to insert the SIMATIC 300 station in the component 

view of the SIMATIC Manager.

2. Select the menu command Insert > Station > SIMATIC 300 station.
A new SIMATIC 300 station is inserted into the selected project.
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3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. Enter the name for the SIMATIC 300 station in the "Name" text box.

5. Click "OK".

Step 2 - Configure IE/PB Link PN IO link module in the SIMATIC 300 station
1. Select the SIMATIC 300 station in the component view of the SIMATIC Manager.

2. In the detailed view, open HW Config by double-clicking the "Hardware" object.
The hardware configuration of the SIMATIC 300 station opens.

3. If the hardware catalog is not visible, select the menu command View > Catalog.

4. Select the device type Gateway – IE/PB Link PN IO in the hardware catalog under "SIMATIC 
300".

Note

The IE/PB Link PN IO link module is a special configuration component.

No other components, such as profile rails or modules, can be placed in the S7-300 station 
apart from this component.

5. Create an Ethernet network.

6. Assign parameters for the Ethernet network using the following data:

– IP address

– S7 subnet ID

7. Create a PROFIBUS network.

8. Assign parameters for the PROFIBUS network using the following data:

– Address

– "No DP" mode

9. Select the "Activate data record gateway" check box for the IE/PB Link PN IO link module.

10.Transfer the parameters to the IE/PB Link PN IO link module.

11.Note down the following information:

– The S7 subnet ID and the IP address of the Ethernet network

– The DP master address for the PROFIBUS network

12.Repeat the procedure for any other IE/PB Link PN IO link modules.

Note

Use the same S7 subnet ID for the Ethernet network for any further IE/PB Link PN IO link 
modules.
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Step 3 - Configure IE/PB Link PN IO link module in the process device network view
1. Configure an Ethernet network in the process device network view.

2. Assign parameters for the Ethernet network with the S7 subnet ID.

3. Configure the IE/PB Link PN IO Link module in this Ethernet network.

4. Assign parameters for the IE/PB Link PN IO link module using the following data:

– With the S7 subnet ID

– With the corresponding IP address

– With the corresponding DP master address

5. Repeat the procedure for any other IE/PB Link PN IO link modules.

Additional information
For additional information on this topic, refer to the SIMATIC NET; S7-CPs for Industrial 
Ethernet and PCS 7 Process Control System; SIMATIC PDM manuals.

5.9 Configuring the monitoring of industrial PCs and network objects

5.9.1 Requirements

Introduction           

Note

You can monitor the industrial PCs and network objects for the following maintenance station 
versions:
● MS Basic
● MS Standard

The programs or services listed in the following table must be available and configured to 
monitor industrial PCs and network objects.

Application/service MS single-station sys‐
tem

MS multiple station sys‐
tem

SIMATIC PDM MS

OPC Server MS single-station sys‐
tem

● MS server
● Redundant partner 

of the MS server

Not supported
NDIS adapter

SNMP service On each industrial PC 
to be monitoredDiagnostics Monitor
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Programs and services
● OPC Server

– OPC (OLE for Process Control) is an interface for data exchange in automation 
engineering.

– It is set up in HW Config.
You can find information about this in the following sections.

● NDIS adapter

– For monitoring of components on the plant bus, if access to the plant bus is provided 
via a communication processor (CP 1623 / CP 1613).

– The NDIS adapter must be configured.
You can find more information about this in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

● SNMP service

– SNMP is the Simple Network Management Protocol that is used to manage networks.

– The SNMP service must be configured.
You can find more information about this in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

A network connection must be available to the components with SNMP functionality to be 
included in the diagnostics.

● Diagnostics Monitor

– Diagnostics Monitor is a diagnostics tool that provides the diagnostic data required from 
SIEMENS industrial PCs.

– Diagnostics Monitor is called in the header of the faceplate in process control.

– Diagnostics Monitor must be installed and configured.
You can find more information about this in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

– Additional settings
Start the Web server
Start the Management Explorer.
Select Options > Web server.
Authorize Diagnostics Monitor Web server in the Windows firewall
Open the firewall.
Create a new exception/rule for the "MiniWebService.exe" program.
This file is accessed via the Windows Start menu, submenu ...\Siemens\Automation
\DiagnosticManagement\WebServer_DM\Bin.

5.9.2 Device profiles and community

Introduction
If an SNMP-compatible component is configured in the OPC server, a device profile and a 
community must be assigned to this SNMP-compatible component.
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Overview
The following table shows the assignment of the community to the device profile.     

Components Device profile Community
SCALANCE series X200 Profile_SCALANCE_X200_Vxy.txt public

 SCALANCE series X200 RNA Profile_SCALANCE_X200RNA_Vxy.txt
SCALANCE series XB200 Profil_SCALANCE_XB200_Vxy.txt
SCALANCE series XC200 Profil_SCALANCE_XB200_Vxy.txt
SCALANCE series XF200 Profil_SCALANCE_XB200_Vxy.txt
SCALANCE series XP200 Profil_SCALANCE_XB200_Vxy.txt
SCALANCE series X300
SCALANCE series X400

Profil_SCALANCE_X300X400_Vxy.txt

SCALANCE series XM400 Profil_SCALANCE_XM400_Vxy.txt
SCALANCE series X500 Profil_SCALANCE_X500_Vxy.txt
SCALANCE series W700 Profil_SCALANCE_W700_Vxy.txt (xy =13)
SCALANCE series W700, firmware 6.1 
or higher

Profil_SCALANCE_W700_Vxy.txt (xy >= 
61)

ESM/OSM Profil_OSM_Vxy.txt
Siemens IPC (Industrial PC) Profil_IPC_Vxy.txt SOL
Other devices,
for example, third-party PCs, premium 
servers for SIMATIC PCS 7, network 
adapters, switches

MIB-II_V10.txt Determine the community configured 
in the device.

All devices that were integrated by 
means of import, but are not to be dis‐
played

No SNMP -

Note

"No SNMP" as device profile has the following effects on the diagnostic screens:
● No asset object is created for the network component.
● The asset object of a PC station is created for an industrial PC.

5.9.3 How to assign components with SNMP functionality to the OPC server

Naming rules
Aspects to be taken into account when naming components with SNMP functionality:

● Do not use spaces or special characters in module names.

● For IPCs, assign module names that correspond to the computer name of the IPC in the 
SIMATIC Manager.
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● For all other modules, assign module names that are different from the existing computer 
names of PC stations in the project.

● If you use two separate Ethernet networks in your configuration, make sure that both the 
names and the IP addresses of the modules are unique across the network.

Requirements   
● The HW configuration for the PC objects and network objects is completed.

● The OPC server has been inserted.
You will find more information on this subject in the following sections:

– Configuring the PC station for MS single station system (Page 39)

– How to configure a PC station for an MS server (Page 41)

Procedure
1. Select the OPC server in HW Config, and then select the menu command Edit > Object 

Properties....
The "Properties – OPC server" dialog box opens.

2. Open the "SNMP" tab.

3. Enter at least 1000 ms in the "Cycle time" input box.
You can obtain additional information with the "Help" button.

4. Click "Edit plant configuration".
The "Edit plant configuration" dialog box opens.

5. Click "Import".
All objects configured in your project with an IP address are imported.

Note

When you import a CP 1623 / CP 1613, the IP address of the HW Config is imported. If 
necessary, replace this TCP/IP address with an NDIS IP address.

6. Double-click the node.
The "Edit node" dialog box opens.
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7. Enter the following data for the imported devices.

– Name:
Enter a name.

– IP address:
If necessary, change the IP address.

– Device profile and community:
You can find additional information about this in the section "Device profiles and 
community (Page 55)".

Note

Note that these community name entries are case sensitive. 

The community name in the "Edit Node" and "Add Node" dialog boxes must match the 
community name stored in the respective device.

– Timeout:
Enter a value of 9000 ms or higher, depending on the number of components to be 
monitored.
You can obtain additional information with the "Help" button.

– SNMP optimization
Activate the check box.

– Comment:
You can enter a comment in this field. This comment is visualized in the faceplate of the 
process control system.

8. Click "OK".
The "Edit nodes" dialog box closes and you return to the "Edit plant configuration" dialog 
box.

9. Click the "Add" button if you want to insert IPCs or other components with SNMP 
functionality.
The "Add node" dialog box opens.

10.Enter all required data.
Proceed as described in item 7.

11.Click "OK".
The "Add node" dialog box closes and you return to the "Edit plant configuration" dialog 
box.

12.Insert additional nodes as required.

13.Click "OK".
The configuration is complete.

14.Compile and download the hardware configuration.
Additional information on this is available in the Process Control System PCS 7; 
Engineering System manual.
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5.9.4 How to insert the OPC server into the redundant partner

Requirement   
The OPC server is configured in the MS server.

You can find additional information on this topic in the section "How to assign components with 
SNMP functionality to the OPC server (Page 56)".

Procedure
1. In SIMATIC Manager, open the component view.

2. Select the SIMATIC PC station of the MS server.

3. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

4. Select the OPC server.

5. Select Edit > Copy from the menu.

6. Select the SIMATIC PC station of the redundant partner.

7. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

8. Select the position for the OPC server.

9. Select the Edit  > Paste command.

10.Select the Station > Save and Compile command.

5.9.5 How to transfer the OPC configuration to the WinCC project

Introduction
Data tags, alarm tags and alarm texts for all components with SNMP functionality are 
generated in the WinCC project with tag export.

Requirements
● The diagnostic structure has been created.

● The maintenance station has been compiled.

Procedure
1. Select the OPC server in HW Config, and then select Edit > Object Properties... .

The "Properties – OPC server" dialog box opens.

2. Open the "SNMP" tab.
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3. In the "Tag export" group, select the check box

– "Export complete plant configuration" upon initial tag export

– "Export changes only" upon all subsequent tag exports

4. Click "Export Tags for WinCC".

5. Click "OK".
The dialog box closes.

5.10 Creation of the diagnostics structure

5.10.1 Information on diagnostics structure and plant hierarchy

Diagnostics structure in the plant hierarchy       
The diagnostics structure is a folder structure in the plant hierarchy and is automatically created 
by the system. The number of hierarchy levels is limited to 8.

The diagnostics hierarchy folder is the top hierarchy folder; it maps the area-forming level for 
the OS (area selection button in overview of process control). Depending on the set level OS 
area in the plant hierarchy, a maximum of three folders is created with the name "Diagnostics".

The hierarchy folders with the names AS objects, field devices, network objects, and PC 
stations are created on the same hierarchy level below the diagnostics hierarchy folder that 
maps the OS area. The version of the maintenance station and the existing objects determine 
which hierarchy folders are created.

Note

The "Field devices" area is only created if you use the PCS 7 Basic Library >=V8.1 in the AS.

If you use the PCS 7 Basic Library <=V8.1 in the AS, all field devices are assigned to the "AS 
system" area.

The names of the automatically generated hierarchy folders cannot be changed.

Settings in the plant hierarchy
The following settings are made for the maintenance station in the "Plant hierarchy - Settings" 
dialog box:

● Number of hierarchy levels (1)

● Area-forming level for the OS (1)

● Creation of the diagnostics structure

● Version of the Maintenance Station

Configuring the maintenance stations
5.10 Creation of the diagnostics structure

Maintenance Station
60 Function Manual, 05/2017, A5E41291135-AA



● Setting for deriving names in the PH

● Selection of the maintenance station 

(1) Note: Applies to all multiprojects/projects

Information on configuration of settings in the plant hierarchy is available in the following 
section.

Additional information
You can find additional information about this in the "Relationship between the diagnostic 
structure and version (Page 63)" section.

5.10.2 How to make the settings in the plant hierarchy

Requirements for MS single-station system and MS multiple-station system         
● The multiproject/project has been created.

● The hardware configuration is completed.

● The network configuration is completed.

● The basic parameter assignment for all components is available offline.

Requirements for SIMATIC PDM MS
● The project was not created as multiproject.

● The hardware configuration is completed

● The plant configuration is completed.

● The configuration of PC stations and network components (optional) is completed.

● The naming of components regarding LID and TAG is completed.

● All components in the process device network view are configured.

● The used IE/PB Links PN IO are configured.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Settings... .

Configuring the maintenance stations
5.10 Creation of the diagnostics structure

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 61



4. If you have selected a multiproject, the "Plant Hierarchy - Settings" dialog box opens.
Select the project whose settings you wish to use as a template for the plant hierarchy.

– Click "OK".
The "Customize Plant Hierarchy" dialog box opens.

– Proceed to step 6.

5. If you have selected an individual project or a project within a multiproject, the "Plant 
Hierarchy - Settings" dialog box opens.

6. Define the settings for the relevant levels.
Remember that the settings of the plant hierarchy within the multiproject/project are to be 
uniform.

7. Activate the "Derive picture hierarchy from the plant hierarchy" check box.
If you do not wish to derive the diagnostic screens from the plant hierarchy for your plant 
areas, deactivate the "Picture Tree" check box in the dialog for compiling the OS. 
Configure the plant hierarchy for the diagnostic screens in the WinCC project in the Picture 
Tree editor.

8. Enable the "Derive diagnostic screens from the plant hierarchy" check box.

9. Specify the version.
Enable the appropriate option button:

– "Maintenance Station Standard (license required)" option button

– "Maintenance Station Basic (overview screens only)" option button

– "Maintenance Station PDM (no AS diagnostics)" option button

10.When creating/updating the diagnostic screens, specify whether the names of the created 
hierarchy folders should be derived from the name or the commentary for the hardware 
components. Enable the appropriate option button:

– "Derive PH names from the names of the hardware components" option button

– "Derive PH names from the comments of the hardware components" option button
Since there are no restrictions on the characters that can be used for the comment texts, 
you can use any type of name.

11.Click "OK".
The "Define Maintenance Station" dialog box opens and all OSs available in the multiproject/
project are shown.

12.Select the OS you want to define as Maintenance Station.

13.Click "OK".

Result
In a multiproject, the "Diagnostics" hierarchy folder is inserted in all the projects within the 
multiproject. 

● The standard diagnostic structure with the hierarchy folders "AS Objects", "Field Devices", 
"Network Objects", and "PC Stations" is automatically created in the project with the MS 
server. The structure for the user diagnostics must be created manually. 

● In the other projects of the multiproject, only the "AS Objects" and "Field Devices" hierarchy 
folders are created automatically within the diagnostics structure.
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Note

The "Field devices" area is only created if you use the PCS 7 Basic Library >=V8.1 in the AS.

If you use the PCS 7 Basic Library <=V8.1 in the AS, all field devices are assigned to the "AS 
system" area.

The diagnostics structure depends on the selected type.

If the second or third level is activated for the OS area, a structure of two or three "Diagnostics" 
folders is created in the plant hierarchy.

5.10.3 Relationship between the diagnostic structure and version

Introduction
The diagnostic structure is created differently depending on the version of the Maintenance 
Station.

Diagnostic structure MS Basic version       
The table shows an example of the diagnostic structure.

Areas and levels
1 2 3 4 5 6 7 8
Diagnos‐
tics
 
 

AS/system -
Network ob‐
jects
PC stations
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Diagnostic structure – MS Standard version
The table shows an example of the diagnostic structure.

Areas and levels
1 2 3 4 5 6 7 8
Diagnostics AS/system AS objects AS detail 

view
-

DP master 
system

DP nodes -

PROFINET 
IO system

PN nodes -

Field devices AS objects 
without their 
own group 
display

DP master 
system

DP nodes Modules HART field 
devices

-

PA field devi‐
ces

-

PROFINET 
IO system

PN nodes Modules HART field 
devices

-

PA field devi‐
ces

-

DP nodes
Network ob‐
jects

-

PC stations
User objects Depending on the configuration in the plant hierarchy

Diagnostic structure – SIMATIC MS PDM version
The table shows an example of the diagnostic structure.

Areas and levels
1 2 3 4 5 6 7 8
Diagnos‐
tics

Field devices Depending on the configuration in SIMATIC PDM 
Network ob‐
jects

-

PC stations
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5.11 Advanced diagnostics settings

5.11.1 "Maintenance functions" tab

5.11.1.1 Configuring maintenance links

Introduction     
In process control, links to freely configurable web pages can be called in the overview screen 
and the header area of the faceplates; these web pages are used to support the diagnostic 
measures.

10 link objects are automatically created by the system.

Automatically created link objects are:

Maintenance link1 to Maintenance link10.

The properties are managed in one language.

A link object has the properties "Name:" and "URL:".

The name of the target address is entered in the "Name:" entry field.

The target address is entered in the "URL:" entry field.

You can change the properties of link objects.

You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Rule
● Maintenance links are always valid for the entire multiproject/project.

● The number of link objects is limited to 10.
Display of the link objects, if this is configured:

– In the overview screen, link object 1 to 10

– In the header of the faceplate link, object 1 to 3

● The automatically generated link objects can be renamed.

● The name of the link object contains a maximum of 24 characters.
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● The web address consists of up to 256 characters.

● The name and the web address to the web page are configured in the object properties of 
the link object.

Note

Ensure that the target address is accessible during process control.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Functions for maintenance" tab

5. In the "Maintenance links" area, select the maintenance link whose existing properties you 
want to change.

6. Click "Properties...".
The "Properties maintenance link" dialog box opens.

7. Enter the desired name for the link object in the "Name:" entry field.

8. Enter the target address in the "URL:" entry field.

9. Click "OK".
The "Properties maintenance link" dialog box closes.

10.Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on the overview screen in the section "Calling web pages 
via maintenance links (Page 113).

You can find additional information on the faceplate in the section "Screen window title and 
header (Page 179).
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5.11.1.2 Configuring maintenance targets for individual export

Introduction     
Maintenance targets can be selected for storage of individual export files in the process control. 
The selection is made in the "Maintenance" view of the faceplate.

A target object is created automatically by the system.

Automatically created target object:

The name is Default target. The path is project directory ...\wincproj\<os-name>.

A target object has the properties "Name:" and "Path:".

The name of the target path is entered in the "Name:" entry field.

The target path for the individual export file is entered in the "Path:" entry field.

You can add, change and/or delete target objects.

You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Target directory
The target directory can be configured as a local or network directory.

Target directory Example of a target directory Storage location
Local target direc‐
tory

D:\folder On the MS server which is the master at the 
time export is initiated, in the configured path

Network target di‐
rectory

\\computer name\shared drive\fold‐
er

On the specified computer in the configured 
path

Note

We recommend that you configure the target directory as a network target directory for a plant 
configuration with an MS server and a standby MS server. This will ensure that the export file 
is always stored in the same "location", regardless of which MS server is the master at the 
time the export is initiated.

Rules
● Maintenance targets are always valid for the entire multiproject/project.

● The name of the target object has a length of not more than 24 characters.

● The name of the target object is managed in one language.

● The maximum length of the target directory is 256 characters.
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Requirement
The Maintenance Station has been created.

Procedure
The following section describes how to configure, change and delete a target object.

To open the "Advanced Diagnostics Settings" dialog, follow the steps below.

1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Functions for maintenance" tab

Configuring the maintenance target
1. Click "Add..." in the "Maintenance targets" area.

The "Add maintenance target" dialog box opens.

2. Enter the name for the target object in the "Name" entry field.

3. Click "Browse".

4. Select the required target directory.
The target directory is entered in the "Path:" entry field.

5. Click "OK".
The "Add maintenance targets" dialog box closes.

6. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Changing maintenance target properties
1. In the "Maintenance targets" area, select the target object whose properties you want to 

change.

2. Click "Properties...".
The "Properties maintenance target" dialog box opens.

3. Make the desired changes.

4. Click "OK".
The "Properties maintenance target" dialog box  closes.

5. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.
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Deleting maintenance targets
1. In the "Maintenance targets" area, select the maintenance target you want to delete.

2. Click "Delete".
The target object is deleted.

3. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on selecting maintenance targets in the section 
""Maintenance" view (Page 196)".

5.11.1.3 Configuring maintenance actions

Introduction   
An action to be performed can be assigned to a requested maintenance action in the process 
control. The assignment is made in the "Maintenance" view of the faceplate.

Seven action objects are created automatically by the system.

Automatically created action objects are:

● Disassembly

● Device swap

● Calibration

● Zero adjustment

● Cleaning

● Service

● Other

Texts for the automatically created maintenance actions are available in multiple languages.
You can find information on this in the Process Control System PCS 7; Operator Station 
configuration manual, section "Setting languages".

An action object has the properties "Name:" and "Name for user:".

The name of the maintenance action is entered in the "Name:" entry field. 

The name that a maintenance engineer can select from the drop-down list is entered in the 
"Name for user:" entry field.

You can add, change and/or delete action objects.

The number of action objects is not limited.
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You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Rules
● Maintenance actions are always valid for the entire multiproject/project.

● The name of an action object contains a maximum of 24 characters.

● The name of the action object is managed in one language.

● The text in the "Name for user:" field is managed in multiple languages. 
You can find information on this in the section "Configuring multilingual texts (Page 74)".

Requirements
The Maintenance Station has been created.

Procedure
The following section describes how to configure, change and delete an action object.

To open the "Advanced Diagnostics Settings" dialog, follow the steps below.

1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Functions for maintenance" tab

Add maintenance action
1. Click "Add..." in the "Maintenance actions" group.

The "Add maintenance action" dialog box opens.

2. Enter the name for the action object in the "Name:" entry field.

3. Click inside the "Name for user:" entry field.
The text is applied in the "Name for user:" entry field.

4. If you want to change the text in the "Name for user:" entry field, enter the desired text.

5. Click "OK".
The "Add maintenance actions" dialog box closes.

6. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.
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Changing maintenance action properties
1. In the "Maintenance actions" group, select the action object whose properties you want to 

change.

2. Click "Properties...".
The "Properties maintenance action" dialog box opens.
The previous entries are displayed in the input dialog.

3. If you want to change the text in the "Name:" entry field, enter the desired text.
Proceed to step 5.

4. If you want to change the text in the "Name for user:" entry field, enter the desired text.
Click "OK".
The "Advanced Diagnostics Settings" dialog box opens.

– If the change does not affect the other languages, click "No".

– If the change affects the other languages, click "Yes".

The "Advanced Diagnostics Settings" dialog box closes.

5. Click "OK".
The "Maintenance action properties" dialog box closes.

6. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Deleting a maintenance action
1. In the "Maintenance actions" group, select the action object you want to delete.

2. Click "Delete".
The action object is deleted.

3. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on multilingual configuration of maintenance actions in the 
section "Configuring multilingual texts (Page 74)".

You can find additional information on languages in the Process Control System PCS 7; 
Operator Station configuration manual, section "Setting languages".

You can find additional information on assigning a maintenance action in the section 
""Maintenance" view (Page 196)".
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5.11.1.4 Configuring maintenance information

Introduction     
In PCS 7 V8.2 and higher, user-specific maintenance information texts can be configured in 
the process control for displaying detailed diagnostic information in the faceplate.

Sixteen information objects are created automatically by the system.

Automatically created information objects are:

● External service request, no additional information

● Service interval reached

● Different operating state

● Different performance parameters

● Auxiliary energy problem

● Auxiliary material problem

● Mechanical problem

● Electrical problem

● Pneumatic problem

● Calibration request

● Measuring circuit check

● Process-related event

● Cleaning request

● Emptying request

● Wear reserve undershot

● Degree of pollution high

Texts for the automatically created maintenance information are available in multiple 
languages.
You can find information on this in the Process Control System PCS 7; Operator Station 
configuration manual, section "Setting languages"

An information object has the properties "Name:" and "Name for user:".

The name of the maintenance information is entered in the "Name:" entry field. 

The name that is displayed in the faceplate is entered in the "Name for user:" entry field.

You can change the properties of information objects.

You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.
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Rule
● Maintenance information is always valid for the entire multiproject/project.

● The number of maintenance information objects is limited to 16.

● The name of the information object is managed in one language and cannot be changed.

● Maintenance information created by the system can be adapted on a user-specific basis.

● The text in the "Name for user:" field is managed in multiple languages. 
You can find information on this in the section "Configuring multilingual texts (Page 74)".

● The following applies to a project created in PCS 7 versions before V8.2.
The maintenance information in the faceplate pre-assigned by the system is only displayed 
if the "Advanced Diagnostics Settings" dialog has been opened and confirmed with "OK".

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant hierarchy > Advanced diagnostics settings... .
The "Advanced Diagnostics Settings" dialog box opens. 

4. Select the "Functions for maintenance" tab

5. In the "Maintenance information" group, select the information object whose properties you 
want to change.

6. Click "Properties...".
The "Properties maintenance information" dialog box opens.
The previous entries are displayed in the input dialog.

7. Enter the desired text.

8. Click "OK".
The "Advanced Diagnostics Settings" dialog box opens.

– If the change does not affect the other languages, click "No".

– If the change affects the other languages, click "Yes".

The "Advanced Diagnostics Settings" dialog box closes.

9. Click "OK".
The "Properties maintenance information" dialog box closes.

10.Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.
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Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on multilingual configuration of maintenance information 
in the section "Configuring multilingual texts (Page 74)".

You can find additional information on languages in the Process Control System PCS 7; 
Operator Station configuration manual, section "Setting languages".

You can find additional information on configuring in the section "Configuring the display of 
maintenance information (Page 81)".

You can find additional information on displaying maintenance information in the section 
""External diagnostics" view (Page 226)".

5.11.1.5 Configuring multilingual texts

Introduction
Default texts for maintenance actions and maintenance information are available for the 
languages installed in the project.

Languages that might typically be installed in the project are:

● German (Germany)

● English (United States)

● French (France)

● Italian (Italy)

● Spanish (Spain, International Sort)

● Chinese (Simplified, PRC)

● Japanese (Japan)

You can display the languages installed in the project. 

Select the menu command Options > Language for Display Devices... in SIMATIC Manager.

Requirements
The Maintenance Station has been created.

The desired languages have been installed in each project.

Procedure
1. Select the menu command Options > Language for display devices.

2. Select the desired language as the default language.
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3. Click "OK".

4. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....

5. Select the appropriate text.

6. Click "Properties".

7. Enter the desired text in the "Name for user:" field.

8. Click "OK".

9. To change the text in the selected language only, click "No".

10.Click "OK".

11.Repeat steps 5 to 10 for all texts you want to change in the selected language.

12.Click "OK".

13.Repeat steps 1 to 12 for all texts and languages you want to change.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on languages in the Process Control System PCS 7; 
Operator Station configuration manual, section "Setting languages".

5.11.2 "Other settings" tab

5.11.2.1 Automatic positioning of block icons in the areas

Introduction
You specify the scope for creating/updating diagnostics screens in the "Automatic positioning 
of the block icons in the areas" area of the "Other settings" dialog.

Automatic positioning can be selected for one of the following diagnostic areas.

● AS/system

● Field devices

● User objects

● Network objects

● PC stations

The selection applies to the selected diagnostic area including all subordinate levels.
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The system offers the following options: 

● Check box cleared
This is the default setting.
When you create/update a screen, all PCS 7 block icons are arranged automatically, 
starting in the top left corner.
Screens in which a rack structure (for example, ET 200 central rack) is displayed are 
exceptions to this. In this case, the block icons for objects are arranged in the order of their 
slots.
After you update/create the diagnostics screens, move the block icons to meet your 
requirements. Block icons that have been moved remain in their position after the screen 
is updated. New block icons are added in the top left corner of the screen. 
Note that adding new block icons may cause icons to overlap.
Block icons to be deleted are removed from the screen. Their position in the screen remains 
unoccupied.

● Check box selected
The block icons for the selected diagnostic area are repositioned automatically.
All block icons are repositioned.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Other settings" tab.

5. Select the desired diagnostic area.

6. Click "OK".
These settings are saved retentively.

Result
When the "Create/update diagnostic screens" function is executed, the block icons for the 
selected diagnostic area are repositioned automatically.
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After OS compilation and subsequent download, the changes are applied in the process 
control.

Additional information
You can find additional information in the section "Creating/updating the diagnostic screens 
(Page 93)"

5.11.2.2 Storage location for the files of the (filtered) total export

Introduction
In the "Storage location for the files of the (filtered) total export" area of the "Other settings" 
dialog, you specify the user-specific storage location for the files of the (filtered) total export.

The user-specific target directory can be configured as an absolute or relative path.

Path Example of a storage path Storage location
Absolute path D:\folder On the MS server(s) in the con‐

figured path 
Relative path \\computer name\shared drive

\folder
On the specified computer in the 
configured path

In a redundant system, the total export file is saved on the MS server and on the redundant 
partner when using an absolute path.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Other settings" tab.

5. Specify the storage location for the files of the (filtered) total export.

6. Click "OK".
These settings are saved retentively.
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Result
After OS compilation and subsequent download, the setting is applied in the process control 
and saved in the "@ExportPath" tag.

Files of the (filtered) total export are additionally stored at the specified storage location.

5.11.2.3 Navigation information in the screen

Introduction
In the "Navigation information in the screen" area of the "Other settings" dialog, you specify 
whether and at which location the path will be displayed within the plant hierarchy in the 
diagnostic screen in the process control.

The path can be displayed at the following positions in the diagnostic screen:

● Top left

● Top center

● Top right

● Bottom left

● Bottom center

● Bottom right

The overview screen of the diagnostic screens is not affected by these settings.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Other settings" tab.

5. Select the "Display" check box.

6. Select the position for the display of the path in the diagnostics screen.
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7. If you want to have the block icons repositioned, select the "Re-position block icons" check 
box.

8. Click "OK".
These settings are saved retentively.

Result
When the "Create/update diagnostic screens" function is run, the associated path will be 
displayed in the diagnostic screens at the selected position.

After OS compilation and subsequent download, the changes are applied in the process 
control.

Note

If block icons and path information overlap in the diagnostic screens, use the "Re-position 
block icons" option.

5.11.3 "Edit for Picture Structure" tab

Introduction
The hierarchy and components of the PC Station and Network objects areas are displayed in 
the tab.

You can make structural and block icon changes for custom process control visualization.

The tab has a similar structure to the Explorer with a tree and list view. 

The tree view shows the folder structure. This is the basis for the hierarchy of the diagnostic 
screens.

The individual components are displayed in the list view. This is the basis for the block icons 
for the diagnostic screens.

Operator input
Tree view area (hierarchy)

Create subfolders in the tree view to create a hierarchy. You can drag-and-drop individual 
components to the subfolders. You can select multiple components.

A combination of PC stations and network objects is possible.
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You can add, delete and rename subfolders. 

● Assign a unique name or change the name when you add a subfolder.
This name is then used when you create diagnostic screens.

● If you delete a folder, you delete all the subfolders that it contains.
All components assigned to these folders are assigned to the higher-level folder when the 
original folder is deleted.
The overview folder for PC stations and network objects cannot be deleted or renamed.

● You can also create empty subfolder. 
Empty subfolders are taken into consideration under the following conditions when creating 
the diagnostic screens:

– At least one lower-level component has been assigned to the empty hierarchy folder.

– The empty subfolder is not created as the lowest hierarchy folder.

● "Create diagnostic screens" creates a group display in the higher-level screen for each 
available subfolder.

List view area (components)

The following information is displayed in the individual columns of the list view:

● Name of component

– Derived from the PC station name and OPC server configuration

– Cannot be modified in the editor

● Block icon

– Type of block icon to be used when creating the diagnostic screen

– Cannot be modified in the editor

● Variant block icon

– Version of block icon to be used when creating the diagnostic screen

– Can be modified in the editor by entering the version

● Picture file

– Picture file to be used for the block icon

– The user can save their own created picture files in different formats in the WinCC project 
directory "GraCS".
Formats can be, for example, *.emf, *.bmp and *.ipg.

– You can assign this picture file to the component using a browser dialog in the editor. 

Result
Closing the editor with the "OK" button saves all configuration changes in the background. 

There is no direct derivation of the plant hierarchy. 

Configuring the maintenance stations
5.11 Advanced diagnostics settings

Maintenance Station
80 Function Manual, 05/2017, A5E41291135-AA



The following actions are then performed during the creation/update of diagnostic screens:

● The structure and diagnostic screens in the plant hierarchy are created or deleted.

● The block icons required for OR operations for group display information in the diagnostic 
hierarchy are added automatically.

5.12 Configuring the display of maintenance information

Introduction     
This section describes the configuration steps for displaying the maintenance information in 
the process control.

Requirements
● The maintenance information has been created.

You can find information on this in the section "Configuring maintenance information 
(Page 72)".

● Channel blocks of the Advanced Process Library are applied (in PCS 7 V8.2 or higher).

Procedure
1. Activate "Feature bit 10" on the channel block.

2. Interconnect the "MS_Ext" input on the channel block with the signals of the external 
maintenance state of the user program.
You can use the "MSTOu" converter block for this.

3. Interconnect the "Text_Ref" input on the channel block with the signals you use for 
displaying the external diagnostic information.
You can use the "BO_W" converter block for this.
The individual bits of the "Text_Ref" input activate the state display in the faceplate in the 
"External diagnostics" view in process mode.

Note
Maintenance demanded and maintenance required

Only the external maintenance states "Maintenance demanded" (corresponds to significance 
6) and "Maintenance required" (corresponds to significance 5) are taken into account in the 
diagnostics block.

These maintenance statuses trigger the messages "Maintenance demanded (external)" and 
"Maintenance required (external)" in the process control.

Configuring the maintenance stations
5.12 Configuring the display of maintenance information

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 81



Note
Multiple channel blocks for HART modules

When HART modules and auxiliary variables are used, you use multiple channel blocks for 
the same channel of the module.

The above-mentioned procedure must be performed for each channel block.

Result
After AS and OS compilation and subsequent download, the maintenance information is 
displayed in the process control.

Additional information
You can find additional information on displaying maintenance information in the section 
""External diagnostics" view (Page 226)".

5.13 Configuring the user diagnostics

5.13.1 Overview

Introduction
Passive or indirect components without self-diagnostics (for example,  pumps, motors, control 
loops) can be monitored with the help of the user diagnostics. A "user" area is created within 
the diagnostic structure for this purpose.   

You can perform the following tasks in the "user" area:

● Creating individual diagnostic structures

● Creating project-specific diagnostics rules

● Configuring condition monitoring functions

Note

You can use the user diagnostics in the MS Standard version only.

User diagnostic structure
In the plant hierarchy, you can create one other hierarchy folder under the "Diagnostics" 
hierarchy folder and additional hierarchy subfolders under this hierarchy folder to build a user 
diagnostic structure based on technological aspects.
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In the user diagnostic structure, you can insert one self-created diagnostic screen and CFC 
charts for each hierarchy folder. 

You can incorporate buttons into the diagnostic screens for switching between the user-created 
and automatically created diagnostic screens.

The diagnostics functions are performed with different blocks, for example AssetM, which are 
integrated in the CFC charts.

Diagnostic function with the AssetM block
The "AssetM" block has the function of a substitute object and is used for monitoring 
components without self-diagnostics.

You can use the "AssetM" block to monitor three analog values.

Each analog value can be monitored for limits. 

The maintenance status is defined on the basis this limit, demanded or alarm defined 
(implementation of traffic light function in accordance with NE 107 of NAMUR).

The following functions are also available to you here:

● 7 inputs for reporting a corresponding maintenance status

● 16 inputs for displaying detailed diagnostics information

● 1 input for the maintenance status

● 1 input for the signal status

Cascading the signal status of process values
By using the "MuxST" multiplex block, you can interconnect the signal status of different 
process values weighted to the "AssetM" block. The signal status with the highest priority is 
shown in the faceplate in process mode.

The signal status must correspond to the PA profile 3.x.

Cascading the maintenance status
By using the "MuxMST" multiplex block, you can interconnect the maintenance status of 
different "AssetM" blocks to a higher level "AssetM" block. The maintenance status with the 
highest priority is shown in the faceplate in process mode.
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5.13.2 How to create the user diagnostic structure

Introduction
You create the user diagnostic structure in the project with the AS and the project with the 
Maintenance Station. If the AS and the Maintenance Station are in different projects of a 
multiproject, configure the CFCs in the project with the AS for the user diagnostic area and, in 
the project with the Maintenance Station, configure the OS pictures for the user diagnostic 
area. The user diagnostic area must be created in both projects.

Requirement   
The diagnostic structure has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. In the plant hierarchy, select a project for which you wish to create a user diagnostic 
structure.

3. In the tree view, select the diagnostic hierarchy folder directly below which the "AS objects" 
hierarchy folder is located.

4. Select the menu command Insert > Technological Objects > Hierarchy Folder.

Note

There may only be one hierarchy folder created for the user diagnostic structure under the 
"Diagnostics" hierarchy folder.

5. Select the hierarchy folder in the detail view.

6. Select the menu command Edit > Rename.

7. Enter a short, unique name and confirm with the Enter key.
The name is applied.
You can create additional hierarchy subfolders below this hierarchy folder.

Note

128 characters are available for the length of variable names.

You can find additional information about this in the manual Process Control System PCS 
7; Operator Station.

8. If you have not created the user diagnostic structure in the project of the MS server, you 
must update the plant hierarchy.
You can find additional information about this in the section "How to update the user 
diagnostic structure (Page 87)".
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5.13.3 How to create a CFC chart and insert an AssetM block

Introduction
The "AssetM" block is used to monitor user-specific sections of the plant. This block is 
integrated into a CFC. Multiple blocks can be integrated into a CFC.

Note

The procedure detailed here also applies to the AS system and field devices areas.

Requirement   
The user diagnostic structure has been created.   

Procedure
1. In the tree view, select the hierarchy folder in which you are creating a CFC.

2. Select the menu command Insert > Technological Objects > CFC.
A new CFC is created.

3. Select the CFC in the detail view.

4. Select the menu command Edit > Rename.
Enter a short, unique name and confirm with the Enter key. The name is applied.

Note

128 characters are available for the length of variable names.

You can find additional information about this in the manual Process Control System PCS 
7; Operator Station.

5. Mark the CFC in the detail view and select the menu command Edit > Open Object.

6. Select the "AssetM" block from the PCS 7 Advanced Process Library.

7. Drag-and-drop the block into the CFC.

8. Interconnect the signals, which are to be displayed via the PCS 7 Maintenance Station, 
using the "AssetM" block.
You will find additional information on the "AssetM" block in the Online Help for the block.

9. Execute steps 1 to 7 if you want to create additional CFCs.

Additional information
Additional information on this is available in the Process Control System PCS 7; 
Engineering System manual.

Configuring the maintenance stations
5.13 Configuring the user diagnostics

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 85



5.13.4 Assigning parameters for the AssetM block

Overview     
After the AssetM block has been placed in the CFC, interconnect the parameters that are to 
be used. 

In order to display information in the faceplate from SIMATIC PDM for the monitored 
component during process control, a SIMATIC PDM object must be created for each AssetM 
block in the process device plant view. 

This SIMATIC PDM object saves the rating plate (identification data) and the diagnostic texts. 
The "AssetMon" device is assigned to the SIMATIC PDM object.

The PLT ID is a connection parameter between a SIMATIC PDM object (parameter data EDD) 
and the faceplates in the Maintenance Station. 

The PLT-ID is linked to the SIMATIC PDM object.

Procedure
The PDM object is created in SIMATIC Manager as follows:

1. Select View > Process Device Plant View in SIMATIC Manager.

2. Select a project in SIMATIC PDM in which you want to insert the SIMATIC PDM object.

3. Select File > New object.

4. Select the inserted object with the right mouse button.

5. Select Device selection (Reassign)... in the shortcut menu.

6. In the tree structure, select Devices > DATA_OBJECTS > CFC > Siemens AG > 
AssetMon.

7. Click OK.

8. Select the object with the right mouse button.

9. Select Open object in the shortcut menu.

10.Enter all required data in the parameter assignment mask.

11.Select File > Save and close the parameter assignment mask.

12.Enter the generated PLT ID for the associated "PLT ID" block parameter.

Note

The PLT ID cannot be changed or deleted.

Additional information
You can find additional information on the AssetM block in the manual Process Control System 
PCS 7; Advanced Process Library.
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5.13.5 How to update the user diagnostic structure

Introduction
The following steps are only required if you have created a user diagnostic structure in a 
location other than the MS server project.   

You have to update the plant hierarchy in the multiproject.

Procedure
1. In the "plant hierarchy", select the project for which you have created a user diagnostic 

structure.

2. In the shortcut menu, select the menu command Plant Hierarchy > Update in Multiproject.
The "Plant Hierarchy - Update in Multiproject" dialog box opens.

3. Click "OK".
The "Plant Hierarchy - Update in Multiproject (target projects)" dialog box opens.

4. Enable the check box for the MS server's current project.

5. Click "OK".

6. Perform steps 1 to 6 for all the projects in a multiproject for which you have created a user 
diagnostic structure.

Result
The user diagnostic hierarchy of the other projects is added to the plant hierarchy in the project 
of the MS server.

5.13.6 How to Create User Diagnostic Screens

Introduction   
You create the user diagnostic screens in the hierarchy folders of the user-specific diagnostic 
structure in the project. In an MS single station system, this is the MS project. In an MS multiple 
station system, it is the MS server project.

You can create one user diagnostic screen per hierarchy folder.

Requirements
● The user diagnostic structure has been created.

● The CFCs for the user diagnostic structure have been created.

● A multiproject update is performed for multiprojects.
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Procedure
1. Open the plant view in the SIMATIC Manager.

2. In the tree view, select the hierarchy folder for which you want to create the user diagnostic 
screen.

3. Select the menu command Insert > Technological Objects > Picture.

4. Enter a short, unique name and confirm with the Enter key.
The name is applied.

5. Click "OK".

6. Select the picture in the detail view.

7. Select the menu command Edit > Object properties... .

8. Select the "Block icons" tab.

9. Select the "Derive the block icons from the plant hierarchy" check box.

10.Repeat steps 2 through 9 for all hierarchy folders into which you wish to insert user 
diagnostic screens.

5.13.7 How to create the group display hierarchy for the user diagnostics

Introduction   
You will need to refer to the information in this section if you have added a user-specific 
diagnostic structure to the diagnostic structure.

Requirement
The WinCC project is opened:

● In an MS single station system, this is the WinCC project of the MS.

● In an MS multiple station system, it is the WinCC project of the MS server.

Procedure
1. In the WinCC Explorer tree view select the "Project Editor".

2. Open the shortcut menu and select the menu command Open.
The "OS Project Editor" dialog box opens.

3. Select the "Message display" tab.

4. Enable the "Create/Update Group Displays" check box in the "Group display hierarchy" 
group.

5. Click "OK".
The group displays for the hierarchy calculation are automatically inserted into the screens 
when the hierarchy is saved, the OS is compiled or the OS is downloaded.
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5.14 Setting up SIMATIC PDM

Overview      
If you have configured devices with SIMATIC PDM, the following requirements must be met 
on the engineering station for visualization in the process control.

● Installation
The SIMATIC Process Device Manager (SIMATIC PDM) add-on package (requires a 
license) is installed.

● In the Windows Control Panel

– The Microsoft Internet Information Server (IIS) with ASP.NET support is installed.

– The rule in the firewall is enabled.

– The SIMATIC PDM users are added to the Logon_Administrator Windows group.

● In the Windows Start menu

– The SIMATIC PDM Web server is configured.

● In SIMATIC Manager:

– A PDM application is inserted in the PC station of the engineering station.

– In the SIMATIC PDM "Settings..."
The path to the maintenance project is entered on the "Maintenance Station" tab.
For multi-user engineering with several engineering stations, the path must be entered 
for each engineering station.

– In the SIMATIC PDM "Role management..."
All Windows users who use SIMATIC PDM Web are assigned the "Service user" role.

Additional information
You can find information about this in the following documents:

● Online Help for SIMATIC PDM
● Manual Process Control System PCS 7; Help for SIMATIC PDM

5.15 Overview of complete export

Overview

Note

You use this function in process control if you are using the MS Standard or SIMATIC PDM MS 
version of the maintenance station.

Identification data from all diagnostics-capable components (such as field devices, PCs, AS 
components, network components) can be exported.     
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With complete export, the data from all the components with diagnostics functionality is 
exported to the export file "@XML_Export.sml".

The complete export file is stored in the default target directory on the MS in the "AssetExport" 
folder of the OS project directory.

The complete export file is stored on both partners in a redundant system.

The complete export file can also be stored in a configured target directory (e.g., for reuse of 
the data in external systems). 

You can find information on this in the section "Storage location for the files of the (filtered) 
total export (Page 77)".

In the process control, the system allows you to display the data of the last complete export 
in filtered form and to export this data.

Additional information
You can find additional information about displaying and exporting the data in process control 
in the section "Functions in the overview screen (Page 113)".

5.16 Overview of individual export

Overview  

Note

You use this function if you are using the MS Standard or SIMATIC PDM MS version of the 
maintenance station.

Data of a diagnostics-capable component (such as field devices, PCs, AS components, 
network components) can be exported.     

During an individual export, the data of a diagnostics-capable component is written to an export 
file.

The file name is automatically generated by the system.

The individual export file is stored in the default target directory on the MS in the "AssetExport
\Out" folder in the OS project directory.

The individual export file is stored in the standard target directory on the connected OS server 
(current preferred server) in a redundant system.

The individual export file can also be stored in a configured target directory (e.g. for reuse of 
the data in external systems). 

You can find information on this in the section "Configuring maintenance targets for individual 
export (Page 67)".
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Structure of the file name
The name of the export file is structured as follows:

"<Tagname>_<AssetID>_YYYY_MM_DD_HH_MM_SS_SSS.XML"

Structure of the file name Description
<Tagname> Configured name of the component (see rating plate)
<AssetID> Unique, system-assigned identification number of the component
YYYY_MM_DD_HH_MM_SS_SSS Date and time of the export
xml File type 

Additional information
You can find additional information about displaying and exporting the data in the process 
control in the section ""Maintenance" view (Page 196)".

5.17 Engineering for maintenance

5.17.1 Engineering for release request

Introduction
You must make interconnections on the blocks in the CFC for the release request.

We recommend that the configuration steps be taken into consideration when the typicals are 
created.

Requirements
● The CFC typicals have been created.

● The PCS 7 Advanced Process Library V8.2 or higher is used.

Procedure
1. Open the CFC typical.

2. Interconnect the output parameter MS_Req of the channel block with a free input parameter 
ExtMsg of the technological block.

3. Change the message class of the utilized external message on the technological block to 
the message class not requiring acknowledgment "Request for operator input - General".

4. Adapt the event text as desired.

You can connect the release request signals of multiple channel blocks to the technological 
block with an OR operation.
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Result
The release request "Sequence for maintenance (Page 244)" can be used.

After AS and OS compilation and subsequent download, the changes are applied in the 
process control.

Compile and download the OS in which the technological block will be displayed.

Additional information
You can find additional information on maintenance in the section "Overview of maintenance 
(Page 243)" and in the manual Process Control System PCS 7; Advanced Process Library.

5.17.2 Engineering for maintenance release

Introduction
You must make interconnections on the blocks in the CFC chart for the maintenance release.

We recommend that the configuration steps be taken into consideration when the typicals are 
created.

Requirement
● The CFC typicals have been created.

● The PCS 7 Advanced Process Library is used.

Procedure
1. Open the CFC typical.

2. Interconnect the output parameter MS_Release of the technological block with the input 
parameter MS_Release of the channel block.
You can interconnect the maintenance release of a technological block to multiple channel 
blocks.

3. Interconnect the output parameter OosAct of the channel block with the input parameter 
OosLi of the technological block.
You can connect the "In maintenance" information (OosAct) of multiple channel blocks to 
the technological block with an OR operation.

4. Use the feature bit "Reaction to the out of service mode" to define the desired behavior of 
the technological block.

Result
The maintenance release "Sequence for maintenance (Page 244)" can be used.

After AS and OS compilation and subsequent download, the changes are applied in the 
process control.
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Compile and download the OS in which the technological block will be displayed.

Additional information
You can find additional information on maintenance in the section "Overview of maintenance 
(Page 243)" and in the manual Process Control System PCS 7; Advanced Process Library.

5.18 Creating/updating the diagnostic screens

Introduction
The diagnostic screens in the diagnostics area with their block icons are created or updated 
with this function.

The "@@maintenancetypicals.pdl" file contains all the templates for block icons which are 
used to display the diagnostic information.     

If you execute the "Create/update diagnostic screens", PCS 7 automatically uses block icons 
from this file. This file is installed as standard during the installation of PCS 7.

You can customize block icons to your specific requirements. 

Note

If you want to customize the standard block icons included in the @@maintenancetypicals.pdl 
file, do not change this file. All changes in this file are overwritten by an update.

Always create a new file. The name of the file starts with the fixed name component 
"@maintenancetypicals". You can specify the rest of the file name yourself. Insert the required 
block icons there and customize them.

The process is exactly the same as for adapting the standard block icons.

You can find additional information about this in the section "Example: Creating object 
templates" in the WinCC Information System online help.

You can find additional information on positioning block icons in the section "Automatic 
positioning of block icons in the areas (Page 75)".

Requirements     
The configuration must have the following status:

● The settings relating to the diagnostic structure have been made.
You can find information on this in the section "How to make the settings in the plant 
hierarchy (Page 61)".

● The "Language for display devices" is set as the default language in the SIMATIC Manager. 
Texts displayed during process control are generated in this language.

● When you use SIMATIC PDM, the maintenance project is configured in the settings for the 
SIMATIC PDM project.
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Procedure
1. Open the SIMATIC Manager and activate the plant view.

2. Select the required hierarchy folder in the tree view.

– If you want to create diagnostics screens for the multiproject/project, select the 
multiproject/project.

– If you wish to create diagnostic screens for certain hierarchy folders, select the required 
hierarchy folder in the maintenance station.

3. Select the Options > Plant Hierarchy > Create/Update Diagnostics Screens menu 
command.

4. If you have already compiled the AS charts, no other dialog box is opened, and the 
diagnostic screens are created/updated directly.
Proceed to step 6.

5. If you haven't compiled the AS charts yet, the "Create module drivers" dialog box is opened 
one after another for every CPU for which this function has not been executed yet. 
Click "OK" in all dialog boxes to create the required diagnostic blocks.

Note

If you click "Cancel" in this dialog box, no module drivers are created for this CPU, and the 
diagnostic screens are not updated!

6. The "Create/update diagnostic screens" dialog box opens after the completion of the 
generation process.
Click "Yes".
The function log is displayed in the "WordPad" editor. If error messages appear, rectify the 
errors and run the function again.

7. Close the "WordPad" editor.

Result
The diagnostic screens are created or updated.

After OS compilation and subsequent download, the diagnostic screens are displayed in the 
process control.

Displaying a log of the diagnostic screens   
In the SIMATIC Manager select Options > Plant Hierarchy > Diagnostics Screen Log.

The diagnostic screen log contains information about the creation of the diagnostic screens.

Configuring the maintenance stations
5.18 Creating/updating the diagnostic screens

Maintenance Station
94 Function Manual, 05/2017, A5E41291135-AA



5.19 Compiling and downloading

5.19.1 Compilation and downloading of the Maintenance Station

Compiling and downloading an MS single station system or multiple station system
● Compile    

The diagnostic screens you generated or updated must be compiled and downloaded to 
the maintenance station.
Before you compile the maintenance station, the diagnostic screens have to be created at 
least once or updated after configuration changes.
"Area-oriented" must be set as OS compilation mode.
In an MS single station system, compile the MS.
In an MS multiple station system, compile the MS server.

Note

Clear the "Picture Tree" check box in the dialog for OS compilation if you do not want to 
derive the hierarchy from the plant areas.

The hierarchy for the diagnostic area is created even if the check box is cleared.

● Downloading    
Perform the download after the compilation.
If you are using an MS multiple station system, load the MS server.
If you are using a redundant MS multiple station system, download the MS server and the 
redundant partner.
You must not download an MS single station system.

5.19.2 Compiling and downloading SIMATIC PDM MS

Requirements
● Configuration in the process device network view has been completed.

● The parameter view for all field devices has been opened once.

● The "Create/update diagnostics screens" function has been executed.

● The project is open in SIMATIC Manager.
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Procedure 

Compiling and downloading charts
1. Select the "Charts" hierarchy folder in the component view of SIMATIC Manager.

2. Select the Edit > Compile menu command.

3. Select the following check boxes:

– Entire program

– Generate module drivers

Download WinLC RTX
1. Select the PC station in the component view of the SIMATIC Manager.

2. Select the menu command PLC > Download.

Compiling OS
1. Select the OS hierarchy folder in the component view of SIMATIC Manager.

2. Select the Edit > Compile menu command.

3. Select the following check boxes:

– Entire OS

– With memory reset

Download OS
The OS for SIMATIC PDM MS does not have to be downloaded.

5.20 Assigning the server data and downloading of a client

Server data
Before an MS or OS/MS client is downloaded,  it must be assigned the relevant OS server. 
This loads the server data to the MS or MS/OS client project.

Client Server data (server package)
MS server OS servers

whose automation systems are being 
monitored

OS server
whose OS area is dis‐
played

MS client on an engi‐
neering station

X X -

MS client on a sepa‐
rate PC station
OS/MS client X X X
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Downloading
The MS client or OS/MS client is downloaded in exactly the same way as an OS client. The 
MS client in the engineering station does not have to be downloaded.

Additional information
Additional information is available in the manual Process Control System PCS 7; Operator 
Station in the sections "Downloading the server data" and "How to compile and download 
several operator stations".

5.21 Changes in the project
You can find information about the following changes in the sections below:

● Changes in the version (Page 97)

● Changes in HW Config (Page 98)

● Adding an AS subproject (Page 98)

● Adding an OS server (Page 99)

● Subsequently defining OS server as MS server (Page 99)

● Assigning another OS as MS station (Page 99)

● Changes in the software (Page 101)

● Changing the storage location of a subproject (Page 101)

5.21.1 Change in the version

You change the version in the SIMATIC Manager in the plant hierarchy settings. You can find 
additional information about this in the section "How to make the settings in the plant 
hierarchy (Page 61)"

If you change the version of the maintenance station, you must observe the following:   

● MS Standard to MS Basic

– The diagnostic structure below the AS objects, the diagnostic structure of the field 
devices and the user diagnostic structure including the contained pictures are deleted.

● MS Basic to MS Standard

– The diagnostic structure of the AS objects is regenerated.

– The diagnostic structure of the field devices is created.

● MS Standard to SIMATIC PDM MS

– The diagnostic structure of the AS objects including the contained pictures is deleted.

– The diagnostic structure of the field devices is regenerated.
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● SIMATIC PDM MS to MS Standard

– The diagnostic structure of the field devices including the contained screens is 
regenerated.

– The diagnostic structure of the AS objects is generated.

● MS Basic to SIMATIC PDM MS

– The diagnostic structure of the AS objects including the contained pictures is deleted.

– The diagnostic structure of the field devices is created.

● SIMATIC PDM MS to MS Basic

– The diagnostic structure of the field devices and the user diagnostic structure including 
the accompanying screens are deleted.

– The diagnostic structure of the AS objects is generated.

After changes, you may have to perform the following tasks:

● Creating/updating the diagnostic screens (Page 93)

● Compilation and downloading of the Maintenance Station (Page 95)

● Assigning the server data and downloading of a client (Page 96)

5.21.2 Changes in HW Config

Changes in the hardware configuration of the engineering system affect the displays in the 
diagnostic screens.

After changes, perform the following tasks:

● Creating/updating the diagnostic screens (Page 93)

● Compilation and downloading of the Maintenance Station (Page 95)

5.21.3 Adding an AS subproject

Perform the following tasks if a subproject with an AS is added after creating the diagnostic 
structure:

● Enable diagnostics derivation in the plant hierarchy settings of the newly added subproject. 
Confirm the following information. 
Exit the dialog with "OK".

● Creating/updating the diagnostic screens (Page 93)

● Compilation and downloading of the Maintenance Station (Page 95)
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5.21.4 Add OS server

Perform the following tasks if an OS server is added after creating the diagnostic structure in 
the multiproject/project:

● Assign server data of the OS server to the MS server
You can find more information on this topic in the Process Control 
System PCS 7; Operator Station manual in the section "How to load server data".

● Load MS server
You can find additional information about this in the section "Compilation and downloading 
of the Maintenance Station (Page 95)". 

5.21.5 Subsequently defining OS server as MS server

If an OS server is defined at a later point in time as MS server in a plant in operation, you need 
to perform not only the configuration tasks described for the MS server but also a download 
for the OS client, which assumes the role of the OS/MS client.

For additional information on downloading, refer to the section "Assigning the server data and 
downloading of a client (Page 96)".

5.21.6 Assigning another OS as MS station

Perform the steps in the table if you subsequently use another OS as MS server in an operating 
plant.

This assigns MS functionality to another OS.

The steps in the table apply to the example configuration. The example configuration consists 
of a redundant OS server (original MS) and a redundant MS server (new MS).

Step Project Action Comment
1 OS server

 
If required:
Back up the existing diagnostic screens.

Only required for screens in which project-spe‐
cific adjustments have been made so that these 
adjustments can later be reapplied.

2 2.1 OS server master HW Config\OPC server\SNMP:
Delete all SNMP devices.

The SNMP configuration is prepared for transfer.

2.2 Export the entire SNMP plant configuration 
using "Export variables for WinCC".

All SNMP variables and associated messages 
are deleted from the OS server.

2.3 Delete the OPC server. The OPC server of the OS server standby is lat‐
er copied to the MS server master and MS serv‐
er standby.

2.4 Save and compile HW Config. The changes in the HW Config of the OS server 
master are now complete.
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Step Project Action Comment
3 Plant hierarchy Disable the "Derive diagnostic screens from 

the plant hierarchy" function.
Note:
This does not delete any server packages in 
the OS server.
Remove the server packages that are not 
required from the assignment.

The following applications are removed from the 
startup list:
● IMServerX.exe 

(Found on all OS servers when the "Derive 
diagnostic screens from the plant hierarchy" 
function is enabled)

● OsStateMashineX.exe
● AsOsHeartBeatX.exe
● OSLTMHandlerX.exe

4 Plant hierarchy Enable the "Derive diagnostic screens from 
the plant hierarchy" function.
Specify the assignment to the new MS serv‐
er.

● Changes can now no longer be downloaded 
to the MS server.

● The applications listed in step 3 are added 
to the MS server startup list.

● The IMServerX.exe application is added to 
the startup list of the other OS servers.

5 OS server standby Copy the OPC server from the OS server 
standby in HW Config to the MS server mas‐
ter and MS server standby.

The OPC server has now been added to the 
configuration of the new MS server.

6 OS server standby Delete the OPC server from the OS server 
standby. Save and compile the HW Config 
of the OS server master and standby.

There is now no OPC server in the OS server 
(original MS server).

7 OS server master Compile the OS server using the options 
"Entire OS" and "Memory reset".

The OS server is compiled.

8 Plant hierarchy Run the "Create/Update diagnostic screens" 
function.

The diagnostic screens are created.

9 MS server If required:
Replace the diagnostic screens generated 
in the MS server with the screens you 
backed up in step 1.

Perform this action at the Windows Explorer lev‐
el.
Ensure that the screen names are the same. 

10 Plant hierarchy Run the "Create/Update diagnostic screens" 
function.
Note
This step is necessary if you have carried 
out step 9.

The variable interconnections in the screens are 
corrected (for example, server prefix).

11 11.
1

MS server master Compile the MS server using the options 
"Entire MS" and "Memory reset".

The MS server is compiled.

11.
2

HW Config\OPC server\SNMP: 
Export the entire SNMP plant configuration 
using "Export variables for WinCC".

The variable and messages for SNMP devices 
are created on the MS server.

12 12.
1

MS server master Configure and download the PC stations 
(station configuration editor).

The modified configurations are transferred to 
the station configuration editor of the target sys‐
tem.12.

2
MS server stand‐
by

12.
3

OS server master

12.
4

OS server standby
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Step Project Action Comment
13 13.

1
MS server master Load the servers.

 
 
 

The OS projects are transferred to the target 
systems.

13.
2

MS server stand‐
by

13.
3

OS server master

13.
4

OS server standby

14 OS clients Load all OS clients that are to be displayed 
the diagnostics area.

The OS projects with modified database entries 
are transferred to the target systems.

5.21.7 Changes in the software

● Change the standard message server for the "Alarms" component
If the assigned standard message server for the "Alarms" component is changed in a plant 
configuration in a multiple-station system with an OS client, the MS server then has to be 
compiled and downloaded.
You can find additional information about this in the manual Process Control System PCS 
7; Operator Station in the section "How to assign the standard server".

● Change the screen resolution
If the screen resolution is changed in the "Available Layouts:" group on the "Layout" tab of 
the OS project editor, the next time "Create/Update Diagnostic Screens" is called, the 
available overview screen is renamed and a new overview screen that corresponds to the 
new screen resolution is created. A respective message is included in the log of the function 
"Create/Update Diagnostics Screens". This also provides the new name of the former 
overview screen.
If you have manually changed the overview screen, you can manually carry out the changes 
in the current overview picture by copying from the former overview screen.
All other existing diagnostic screens retain their screen resolution. If the images are created 
in a new screen resolution, you must manually delete the screens. User-specific changes 
will be lost.

5.21.8 Changing the storage location of a subproject

If you change the storage location of a subproject with the "Save As" function, you must stop 
the SIMATIC PDM Asset Service before performing the "Save As" operation.

When the "Save As" operation is finished, you must restart SIMATIC PDM Asset Service.
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5.22 Deleting the diagnostics area

Introduction
During deletion of the diagnostic structure, the following is deleted:

● Diagnostics hierarchy folder with all subfolders

● Target objects

● Action objects

● Link objects

Requirement   
● The diagnostic structure and/or user diagnostic structure has been created.

Note

If you have manually changed diagnostic screens, make sure that you make a backup copy 
before deleting, because all changes will be lost after deleting and recreating the diagnostic 
structure.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Settings... .
The "Plant Hierarchy - Settings" dialog box opens.

4. Proceed as follows if you have selected a multiproject:

– Click "OK". 
The "Plant Hierarchy - Settings" dialog box opens.

– Proceed to step 6.

5. If you have selected an individual project or a project within a multiproject, the "Plant 
Hierarchy - Settings" dialog box opens.

6. Disable the "Derive diagnostic screens from the plant hierarchy" check box.

7. Click "OK".

Note

The complete diagnostic structure and all the diagnostic screens are deleted, including the 
user diagnostic structure.

The charts with the diagnostic blocks and the charts of the user diagnostics are not deleted 
during this process; they remain in the chart folders for the S7 programs.
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8. Compile the OS.

9. In an OS multiple station system, download the OS server.
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Operator control and monitoring 6
6.1 Starting the process control

MS Standard and MS Basic     
The start of the process control of a Maintenance Station is the same as the start of the process 
control of an Operator Station.

When an MS multiple station system and SIMATIC PDM are used, the engineering station 
must be switched on and the SIMATIC PDM Asset Service started for the SIMATIC PDM device 
data to be provided.

SIMATIC PDM MS
Before activating process control, check the setting for the WinCC project type in WinCC 
Explorer. A single station project must be set as the project type.

Activate process control in WinCC Explorer using the "Activate" button.

User administration
Creation of users and assignment of user rights for operator control and monitoring in pictures, 
faceplates, alarm lists and for operation of the system functions is the same as in PCS 7 OS. 
You can find additional information on this topic in the Process Control System PCS 7; 
Operator Station manual and the WinCC Information System online help.

OS simulation
You can only use the OS simulation function in the MS Standard or MS Basic version.

OS simulation for a PCS7 Maintenance Station in MS Standard and MS Basic is possible only 
to a limited extent (for example, no identification or diagnostics data).
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6.2 Layout of the user interface

User interface in the process control   
The user interface is structured in the same way as the Operator System interface. It is divided 
into 3 areas: 

● Overview area (Page 107)
The overview area is displayed permanently. Its group displays for the various plant areas 
and the message line provide an overview of the entire plant.
Display and operator control in the overview area is the same as display and operator 
control in an OS.
If deviations exist, the document points this out.

● Working area (Page 110)
In the working area, the overview screen, the area overview screens and the diagnostic 
screens of the individual components are displayed for the diagnostics area.

● Button area (Page 110)
The button area is displayed permanently. It comprises several button sets between which 
the maintenance engineer (operator of the "Diagnostics" area) can switch. 
The keys in the button sets are operated in the same way as the keys in an OS. 
If deviations exist, the document points this out.

The following figure shows an example of the user interface:
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Additional information
You can find additional information on this in the manual Process Control System PCS 
7, OS Process Control.

6.2.1 Overview area

Display in the overview area
The following figure shows an example of the overview area:     

This section only describes the displays and buttons that are specific to the Maintenance 
Station.

"Highest priority messages" list button
If at least one message with Priority 16 is active (came in or came in acknowledged state), the 
button is displayed. This priority is predefined by the system for emergency operation of an 
AS. 

To display the "Highest priority messages" list, click the button.

Button Function Permission
"Highest priority messag‐
es" list is called

Enable for the diagnostics area

In addition to the display, an AS process control message without area information is 
generated. The message is triggered as soon as at least one highest priority message in the 
"Diagnostics" area is pending.

As soon as all highest priority messages in the "Diagnostics" area have gone out, the message 
without area information is assigned the status "outgoing".

For more information on configuration of the message priority see the manual Process Control 
System PCS 7; Operator Station.

Sum status of the plant
The plant operator obtains an overview of the statuses of the individual areas from the 
"Diagnostics" area.

The displays are shown on each operator station regardless of whether the "Diagnostics" area 
is assigned to this operator station.
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The following cases are exceptions to this:

● OS single-station projects

● All operator stations of a project if the Maintenance Station is an OS single-station project.

The following table shows an example of the assignment of the displays to their area and 
describes the possible states that each display can have.

Display Area State
PC stations ● Gray:

There is no problem in the area.
● Yellow:

There is at least one maintenance 
demand in the area.

● Red:
There is at least one maintenance alarm 
in the area.

● Yellow/red:
There is at least one maintenance 
demand and one maintenance alarm in 
the area.

● Blue:
There is no connection to the MS server.

 

Network objects

AS/system

Note

If no maintenance group display is created for an area in the overview screen of the 
"Diagnostics" area, the corresponding display is also not shown. 

Messages without area information regarding maintenance state
The system generates AS process control messages without area information regarding the 
maintenance state of components.

These messages are displayed on every OS station:

● In the single message line of the overview area

● In the message lists

It does not matter whether the "Diagnostics" area is shown on the operator station or not.

If at least one component has the state "maintenance alarm/demand" in one of the diagnostics 
areas (PC stations, network objects, AS/system), a message without area information of the 
same message type is also generated for this area.

When no more components have the state "maintenance alarm/demand", the message without 
area information is assigned the status "outgoing".
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The following table shows the messages without area information:

Message 
type

Priority Message text

Fault  0 ● Maintenance alarm in the PC stations area of MS
● Maintenance alarm in the network components area of MS
● Maintenance alarm in the AS system area of MS

Error  0 ● Maintenance demanded in the PC stations area of MS
● Maintenance demanded in the network components area of MS
● Maintenance demanded in the AS system area of MS

Area key for the diagnostics area
The following figure shows an example of the area key for the diagnostics area:

The area key is used to open the overview screen for the diagnostics area.

Navigation through the picture hierarchy is similar to navigation through the picture hierarchy 
of the OS areas.

Group display for the diagnostics area
In addition to the area key, the current message state is displayed on the third button of the 
group display of the entire diagnostics area.

The lower-level area overview screen is called via the group display.

The following table shows default system settings for the possible states:

Display Message type/state Priority Message state
Message is locked (1) 1 -

AS process control fault 2 ● "S" display
● Flashing

Incoming message
● Static

Message acknowledged
AS process control error 3 "F" display

● Flashing
Incoming message

● Static
Message acknowledged
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Display Message type/state Priority Message state
Maintenance demanded 4 "M" display

● Flashing
Incoming message

● Static
Message acknowledged

No message is pending 5 -

The number in the priority column indicates the priority of the display. The lowest number has 
the highest priority. 

Note that unacknowledged messages have a higher priority than acknowledged messages.

(1) At least one message is locked. Messages can only be locked for components from the 
AS/system, user objects, and field devices areas.

6.2.2 Button area

Representation of the button area
The figure below shows an example of a button set from the button area.     

This section only describes the buttons that are specific to the Maintenance Station.

Locking/unlocking messages       
If a screen is open within an AS in the AS/System and Field devices area, messages can be 
locked or unlocked for the components shown in this screen and their subordinate components.

If a screen is open below the overview screen in the User objects area, messages can be 
locked or unlocked for the components shown in this screen and their subordinate components.

This function is not available in the PC stations and Network objects areas. 

You can find additional information on enabling/disabling messages in the section: "How to 
lock and unlock messages (Page 186)".

6.2.3 Working area

Display in the working area
The diagnostic screens are displayed hierarchically in the working area.     

You usually get from the overview to the detail via the hierarchy.

You can also change the screen via the hierarchy buttons in the button set.
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The overview screen is the highest hierarchy level. You get to the respective area overview 
screen via the maintenance group displays of an area.

The components are displayed as block icons in the area overview screen. 

The working area also displays faceplates, operator control windows, message lists and dialog 
windows.

Navigation information can be displayed in the diagnostic screens. You can find information 
on configuring in the section "Navigation information in the screen (Page 78)".

Additional information
You can find additional information in the following sections:

● Overview screen (Page 111)

● Area overview screens (Page 163)

● Block icon (Page 165)

● Faceplate (Page 178)

6.3 Overview screen

Introduction
The maintenance engineer gets an overview of the plant status of the entire plant in the 
overview screen.

You can use the buttons to launch various functions. The functions are described in the 
following sections.

A maintenance group display is shown in each area if there is at least one lower-level picture 
for this area. The areas are shown in color as shown below: 

● PC stations (on a yellow background)

● Network objects (on a green background)

● AS/system (cyan background)

● Field devices (cyan background)

● User objects (on a light blue background)

Note

The "Field devices" area is only created if you use the PCS 7 Basic Library >=V8.1 in the AS.

If you use the PCS 7 Basic Library <=V8.1 in the AS, all field devices are assigned to the "AS 
system" area.

The following figure shows an example of the overview screen for the diagnostics area:   
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Calling the overview screen
You call the overview screen as follows:

● Area button

● Group display in the overview

● Picture Tree Navigator

● Navigation buttons in the button set

Maintenance group display in the overview screen
The maintenance group display gives maintenance engineers an overview of the plant status 
of the individual area.

You can change to the area screen from the maintenance group display.

The following table shows the possible states:

Display Message class/status Message state
Message is locked (1) -

AS process control fault/
maintenance alarm

"S" display
● Flashing

Incoming message
● Static

Message acknowledged
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Display Message class/status Message state
AS process control error/
maintenance demanded

"F" display
● Flashing

Incoming message
● Static

Message acknowledged
Preventive maintenance/
maintenance required

"M" display
● Flashing

Incoming message
● Static

Message acknowledged
No message is pending -

(1) At least one message is locked. Messages can only be locked for components of the areas 
AS/system, user objects and field devices.

6.4 Functions in the overview screen

6.4.1 Overview

Functions in the overview screen 
The following functions can be executed in the overview screen:

● Calling web pages via maintenance links (Page 113)

● Complete export (Page 114)

● Accessing the "Manually filtered complete export" function (Page 115)

● Cyclically filtered complete export (Page 125)

● Overview of system functions (Page 132)

● Filtered manual parameter data export (Page 136)

● Filtered cyclic parameter data export (Page 156)

6.4.2 Calling web pages via maintenance links

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.
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Introduction
Up to 10 Web pages that are used to provide support for diagnostics measures can be called. 
The buttons are displayed when the calls are configured.   

The first 3 buttons are also displayed in the header of the faceplate.

Requirements
● The maintenance target (web address) has been configured.

● The maintenance target can be accessed via the network.

Button on the user interface

Button Function Permissions

to

Display of the Web page
Tooltip text: Name of the maintenance link

"Higher process controlling" for diagnos‐
tics area

Procedure
1. Click the button.

Result
The web page is displayed in a screen window.

Additional information
You can find information on configuring in the section "Configuring maintenance links 
(Page 65)".

6.4.3 Complete export

Introduction     
The complete export is used to export the electronic rating plate and component status of all 
the objects with diagnostics functionality (for example, field devices, PCs, and network 
components). 

This file forms the basis for the filtered complete export.
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Button on the user interface

Button Function Permissions
Trigger complete export "Process controlling" for the diagnostics 

area

Procedure
1. Click the button.

Result
The complete export is executed. 

The information is saved to the file "@XML_Export.sml".

Additional information
You can find information on configuring in the section "Overview of complete export 
(Page 89)".

6.4.4 Manually filtered complete export

6.4.4.1 Accessing the "Manually filtered complete export" function

Note

This function is available only for the Maintenance Station in the MS Standard and SIMATIC 
PDM MS versions.

Note

Avoid parallel access to the filtered manual complete export.

Introduction     
The system allows you to display the data of the last complete export filtered and to export 
this data.

A complete export is performed automatically when this function is used.

Various filter criteria are available for filtering data.
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Button on the user interface

Button Function Permissions
Filter device status
● Call filter view
● Filter data

"Process controlling" for the diagnostics 
area

Procedure
1. Click the button.

Result
The view of the faceplate for the manually filtered complete export is displayed.

Additional information
You can find additional information on filtering in the section "How to filter and save the data 
of the complete export" below.

6.4.4.2 Filter settings for the manually filtered complete export

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.

Introduction
A range of filter criteria are available in the faceplate for the manually filtered complete export. 

The manually filtered complete export can be launched.

When you open the faceplate, you see an overview of the last manually filtered complete export 
job executed or active.

If a manually filtered complete export job is active, you cannot change any filter settings. 
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Display
The following figure shows an example of the faceplate for the manually filtered complete 
export.

Operator control

Display Explanation Operator per‐
mission

The option is selected by clicking on the check box.
● Maintenance status, Maintenance job, Maintenance 

status, Priority and Device management areas
The filter criteria are selected.

● Type information area
Option for negation of the logical operator for type 
information

None

Option for the logical operator for type information None
Part of the identification data, for example, the device type for 
which the search text is used

None

Input of search text None

Clicking the button sets all filter criteria. None

Clicking the button resets all filter criteria. None
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Display Explanation Operator per‐
mission

Clicking the "Log" button opens the result of the last manually 
filtered complete export from the default export directory on 
the maintenance server.

None

Clicking the button shows the operator panel for starting the 
update.
An active manually filtered complete export must be comple‐
ted before you can start a new one.

None

Operator panel for updating/canceling 
The following figure shows an example of the operator panel:

● Operator control

Button Explanation Operator per‐
mission

Clicking the button starts the manually filtered complete ex‐
port with the selected filter settings.

None

Clicking the button cancels the operation. None

6.4.4.3 Manually filtered complete export

Note

The manually filtered complete export is available for the Maintenance Station in the MS 
Standard and SIMATIC PDM MS versions.

The manually filtered complete export can be controlled by operator input in the faceplate or 
remotely via OPC access on the MS.

Note

The manually filtered complete export and remote access via OPC use the same variable 
structure.

This is why they are not independent of each other and can influence each other.

Export file
One export file is created for every manually filtered complete export.

The export file is saved to the MS server project.
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An additional storage location can be specified in the ""Other settings" tab (Page 75)" tab under 
"Advanced diagnostic settings".

The name of the export file is structured as follows: "LogFilteredExportManually_YYYY-MM-
DD_HH-MM-SS-SSS.XML". 

The most recent export file is also stored with the following name for display in the faceplate: 
"CurrentFilteredExportManually.XML".

The export file contains the following information:

● Overall status of the manually filtered complete export

● Start time, end time and duration of execution

● Information on manually filtered complete exports with errors or that were not performed

The storage location contains the three most recent export files. Older export files are deleted 
from the system.

If an export file cannot be deleted due to access conflicts, an error message is generated in 
the process control. The system attempts to delete the export file during the next export.

If an export file cannot be written with the defined name due to access conflicts, an error 
message is generated in the process control. The file name is suffixed with "(<x>)", where x 
is a natural number beginning with "1".

Reaction of the manually filtered complete export when the SIMATIC PDM ASSET service is stopped
● The SIMATIC PDM ASSET service is stopped due to archiving

The project states are regularly archived on the engineering station in many plants. 
The SIMATIC PDM ASSET service must be stopped and locked to prevent it restarting for 
the duration of archiving. 
No jobs can be accepted during this time. The Maintenance Station call is rejected.
In this case, a manually filtered complete export that is to be started or is already running 
is paused for the duration of archiving.
The system checks every 10 minutes whether it is possible to resume the manually filtered 
complete export. The check is repeated 20x.
Each check is entered in the log with a time specification.
In this phase, the status in the "...State" variable remains 0xFFFF.
If the start is successful, the manually filtered complete export continues. 
If the start fails after the maximum number of retries, the filtered manual complete export 
is canceled with a message in the message system.

● The SIMATIC PDM ASSET service is not running for other reasons
In this case, the Maintenance Station attempts to start the SIMATIC PDM ASSET service. 
If the start is successful, the manually filtered complete export starts or continues.
If the start fails, the manually filtered complete export is canceled with a message in the 
message system.

Additional information
For additional information, please refer to the following sections.
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6.4.4.4 How to filter and save the data of the manually filtered complete export

Note

This function is available only for the Maintenance Station in the MS Standard and SIMATIC 
PDM MS versions.

Requirement     
● The faceplate for the manually filtered complete export is open. The view for the manually 

filtered complete export is displayed.

● The manually filtered complete export is not running at this time.

● The cyclically filtered complete export can be enabled.

● Processing of the cyclically filtered complete export is not running at this time.

Procedure
1. Select the filter criteria you require.

– Select the desired filter criteria check boxes in the following groups:
- Maintenance status
- Maintenance job
- Priority
- Maintenance status
- Device management
If multiple filter criteria are selected, they are ORed.  
Exception: An exception to this is the "Loop check: On previous day" check box, which 
is only taken into consideration when the "Loop check" check box is selected.

– You can enable all filter criteria with the "Select all" button.
Click "Deselect all" to clear all filter criteria selected.

– In the "Type information" group, you can select an area from the drop-down lists and 
enter the text you are looking for in the input boxes.
You can use the characters "*" and "?" as wildcards.
Link the fields.

2. Click the "Refresh" button.
The view expands to include the operator panel.

3. Click "OK".
A picture window with the result will appear.

4. Click "Save" if you want to save the result in an export file. 
An operator message is triggered. 

Additional information
You can find additional information on the name and storage location in the section "Overview 
of complete export (Page 89)".

Operator control and monitoring
6.4 Functions in the overview screen

Maintenance Station
120 Function Manual, 05/2017, A5E41291135-AA



6.4.5 Manually filtered complete export via OPC

6.4.5.1 Variables for OPC access

Introduction
The manually filtered complete export can also be run via OPC access.

The information for the manually filtered complete export is stored in a structure variable.

This variable structure can be directly accessed by another computer via the OPC DA interface.

You can find information on establishing an OPC connection in the WinCC Information 
System online help.

Variables for OPC access 
The required information is stored in the following variables:

Name of the variable Data 
type

Syn‐
chroni‐
zation

Ini‐
tial 
value

Explanation Access
via OPC(1)

@AssetInfoExportControl.MSFilter DWord X 0 Filter for devices Read/write
@AssetInfoExportControl.TypInfo String X  Type information Read/write
@AssetInfoExportControl.Start Byte - 0 "Start" command Read/write
@AssetInfoExportControl.State DWord X 0 Status or group error entry Read/write
@AssetInfoExportControl.DateStar‐
ted

Date&
Time

X 0 Start time of the export Read

@AssetInfoExportControl.DateFinish‐
ed

Date&
Time

X 0 End time of the export Read

(1)The "Access via OPC" column explains how the variables are to be used.

@AssetInfoExportControl.MSFilter
The following tables show the permitted values for bits 0 to 31.

If multiple bits are set, the states are ORed. 

Exception: An exception to this is bit 24 "Loop check: On previous day", which is only taken 
into consideration when bit 21 "Loop check" is set. 

Bit 15 14 13 12 11 10
 

9 8 7 6 5 4 3 2 1 0

Maintenance state
Good - - - - - - - - - - - - - - - 1
Passivated - - - - - - - - - - - - - - 1 -
Out of service - - - - - - - - - - - - - 1 - -
Simulation - - - - - - - - - - - - 1 - - -
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Bit 15 14 13 12 11 10
 

9 8 7 6 5 4 3 2 1 0

Local operator con‐
trol

- - - - - - - - - - - 1 - - - -

Maintenance re‐
quired

- - - - - - - - - - 1 - - - - -

Maintenance de‐
manded

- - - - - - - - - 1 - - - - - -

Maintenance alarm - - - - - - - - 1 - - - - - - -
Device status un‐
known

- - - - - - - 1 - - - - - - - -

Configuration 
change

- - - - - - 1 - - - - - - - - -

Maintenance job
Maintenance re‐
quired requested

- - - - - 1 - - - - - - - - - -

Maintenance de‐
mand requested

- - - - 1 - - - - - - - - - - -

Maintenance 
alarm requested

- - - 1 - - - - - - - - - - - -

Maintenance status
Completed - - 1 - - - - - - - - - - - - -
Canceled - 1 - - - - - - - - - - - - - -
In maintenance 1 - - - - - - - - - - - - - - -
...

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
...
Maintenance not 
started

- - - - - - - - - - - - - - - 1

Planned mainte‐
nance

- - - - - - - - - - - - - - 1 -

Release request - - - - - - - - - - - 1 - - - -
Priority
Important object - - - - - - - - - - - - - 1 - -
Safety-related ob‐
ject

- - - - - - - - - - - - 1 - - -

Device management
Loop check - - - - - - - - - - 1 - - - - -
Loop check: On 
previous day

- - - - - - - 1 - - - - - - - -

Write protection - - - - - - - - - 1 - - - - - -
Selected devices - - - - - - - - 1 - - - - - - -
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@AssetInfoExportControl.TypInfo
The table shows the permitted values.

Value Explanation
 Initial value
"<Text filter key=""Type"" Filter=""SI‐
MATIC RACK PC"" />
<TextFilterCombination>AND</Text‐
FilterCombination>
<Text filter key=""HwVersion"" Fil‐
ter=""V3.5"" />"

You can specify any text filter using keywords.
The basic structure is shown in the "Value" column.
The following keywords are available:
● TagFunktion
● TagLocation
● Address
● Descreiption
● Message
● Type
● Manufacturer
● OrderNumber
● SerialNumber
● InstallationDate
● HwVersion
● SwVersion
● HWComment

@AssetInfoExportControl.Start
The table shows the permitted values.

Value Explanation
0 Initial value
1 "Start" command via faceplate

The command is reset after execution of the manually filtered complete export.
2 "Start" command via OPC

The command is reset after execution of the manually filtered complete export.

@AssetInfoExportControl.State
The table shows the permitted values.

Value Explanation
0x0 Initial value
0xFFFF Manually filtered complete export underway
0x01 Manually filtered complete export complete

All information data has been determined.
0x02 Manually filtered complete export complete

The manually filtered complete export has been canceled by the operator.
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Value Explanation
0x03 Manually filtered complete export complete

No information data has been determined.
0x04 Processing complete

No device status corresponded to the filter criteria.
0x05 Processing complete

Cyclically filtered complete exports running in parallel prevented start.

@AssetInfoExportControl.DateStarted
The table shows the permitted values.

Value Explanation
Date&
Time

Start time of the export for the export file

@AssetInfoExportControl.DateFinished
The table shows the permitted values.

Value Explanation
Date&
Time

End time of the export for the export file

6.4.5.2 How to launch the manually filtered complete export (OPC)

Note

The function is available for the Maintenance Station in the MS Standard version.

Note

The filtered manual complete export and remote access via OPC use the same variable 
structure.

This is why they are not independent of each other and can influence each other.

Procedure
1. Write the @AssetInfoExportControl.MSFilter and/or @AssetInfoExportControl.TypeInfo 

variable in accordance with the required filter criteria.

2. Write a value of "2" to the start variable @AssetInfoExportControl.Start.
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Result
An export file with the result is created.

Note

If, at the start of a manually filtered complete export, the system detects that another cyclically 
filtered complete export is already running, the manually filtered complete export to be 
launched is canceled.

Corresponding information is entered in the export file.

6.4.6 Cyclically filtered complete export

6.4.6.1 Calling the "Cyclically filtered complete export" function

Note

This function is available for the Maintenance Station in the MS Standard version.

Note

Avoid parallel access to the manually filtered complete export.

Introduction
The system allows you to export the data of the last complete export cyclically filtered.

You open the faceplate for filtered complete export using the button in the overview screen. 

You can use the cyclically filtered complete export irrespective of the manually filtered complete 
export. 

Three independent cyclically filtered complete exports are available.

Button in the overview screen

Button Function Permissions
Device status filter
● Access filter view
● Filter data

"Process controls" for the diagnostics 
area

Procedure
1. Click the button.

2. In the faceplate, select one of the views for the cyclically filtered complete export.
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Result
The view of the faceplate for the selected cyclically filtered complete export is displayed.

Additional information
For additional information, please refer to the following sections.

The function description in the following sections applies to each of the three cyclically filtered 
complete exports. 

6.4.6.2 Filter settings for the cyclically filtered complete export

Note

The filter settings are available for the Maintenance Station in the MS Standard version.

Introduction
A range of filter criteria are available in the faceplate for the cyclically filtered complete export. 

The cyclically filtered complete export can be started, or an active export operation can be 
canceled. 

When you open the faceplate, you see an overview of the last cyclically filtered complete export 
job executed or active.

If a cyclically filtered complete export job is active, you cannot change any filter settings. You 
can only cancel the cyclically filtered complete export job.
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Overview
The following figure shows an example of the faceplate for the cyclically filtered complete 
export:

Display
● Next start

Date and time of the next cyclically filtered complete export start

Operator control

Display Explanation Operator per‐
mission

The option is selected by clicking on the check box.
● Maintenance status, Maintenance job, Maintenance 

status, Priority and Device management areas
The filter criteria are selected.

● Type information area
Option for negation of the logical operator for type 
information

None

Option for the logical operator for type information None
Part of the identification data, for example the device type 
for which the search text is used

None

Input of search text  

Clicking the button sets all filter criteria. None

Clicking the button resets all filter criteria. None
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Display Explanation Operator per‐
mission

Cyclic execution:
Enter the cycle in hours for repeating the cyclically filtered 
complete export.

 

Start:
Enter the date and time for the first start of the cyclically 
filtered complete export.

None

Clicking the "Log" button opens the result of the last cycli‐
cally filtered complete export from the default export direc‐
tory on the maintenance server.

None

Clicking the button shows the operator panel for starting 
the update.
An active cyclically filtered complete export must be com‐
pleted before you can start a new one.

None

Clicking the button displays the operator panel for cancel‐
ing the active cyclically filtered complete export.

None

Operator panel for updating/canceling 
The following figure shows an example of the operator panel for cycle 1:

● Operator control

Button Explanation Operator per‐
mission

Clicking the button starts the cyclically filtered complete ex‐
port with the selected export and filter settings.

None

Clicking the button cancels the operation. None

6.4.6.3 Cyclically filtered complete export

Note

This function is available for the Maintenance Station in the MS Standard version.

Export file
One export file is created for every cyclically filtered complete export.

The export file is saved to the MS server project.

An additional storage location is specified in the "Other settings" tab under "Advanced 
diagnostic settings".
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The name of the export file is structured as follows: "LogFilteredExportCyclic <n>_YYYY-MM-
DD_HH-MM-SS-SSS.XML" (n=1 to 3). 

The most recent export file is also stored with the following name for display in the faceplate: 
"CurrentFilteredExportCyclic<n>.XML".

The export file contains the following information:

● Overall status of the cyclically filtered complete export

● Start time, end time and duration of execution

● Information on cyclically filtered complete exports with errors or exports that were not 
performed

The storage location contains the three most recent export files. Older export files are deleted 
from the system.

If an export file cannot be deleted due to access conflicts, an error message is generated in 
the process control. The system attempts to delete the export file during the next export.

If an export file cannot be written with the defined name due to access conflicts, an error 
message is generated in the process control. The file name is suffixed with "(<x>)", where x 
is a natural number beginning with "1".

Reaction of the cyclically filtered complete export when the SIMATIC PDM ASSET service is stopped
● The SIMATIC PDM ASSET service is stopped due to archiving

The project states are regularly archived on the engineering station in many plants. 
The SIMATIC PDM ASSET service must be stopped and locked to prevent it restarting for 
the duration of archiving. 
No jobs are accepted during this time. The call to the Maintenance Station is rejected.
In this case, a cyclically filtered complete export that is to be started or is already running 
is paused for the duration of archiving.
The system checks every 10 minutes whether it is possible to resume the cyclically filtered 
complete export. The check is repeated 20x.
Each check is entered in the log with a time specification.
In this phase, the status in the "...State" variable remains 0xFFFF.
If the start is successful, the cyclically filtered complete export continues. 
If the start fails after the maximum number of retries, the cyclically filtered complete export 
is canceled with a message in the message system.

● The SIMATIC PDM ASSET service is not running for other reasons
In this case, the Maintenance Station attempts to start the SIMATIC PDM ASSET service. 
If the start is successful, the cyclically filtered complete export is started or continues.
If the start fails, the cyclically filtered complete export is canceled with a message in the 
message system.
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Calculation of the next start time
Once the cyclically filtered complete export has started, the next start time is calculated 
according to the following rules:

● The start time specified in the "Start" text box of the faceplate is in the future
The specified start time is used as the next start time in the "Next start" display box.

● The start time specified in the "Start" text box of the faceplate is in the past
The specified cycle time is added up for the specified start time until a start time in the future 
is reached.
This start time is applied as the next start time in the "Next start" display box.
If the (entered) start time dates back to more than one year in the past, the next start time 
is automatically scheduled to the next full hour.

Once the next start time is reached, the subsequent start time is recalculated by adding up the 
cycle time and is displayed.

Additional information
For additional information, please refer to the following sections.

6.4.6.4 How to launch the cyclically filtered complete export

Note

This function is available for the Maintenance Station in the MS Standard version.

Requirements
● The faceplate for the filtered complete export is open. 

● The cyclically filtered complete export to be selected is not enabled. 
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Procedure
1. Select the required cycle in the header of the faceplate with the "Cycle" button.

2. Select the filter criteria you require.

– Select the required filter criteria check boxes in the following groups:
- Maintenance status
- Maintenance job
- Priority
- Maintenance status
- Device management
If multiple filter criteria are selected, they are ORed.  
Exception: An exception to this is the "Loop check: On previous day" check box, which 
is only taken into consideration when the "Loop check" check box is selected.

– You can enable all filter criteria with the "Select all" button.
Click "Deselect all" to clear all filter criteria selected.

– In the "Type information" group, you can select an area from the drop-down lists and 
enter the text you are looking for in the input boxes.
You can use the characters "*" and "?" as wildcards.
Link the fields.

3. Enter the cycle in hours in the "Cyclic execution" text box.

4. Enter the date and time for the first start of cyclic processing in the "Start" text box.

5. Click the "Refresh" button.
The view expands to include the operator panel.

6. Click "OK".

Result
The next start time is calculated from the specified start and cycle time.

An operator message is triggered. 

An export file is created after each cycle.

The status display in the header of the faceplate shows the current status.

Note

If, at the start of a cyclically filtered complete export, the system detects that another filtered 
complete export is already running, the cyclically filtered complete export to be launched is 
canceled.

Corresponding information is entered in the export file.
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6.4.6.5 How to cancel the cyclically filtered complete export

Note

This function is available for the Maintenance Station in the MS Standard version.

Requirement
The faceplate for the filtered complete export is open.

Procedure
1. Select the desired active cycle in the header of the faceplate with the "Cycle" button.

2. Click the "Cancel" button.
The view expands to include the operator panel.

3. Click "OK".

Result
The cyclically filtered complete export for the selected cycle is canceled.

An operator message is triggered. 

6.4.7 Overview of system functions

6.4.7.1 System functions
A range of functions are available in a faceplate as global system functions.

The system offers the following system functions:

● Message correction for components with SNMP functionality (Page 133)

● PC station reset (Page 133)

● AS system reset (Page 134)

● Field device reset (Page 135)

● User area reset (Page 136)
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6.4.7.2 Message correction for components with SNMP functionality

Introduction       
The "Message correction" function deletes messages of SNMP-compatible components in the 
configuration data of the Maintenance Station (server data) for which the relationship with the 
project has been deleted, for example, if you have removed PC hardware from the system.

The "Message correction" function is available if your plant is not operated via a 
PCS 7 Web client.   

Button on the user interface

Button Function Permissions
Execute message correction "Authorization for area" and "Process 

controlling" for the diagnostics area

Procedure
1. Click the button.

Result
Relevant messages are deleted.

An operator message is triggered.

6.4.7.3 PC station reset

Introduction

The "PC station reset" function resets the saved error states in the following views:

● "Diagnostics" for PC objects

● "Connection display" for client components

● "Connection display" for server components

All saved error states of the components in the "PC stations" area are reset. 

Button on the user interface

Button Function Permissions
PC station reset "Authorization for area" and "Process 

controlling" for the diagnostics area
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Procedure
1. Click the button.

Result
Error states are reset.

An operator message is triggered.

Additional information
You can find information on the individual views at:

● "Diagnostics" view for PC objects (Page 202)

● "Connection display" view for client components (Page 204)

● "Connection display" view for server components (Page 206)

6.4.7.4 AS system reset

Introduction
The "AS system reset" function resets the saved error states in the following views:

● "Performance" for AS objects

● "OBX..." for AS objects

● "Connection load display" for CPU connections

All saved error states of the components in the "AS system" area are reset. 

Button on the user interface

Button Function Permissions
AS system reset "Authorization for area" and "Process 

controlling" for the diagnostics area

Procedure
1. Click the button.

Result
Error states are reset.

An operator message is triggered.
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Additional information
You can find information on the individual views at:

● "Performance" view for AS objects (Page 211)

● "OBx..." view for AS objects (Page 213)

● "Parameters" view for AS objects (Page 215)

6.4.7.5 Field device reset

Introduction

The "Field device reset" function resets the saved error states in the following view:

● "Diagnostics" for AS objects

All saved error states of the components in the "Field devices" area are reset.

Button on the user interface

Button Function Permissions
Field device reset "Authorization for area" and "Process 

controlling" for the diagnostics area

Procedure
1. Click the button.

Result
Error states are reset.

An operator message is triggered.

Additional information
Information on the view is available at:

● "Diagnostics" view for AS objects (Page 208).
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6.4.7.6 User area reset

Introduction

The "User area reset" function resets the saved error states in the following views:

● "Diagnostics" for user objects

● "Monitoring" for user objects

All saved error states of the components in the "User objects" area are reset.

Button on the user interface

Button Function Permissions
User area reset "Authorization for area" and "Process 

controlling" for the diagnostics area

Procedure
1. Click the button.

Result
Error states are reset.

An operator message is triggered.

Additional information
You can find information on the individual views at:

● "Diagnostics" view for user objects (Page 228)

● "Monitoring" view for user objects (Page 229)

6.4.8 Filtered manual parameter data export

6.4.8.1 Calling the function "Filtered manual parameter data export"

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.
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Note

Avoid parallel access to filtered manual parameter data export.

Introduction
The filtered manual parameter data export enable a manual parameter data export from field 
devices via SIMATIC PDM.

You open the faceplate for parameter data export using the button in the overview screen. The 
view for the filtered manual parameter data export is displayed.

Requirement
SIMATIC PCS 7 MS Standard with utilization of SIMATIC PDM >= V8.2 or SIMATIC PDM MS

Button in the overview screen

Button Function Permissions
Calls the faceplate "Higher process controlling" for diagnos‐

tics area

Procedure
1. Click the button.

Result
The view of the faceplate for the filtered manual parameter data export is opened.

Additional information
For additional information, refer to the following sections:

6.4.8.2 Filter settings for the filtered manual parameter data export

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.

Introduction
The faceplate includes various filter criteria and export settings for exporting parameter data. 

The export can be started, or an active export operation can be canceled. 
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When you open the faceplate, you will see an overview of the last executed or active export 
job.

If an export job is active, you cannot change any filter settings. You can only cancel the export 
job.

Time-controlled synchronization can be enabled or disabled irrespective of the other export 
jobs.

Display
The following figure shows an example of the faceplate for the parameter data export:

● In the Maintenance status, Maintenance job, Priority, Maintenance status and Device 
management areas
Selected filter criteria

● In the Export settings area
Selected type of export

● In the "Export jobs to SIMATIC PDM" area
Result of the last executed export job or current data of the active export job:

– Total
Number of parameter data records to be exported

– Open
Number of parameter data records still to be exported

– Successful
Number of parameter data records already exported

– Not successful
Number of parameter data records that were not exported
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Operator control

Display Explanation Operator per‐
mission

The option is selected by clicking on the check box.
● Maintenance status, Maintenance job, Maintenance status, Priority 

and Device management areas
The filter criteria are selected.

● Export settings area
– Offline - Parameter data (project)

The parameter data is read from the project during the export.
– Online - Parameter data (field device)

The parameter data in the project is updated and then exported.
– Time-controlled synchronization between parameter data in the 

field device and in the project
Time-controlled synchronization is started when the specified time 
is reached.
The parameter data in the project is automatically updated and then 
exported.
The activated filter criteria are ignored during the update.
Time-controlled synchronization is executed for field devices for 
which a change in the configuration was detected.

None

Enter the time in hours of the daily start for time-controlled synchronization.
Use the 24-hour format.

None

Clicking the "Log" button opens the log file of the last filtered manual pa‐
rameter data export from the default export directory on the maintenance 
server.
The log file is in English only.

None

Applies to the following export settings:
● Offline - Parameter data (project)
● Online - Parameter data (field device)
Clicking the button shows the operator panel for starting the update.
Observe the following when exporting online and offline parameter data:
An active export job must be completed before you can start a new export 
job.

None

Applies to the following export settings:
● Offline - Parameter data (project)
● Online - Parameter data (field device)
By clicking the button, the operator panel for canceling the active export 
job is shown.

None
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Operator panel for updating/canceling 
The following figure shows an example of the operator panel:

● Operator control

Button Explanation Operator per‐
mission

Clicking the button starts the export job with the selected 
export and filter settings.

None

Clicking the button cancels the operation. None

● Display
Preview value:
The preview value specifies how many devices match the currently set filter.
While the preview value is being determined or if it could not be determined, for example, 
because the ASSET service is currently unavailable, "***" is displayed as preview value.

6.4.8.3 Filtered manual parameter data export of EDD-based devices

Note

The parameter data export is available for the Maintenance Station in the MS Standard version.

Export of parameter data
Parameter data of devices that are integrated in SIMATIC PDM via EDDs can be exported:

● Export of the "offline parameter data (project)"
The parameter data stored in the project is exported to the specified destination.
The selected filter criteria are taken into consideration for the device selection.

● Export of the "online parameter data (field device)"
The complete parameter data is first read from the devices and saved in the project. This 
parameter data is then exported to the specified destination.
The selected filter criteria are taken into consideration for the device selection.

● Time-controlled synchronization (field device --> project)
A check is made at the specified time as to whether there is a difference in the parameter 
data between the device and project or if a device has independently signaled a 
configuration change. For these devices, all the parameter data is first read from the devices 
and saved in the project.
The parameter data saved in the project is then exported to the specified destination.
The selected filter criteria are not taken into consideration for the device selection.
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The export of parameter data can be controlled by operator input in the faceplate or remotely 
via the OPC interface of the MS.

Note

The filtered manual parameter data export and remote access via OPC to use the same 
variable structure.

This is why they are not independent of one another and can influence one another.

Note

When exporting online parameter data, the device parameter assignment may not be open 
elsewhere. Otherwise, only an export of online parameter data is performed. 

This is relevant for the following export types:
● Export of the "online parameter data (field device)"
● Time-controlled synchronization (field device --> project)
● Online parameter data export for a selected device

Refer to the export file to find out whether online or offline parameter data was exported.

Reaction of the parameter data export when SIMATIC PDM ASSET service is stopped
● SIMATIC PDM ASSET Service is stopped due to archiving

The project states are regularly archived on the engineering station in many plants. 
The SIMATIC PDM ASSET service must be stopped and locked against restarting for the 
duration of archiving. 
No export jobs can be accepted during this time. The call to the Maintenance Station is 
rejected.
In this case, a parameter data export that is to be started or is already running is paused 
for the duration of archiving.
There is a check every 10 minutes to determine whether it is possible to resume the 
parameter data export. The check is repeated 20x.
Each check is entered in the log with a time specification.
In this phase, the status in the "...State" variable remains 0xFFFF.
If the start is successful, the parameter data export continues. 
If the start fails after the maximum retries, the parameter data export is canceled with a 
message in the message system.

● SIMATIC PDM ASSET Service is not running for other reasons
In this case, the Maintenance Station attempts to start the SIMATIC PDM ASSET service. 
If the start is successful, the parameter data export is started or continued.
If the start fails, the parameter data export is canceled with a message in the message 
system.

Export file
The parameter data is stored in an individual export file for each created device. 

The export format and the content of these export files conform to the export format of SIMATIC 
PDM.
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To specify the storage location, select the menu command Options > SIMATIC PDM > 
Settings... in SIMATIC Manager and then go to the "General" tab, "Path for 'Asset export' files".

The name of the export file is structured as follows: "<Devicename>_
$YYYYMMDD_HHMMSS.XML". 

When name conflicts occur during the export, the file name is extended by "_1".

Log file
For each export job, a log file is created in which the successful or unsuccessful export of the 
parameter data of the devices is documented.

The storage location of the log file is specified using the WinCC variable 
@AssetControl.ExportPath. The log file is also saved in the project of the MS server.

The name of the log file has the following structure: "LogPDMExportManually_YYYY-MM-
DD_HH-MM-SS-SSS.XML". 

In addition, the most recent log file is stored with the following name for display in the faceplate: 
"CurrentPDMExportManually.XML".

The log file contains the following information:

● Overall status of the parameter data export

● Start time, end time and duration of the execution

● Information on parameter data exports with errors or that were not performed

The storage location contains the three most recent log files. Older log files are deleted from 
the system.

When a log file cannot be deleted due to access conflicts, an error message is generated in 
the process control. There is an attempt to delete the log file with the next parameter data 
export.

When a log file cannot be written with the defined name due to access conflicts, an error 
message is generated in the process control. The file name is suffixed with "(<x>)", where x 
is a natural number beginning with "1".

Additional information
For additional information, refer to the following sections:

6.4.8.4 How to start the filtered manual parameter data export

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.
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Requirements
● The faceplate for the parameter data export is open. The view for the filtered manual 

parameter data export is displayed.

● The filtered manual cyclic parameter data export is not running at this time.

● The filtered cyclic parameter data export can be active.

● The execution of the filtered cyclic parameter data export is not running at this time.

Procedure
1. Select which parameter data will be exported.

– If you want to export parameter data stored in the project, select the "Offline parameter 
data (project)" check box.

– If you want to export parameter data stored in the field device, select the "Online 
parameter data (field device)" check box.

2. Select the filter criteria you require.
When several check boxes are selected, the filter criteria are linked with "Or".  
Exception: An exception to this is the "Loop check: On previous day" check box, which is 
only taken into consideration when the "Loop check" check box is selected.

3. Click the "Refresh" button.
The view is expanded to include the operator panel.

4. Click "OK".

Result
An export file is created for each individual device.

An operator message is triggered. 

The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

The status display in the header of the faceplate shows the current status.

A log file is created for the export job.

Note

If it is detected at the start of a parameter data export that another parameter data export is 
already running, the parameter data export to be launched is canceled.

Corresponding information is entered in the log file.
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6.4.8.5 How to cancel the filtered manual parameter data export

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.

Requirements
● The faceplate for the parameter data export is open. 

● The view for the filtered manual parameter data export is displayed.

Procedure
1. Click the "Cancel" button.

The view is expanded to include the operator panel.

2. Click "OK".

Result
The parameter data export is canceled.

An operator message is triggered. 

The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

6.4.8.6 How to start time-controlled synchronization

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Requirements
● The faceplate for the parameter data export is open. 

● The view for the filtered manual parameter data export is displayed.

● The "Time-controlled synchronization field device --> project" check box is selected.

Procedure
1. Enter the time of the start.

2. Select the "Time-controlled synchronization field device --> project" check box.
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Result
An operator message is triggered. 

The synchronization is performed at the specified time.

A check is made at the specified time as to whether there is a difference in the parameter data 
between the device and project or if a device has independently signaled a configuration 
change. For these devices, all the parameter data is first read from the devices and saved in 
the project.

The parameter data saved in the project is then exported to the specified destination.

The selected filter criteria are not taken into consideration for the device selection.

The values displayed in the "Export jobs to SIMATIC PDM" area are not updated.

A log file is not created on the Maintenance Station.

6.4.8.7 How to stop time-controlled synchronization

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Requirements
● The faceplate for the parameter data export is open.

● The view for the filtered manual parameter data export is displayed.

Procedure
1. Clear the "Time-controlled synchronization field device --> project" check box.

Result
Time-controlled synchronization was terminated.

An operator message is triggered. 
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6.4.9 Filtered manual parameter data export via OPC access

6.4.9.1 Tags for OPC access

Introduction
The filtered manual parameter data export can also be performed with OPC access.

The information for the parameter data export is stored in a structure variable.

This variable structure can be directly accessed by another computer via the OPC DA interface.

You can find information on establishing an OPC connection in the WinCC Information 
System online help.

Variables for OPC access 
The required information is stored in the following variables:

Name of the variable Data 
type

Syn‐
chroni‐
zation

Ini‐
tial 
value

Explanation Access
via OPC(1)

@AssetControl.ActionType Byte X 0 Required action Read/write
@AssetControl.MSFilter DWord X 0 Filter for the SIMATIC PDM 

devices
Read/write

@AssetControl.Start Byte - 0 "Start" command Read/write
@AssetControl.MSFilterPreview DWord X 0 Filter for devices for preview 

value
Read

@AssetControl.StartPreview Byte - 0 Start identifier for preview val‐
ue

Read/write

@AssetControl.ExportStarted Date&
Time

X 0 Start time of the export Read

@AssetControl.ExportFinished Date&
Time

X 0 End time of the export Read

@AssetControl.CyclicTrigger Byte - 0 Time-controlled synchroniza‐
tion enabled

Read/write

@AssetControl.CyclicTriggerRun Byte X 0 Tracked CyclicTrigger Read/write
@AssetControl.CyclicTriggerStart‐
Time

Byte X 0 Time for the daily start of time-
controlled synchronization

Read/write

@AssetControl.CyclicTriggerStart Byte - 0 Start identifier for time-control‐
led synchronization

Read

@AssetControl.State DWord X 0 Status or group error entry Read
@AssetControl.Cancel Byte X 0 "Cancel" command Read/write
@AssetControl.DeviceCount DWord X 0 Total number of export jobs 

according to the filter criteria
Read

@AssetControl.DeviceCountPreview DWord - 0 Number of devices in accord‐
ance with the filter for preview

Read

@AssetControl.DeviceCountOK DWord X 0 Number of successful export 
jobs

Read
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Name of the variable Data 
type

Syn‐
chroni‐
zation

Ini‐
tial 
value

Explanation Access
via OPC(1)

@AssetControl.DeviceCountFailed DWord X 0 Number of unsuccessful ex‐
port jobs

Read

@AssetControl.TagExportStart Byte - 0 Start for export via tag name 
(one device)

Read/write

@AssetControl.TagExportState DWord X 0 State of tag export Read
@AssetControl.TagExportName 256 

bytes
X " " Tag name of the device to be 

exported
Read/write

@AssetControl.ExportPath 256 
bytes

X " " Path to the export destination 
in SIMATIC PDM

Read/write

(1)The "Access via OPC" column explains how the variables are to be used.

@AssetControl.ActionType
The table shows the permitted values.

Value Explanation
0x01 Export of the offline parameter data (project)
0x02 Export of the online parameter data (field device)

@AssetControl.MSFilter
The following tables show the permitted values for bits 0 to 31.

If multiple bits are set, the statuses are ORed 

Exception: An exception to this is bit 24 "Loop check: On previous day", which is only taken 
into consideration when bit 21 "Loop check" is set. 

Bit 15 14 13 12 11 10
 

9 8 7 6 5 4 3 2 1 0

Maintenance state
Good - - - - - - - - - - - - - - - 1
Passivated - - - - - - - - - - - - - - 1 -
Out of service - - - - - - - - - - - - - 1 - -
Simulation - - - - - - - - - - - - 1 - - -
Local operator con‐
trol

- - - - - - - - - - - 1 - - - -

Maintenance re‐
quired

- - - - - - - - - - 1 - - - - -

Maintenance de‐
manded

- - - - - - - - - 1 - - - - - -

Maintenance alarm - - - - - - - - 1 - - - - - - -
Device status un‐
known

- - - - - - - 1 - - - - - - - -
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Bit 15 14 13 12 11 10
 

9 8 7 6 5 4 3 2 1 0

Configuration 
change

- - - - - - 1 - - - - - - - - -

Maintenance job
Mainten. required 
requested

- - - - - 1 - - - - - - - - - -

Maintenance de‐
mand requested

- - - - 1 - - - - - - - - - - -

Maintenance 
alarm requested

- - - 1 - - - - - - - - - - - -

Maintenance status
Completed - - 1 - - - - - - - - - - - - -
Canceled - 1 - - - - - - - - - - - - - -
In maintenance 1 - - - - - - - - - - - - - - -
...

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
...
Maintenance not 
started

- - - - - - - - - - - - - - - 1

Planned mainte‐
nance

- - - - - - - - - - - - - - 1 -

Release request - - - - - - - - - - - 1 - - - -
Priority
Important object - - - - - - - - - - - - - 1 - -
Safety-related ob‐
ject

- - - - - - - - - - - - 1 - - -

Device management
Loop check - - - - - - - - - - 1 - - - - -
Loop check: On 
previous day

- - - - - - - 1 - - - - - - - -

Write protection - - - - - - - - - 1 - - - - - -
Selected devices - - - - - - - - 1 - - - - - - -

@AssetControl.Start
The table shows the permitted values.

Value Explanation
0 Initial value
1 "Start" command

The command is reset after completion of the offline/online export job (ActionType).
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@AssetControl.MSFilterPreview
The structure of the @AssetControl.MSFilterPreview variable corresponds to that of the 
@AssetControl.MSFilter variable.

@AssetControl.StartPreview
The table shows the permitted values.

Value Explanation
0 Initial value
1 "StartPreview" command

The preview value is determined.

@AssetControl.ExportStarted
The table shows the permitted values.

Value Explanation
Date&
Time

Start time of the export for the log file

@AssetControl.ExportFinished
The table shows the permitted values.

Value Explanation
Date&
Time

End time of the export for the log file

@AssetControl.CyclicTrigger
The table shows the permitted values.

Value Explanation
0 "Time-controlled synchronization field device --> project" not enabled
1 "Time-controlled synchronization field device --> project" enabled

Command for enabling the time-controlled synchronization for field device -> project

@AssetControl.CyclicTriggerRun
The table shows the permitted values.

Value Explanation
0 "Time-controlled synchronization field device --> project" not enabled

Command for disabling the time-controlled synchronization for field device -> project
1 "Time-controlled synchronization field device --> project" enabled
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@AssetControl.CyclicTriggerStartTime
The table shows the permitted values.

Value Explanation
0 to 23 Start time of the time-controlled synchronization

@AssetControl.CyclicTriggerStart
The table shows the permitted values.

Value Explanation
0 Initial value
1 Start of the execution of the devices in the "Configuration change" state

@AssetControl.State
The table shows the permitted values.

Value Explanation
0x0 Initial value
0xFFFF Offline/online export job is running
0x01 Export completed

All offline/online export jobs have been completed.
0x02 Export completed

The offline/online export job was canceled by the operator.
0x03 Export completed

Not all offline/online export jobs have been completed.
0x04 Processing completed

No device status corresponded to the filter criteria.
0x05 Processing completed

Exports running in parallel prevented the start

Refer to the log file for your export job to find out which export jobs were completed successfully 
and which were not completed successfully.

@AssetControl.Cancel
The following table shows the permitted values.

Value Explanation
0 Initial value
1 "Cancel" command
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@AssetControl.DeviceCount
The following table shows the permitted values.

Value Explanation
0 Initial value
0 ... Total number of offline/online export jobs according to filter criteria

@AssetControl.DeviceCountPreview
The following table shows the permitted values.

Value Explanation
0 Initial value
0 ... Total number of offline/online export jobs according to filter criteria for the preview value

@AssetControl.DeviceCountOK
The following table shows the permitted values.

Value Explanation
0 Initial value
0 ... Number of successful offline/online export jobs

@AssetControl.DeviceCountFailed
The following table shows the permitted values.

Value Explanation
0 Initial value
0 ... Number of unsuccessful offline/online export jobs

@AssetControl.TagExportStart
The following table shows the permitted values.

Value Explanation
0x0 Initial value
0x01 "Start online export job" command (field device)

The command is reset after executing the export job (TagExportName).
0x02 "Start offline export job" command (project)

The command is reset after executing the export job (TagExportName).
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@AssetControl.TagExportState
The following table shows the permitted values.

Value Explanation
0x0 Initial value
0xFFFF Export job is running
0x01 Export has ended.

Export job has been completed.
0x03 Export has ended.

Export job has not been completed.
0x04 Processing has ended.

No match found for TagExportName.

@AssetControl.TagExportName
The variable is "empty" in the initial state. 

Specify the tag name of the device to be exported. You can find this name in the Component 
List Editor.

@AssetControl.ExportPath
The variable is "empty" in the initial state. The log file for your export job is only stored in the 
"AssetExport" directory in the OS project of the MS server.

Specify the path for AssetExport files that you have specified in the settings for SIMATIC PDM. 
The log file for your export job is stored in the specified path and in the "AssetExport" directory 
in the OS project of the MS server.

6.4.9.2 How to start the filtered manual parameter data export (OPC)

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.

Note

The filtered manual parameter data export and remote access via OPC to use the same 
variable structure.

This is why they are not independent of one another and can influence one another.
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Procedure
1. Select which parameter data will be exported.

– If you are exporting offline parameter data, write the @AssetControl.ActionType variable 
with the value 0x01.

– If you are exporting online parameter data, write the @AssetControl.ActionType variable 
with the value 0x02.

2. Write the @AssetControl.MSFilter variable according to the desired filter criteria.

3. Write the @AssetControl.ExportPath variable.

4. Set the start variable @AssetControl.Start.

Result
An export file is created for each individual device.

The values of the @AssetControl.DeviceCount, @AssetControl.DeviceCountOK, and 
@AssetControl.DeviceCountFailed variables contain the current execution status.

The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

A log file is created for each export job.

Note

If it is detected at the start of a parameter data export that another parameter data export is 
already running, the parameter data export to be launched is canceled.

Corresponding information is entered in the log file.

6.4.9.3 How to cancel the filtered manual parameter data export (OPC)

Note

The function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS version.

Procedure 
1. Set the @AssetControl.AdditionalTrigger variable.

Result
The parameter data export is canceled.

The @AssetControl.Start variable is automatically set to "0".

Operator control and monitoring
6.4 Functions in the overview screen

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 153



The values of the @AssetControl.DeviceCount, @AssetControl.DeviceCountOK, and 
@AssetControl.DeviceCountFailed variables are updated.

Note

It is not necessary to end the offline/online parameter data export.

The @AssetControl.Start variable is automatically set to "0" after completion of the export job.

6.4.9.4 How to start time-controlled synchronization (OPC)

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Requirement 
Time-controlled synchronization is disabled.

Procedure
1. Enter the time of the start in the @AssetControl.CyclicTriggerStartTime variable.

2. Set the @AssetControl.CyclicTrigger variable to "1".

Note

When the value of the @AssetControl.CyclicTrigger variable changes from "0" to "1", a 
modified start time takes effect.

Result
The synchronization is performed at the specified time. 

A check is made at the specified time as to whether there is a difference in the parameter data 
between the device and project or if a device has independently signaled a configuration 
change. For these devices, all the parameter data is first read from the devices and saved in 
the project.

The parameter data saved in the project is then exported to the specified destination. 

The selected filter criteria are not taken into consideration for the device selection.

Time-controlled synchronization has no effect on the variables @AssetControl.DeviceCount, 
@AssetControl.DeviceCountOK or @AssetControl.DeviceCountFailed. 

A log file is not created on the Maintenance Station.
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6.4.9.5 How to stop time-controlled synchronization (OPC)

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Procedure 
1. Set the @AssetControl.CyclicTriggerRun variable to "0".

Result
Time-controlled synchronization was terminated.

6.4.9.6 How to start the parameter data export for a selected device (OPC)

Procedure
1. Write the @AssetControl.TagExportName variable with the variable name of the device to 

be exported.

2. Write the @AssetControl.ExportPath variable.

3. Select which parameter data will be exported.

– If you are exporting online parameter data, write the @AssetControl.ActionType variable 
with the value 0x01.

– If you are exporting offline parameter data, write the @AssetControl.ActionType variable 
with the value 0x02.

Result
An export file is created for the device to be exported.

If the online parameter data export cannot be executed, the offline parameter data are 
automatically exported.

The export via variable name has no effects on the @AssetControl.DeviceCount, 
@AssetControl.DeviceCountOK and @AssetControl.DeviceCountFailed variables.

The values of the @AssetControl.DeviceCount, @AssetControl.DeviceCountOK, and 
@AssetControl.DeviceCountFailed variables contain the current execution status.

A log file is not created.
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The @AssetControl.Start variable is automatically set to "0x0" after completion of the export 
job.

Note

It is not possible to end or cancel the offline/online parameter data export.

6.4.10 Filtered cyclic parameter data export

6.4.10.1 Calling the function "Filtered cyclic parameter data export"

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Note

Avoid parallel access to filtered manual parameter data export.

Introduction
The filtered cyclic parameter data export enables cyclic parameter data export from field 
devices via SIMATIC PDM.

You open the faceplate for parameter data export using the button in the overview screen. 

You can use the filtered cyclic parameter data export independent of the filtered manual 
parameter data export. 

Three independent filtered cyclic parameter data exports are available.

Requirement
Using SIMATIC PDM

Button in the overview screen

Button Function Permissions
Calls the faceplate "Higher process controlling" for diagnos‐

tics area
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Procedure
1. Click the button.

2. In the faceplate, select one of the views for the filtered cyclic parameter data export.

Result
The view of the faceplate for the selected filtered cyclic parameter data export is displayed.

Additional information
For additional information, refer to the following sections:

The function description in the following sections applies to each of the three filtered cyclic 
parameter data exports. 

6.4.10.2 Filter settings for the filtered cyclic parameter data export

Note

The filter settings are available for the Maintenance Station in the MS Standard and SIMATIC 
PDM MS versions.

Introduction
The faceplate includes various filter criteria and export settings for exporting parameter data. 

The export can be started, or an active export operation can be canceled. 

When you open the faceplate, you will see an overview of the last executed or active export 
job.

If an export job is active, you cannot change any filter settings. You can only cancel the export 
job.
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Display
The following figure shows an example of the faceplate for the cyclic parameter data export.

● In the Maintenance status, Maintenance job, Priority, Maintenance status and Device 
management areas
Selected filter criteria

● In the Export settings area
Selected type of export

● In the "Export jobs to SIMATIC PDM" area
Result of the last executed export job or current data of the active export job:

– Total
Number of parameter data records to be exported

– Open
Number of parameter data records still to be exported

– Successful
Number of parameter data records already exported

– Not successful
Number of parameter data records that were not exported

● Cyclic execution
Selected cycle in hours

● Start
Date and time of the first cyclic start

● Next start
Date and time of the next cyclic start
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Operator control

Display Explanation Operator 
permission

The option is selected by clicking on the check box.
● Maintenance status, Maintenance job, Maintenance status, 

Priority and Device management areas 
The filter criteria are selected.

● Export settings area
– Offline - Parameter data (project)

The parameter data is read from the project during the 
export.

– Online - Parameter data (field device)
The parameter data in the project is updated and then 
exported.

None

Cyclic execution:
Here, you enter the cycle in hours for repeating the export.

 

Start:
Here, you enter the date and time for the first start of the cyclic 
execution.

None

Clicking the "Log" button opens the log file of the last filtered cyclic 
export from the default export directory on the maintenance server.
The log file is in English only.

None

Clicking the button shows the operator panel for starting the update.
Note that an active export job must be completed before you can 
start a new export job.

None

Clicking the button displays the operator panel for canceling the 
active export job.

None

Operator panel for updating/canceling 
The following figure shows an example of the operator panel for cycle 3:

● Operator control

Button Explanation Operator per‐
mission

Clicking the button starts the export job with the selected 
export and filter settings.

None

Clicking the button cancels the export job with the selected 
export and filter settings.

None

● Display
Preview value:
Specifies how many devices match the currently set filter
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6.4.10.3 Filtered cyclic parameter data export of EDD-based devices

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Export of parameter data
Parameter data of devices that are integrated in SIMATIC PDM via EDDs can be exported:

● Export of the "offline parameter data (project)"
The parameter data stored in the project is exported to the specified destination.
The selected filter criteria are taken into consideration for the device selection.

● Export of the "online parameter data (field device)"
The complete parameter data is first read from the devices and saved in the project. This 
parameter data is then exported to the specified destination.
The selected filter criteria are taken into consideration for the device selection.

Note

When exporting the "Online parameter data (field device)", the device parameter assignment 
may not be open elsewhere. Otherwise, only an export of offline parameter data is performed. 

Refer to the export file to find out whether online or offline parameter data was exported.

Calculation of the next start time
After starting the filtered cyclic parameter data export, the next start time is calculated 
according to the following rules:

● The start time specified in the "Start" text box of the faceplate is in the future
The specified start time is used as the next start time in the "Next start" display box.

● The start time specified in the "Start" text box of the faceplate is in the past
The specified cycle time is added up for the specified start time until a start time in the future 
is reached.
This start time is applied as the next start time in the "Next start" display box.
If the (entered) start time dates back to more than one year in the past, the next start time 
is automatically scheduled to the next full hour.

After reaching the next start time, the start time that follows is recalculated and displayed by 
adding up the cycle time.

Export file
The parameter data is stored in an individual export file for each created device. 

The export format and the content of these export files conform to the export format of SIMATIC 
PDM.
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To specify the storage location, select the menu command Options > SIMATIC PDM > 
Settings... in SIMATIC Manager and then go to the "General" tab, "Path for 'Asset export' files". 

Depending on the selected cycle, an additional "Cycle<n>" subdirectory is automatically 
created as the storage location, where <n> represents the number of the selected cycle.

The name of the export file is formed as follows: "<Device name>_
$YYYYMMDD_HHMMSS.XML". 

When name conflicts occur during the export, the file name is extended by "_1".

Log file
For each export job, a log file is created in which the successful or unsuccessful export of the 
parameter data of the devices is documented.

The storage location of the log file is specified using the WinCC variable 
@AssetControlCyclic.ExportPath. The log file is also saved in the project of the MS server.

Depending on the selected cycle, an additional "Cycle<n>" subdirectory is automatically 
created as the storage location, where <n> represents the number of the selected cycle.

The name of the log file has the following structure: "LogPDMExportCyclic<n>_YYYY-MM-
DD_HH-MM-SS-SSS.XML". 

In addition, the most recent log file is stored with the following name for display in the faceplate: 
"CurrentPDMExportCyclic<n>.XML".

The log file contains the following information:

● Overall status of the parameter data export

● Start time, end time and duration of the execution

● Information on parameter data exports with errors or that were not performed

The storage location contains the three most recent log files. Older log files are deleted from 
the system.

When a log file cannot be deleted due to access conflicts, an error message is generated in 
the process control. 

When a log file cannot be written with the defined name due to access conflicts, an error 
message is generated in the process control. The file name is suffixed with "(<x>)", where x 
is a natural number beginning with "1".

Additional information
For additional information, refer to the following sections:

6.4.10.4 How to start filtered cyclic parameter data export

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Operator control and monitoring
6.4 Functions in the overview screen

Maintenance Station
Function Manual, 05/2017, A5E41291135-AA 161



Requirements
● The faceplate for the parameter data export is open. 

● The filtered cyclic parameter data export to be selected is not enabled. 

Procedure
1. Select the desired cycle in the header of the faceplate with the "Cycle" button.

2. Select which parameter data will be exported.

– If you want to export parameter data stored in the project, select the "Offline parameter 
data (project)" check box.

– If you want to export parameter data stored in the field device, select the "Online 
parameter data (field device)" check box.

3. Select the filter criteria you require.
When several check boxes are selected, the filter criteria are linked with "Or".  
Exception: An exception to this is the "Loop check: On previous day" check box, which is 
only taken into consideration when the "Loop check" check box is selected.

4. Enter the cycle in hours in the "Cyclic execution" text box.

5. Enter the date and time for the first start of cyclic processing in the "Start" text box.

6. Click the "Refresh" button.
The view is expanded to include the operator panel.

7. Click "OK".

Result
The next start time is calculated from the specified start and cycle time.

An operator message is triggered. 

An export file is created for each individual device.

If the filtered cyclic parameter data export is running, the display values are updated in the 
"Export jobs to SIMATIC PDM" area.

The status display in the header of the faceplate shows the current status.

If the filtered cyclic parameter data export is running, a log file is created.

Note

If it is detected at the start of a parameter data export that another parameter data export is 
already running, the parameter data export to be launched is canceled.

Corresponding information is entered in the log file.
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6.4.10.5 How to cancel the filtered cyclic parameter data export

Note

This function is available for the Maintenance Station in the MS Standard and SIMATIC PDM 
MS versions.

Requirement
The faceplate for the parameter data export is open.

Procedure
1. Select the desired active cycle in the header of the faceplate with the "Cycle" button.

2. Click the "Cancel" button.
The view is expanded to include the operator panel.

3. Click "OK".

Result
The parameter data export for the selected cycle is canceled.

An operator message is triggered. 

The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

6.5 Area overview screens

Possible area overview screens
The following area overview screens can be subordinate to the overview screen of the 
diagnostics area:

● PC stations

– IPC stations created as PC stations in the SIMATIC Manager and to which the profile 
IPC_V** or MIB-II_V1.0 is assigned in the SNMP configuration of the OPC server are 
shown here

– PC stations created as PC stations in the SIMATIC Manager

– No subordinate structures

● Network objects

– All network objects created in the OPC/SNMP server configuration

– All PCs that are configured in the SNMP configuration of the OPC server but have not 
been created as PC stations in the SIMATIC Manager

– No subordinate structures
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● AS/system

– Hierarchically structured display of all configured objects of the automation system level, 
including the interface modules (IMs) of the ET 200 families (ET 200M, ET 200S, ET 
200 SP, ET 200iSP, ET 200pro) and the link modules (DP/PA-Link, DP/FF-Link, Y-Link)

● Field devices

– Hierarchically structured display of all configured field devices and remote I/O stations

● User objects

– User-created hierarchically structured representation of user objects

The selected area overview screen is displayed in the working area. The individual components 
are displayed as block icons in the area overview screen.

Note

The "Field devices" area is only created if you use the PCS 7 Basic Library >=V8.1 in the AS.

If you use the PCS 7 Basic Library <=V8.1 in the AS, all field devices are assigned to the "AS 
system" area.

Calling an area overview screen
You call the area screen as follows:

● Maintenance group display

● Hierarchy buttons in the button set

Function in area overview screen
The diagnostic screens of individual components from the area are called via the block icons 
in the area overview screen.

6.6 Representation of the components

Introduction   
The components to be monitored are displayed in the diagnostics screens as block icons in 
the process control.

To get more information about a component, you can call the corresponding faceplate with a 
mouse click.

Block icon       
The block icons supported by the system which can be displayed in the diagnostic screens 
are contained in the file "@@maintenancetypicals.pdl". 

The file is located in the project directory under " ... \wincproj\<os-name>\GraCS".

Operator control and monitoring
6.6 Representation of the components

Maintenance Station
164 Function Manual, 05/2017, A5E41291135-AA



You can find a description of block icons in the section "Block icon (Page 165)" and in the 
section "Block icon for redundant components (Page 168)".

Faceplate   
Faceplates display all information on a component with diagnostics capability in process mode. 
This includes information that can be obtained by the component itself or from the project data. 
When information is unavailable, the corresponding field is empty.

The faceplate is made up of the title of the screen window, the header and the different views. 
You can change the view.

The number of views in the faceplates depends on the type of component. The three views 
"Ident", "Messages" and "Maintenance" are always available for selection in the faceplates. 
Intelligent components, e.g., components described by an EDD (Electronic Device Description) 
and integrated in SIMATIC PDM, have additional views depending on the component.

Note

The faceplate is displayed if the maintenance station MS Standard or SIMATIC PDM MS 
version is being used.

You can find additional information about this in the section "Faceplate display (Page 178)" 
and in the section "Display of faceplate for redundant components (Page 235)".

6.7 Block icon

Block icon display   
The following figure shows an example of a block icon for a compact device:
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Elements and functions in the block icon
The following elements are displayed in the block icon:

● Label of the block icon

– The following figure shows an example of a label:

The label matches the local ID (LID) from the identification data of the device.
You can find information about the LID in the section "Origin of the identification data 
(Page 236)".

– The following figure shows an example of the label of a device classified as important:

The setting is made in the SIMATIC PDM object properties of the device.

– The following figure shows an example of the label of a device in a safety-related 
application:

The setting is made in the SIMATIC PDM object properties of the device.

● Bitmap
The figure below shows an ET200:

A bit map displaying the device icon is entered automatically in the "DeviceIcon" property, 
provided the bit map is available in HW Config.

● Maintenance group display of the custom component
The following figure shows the maintenance group display as AS process control fault.

You open the associated faceplate with the maintenance group display.
The following states are displayed depending on the maintenance state of the component.
You can find information on the display in the section "Maintenance status and maintenance 
group display (Page 169)".

● Maintenance state of the custom component
The following figure shows the diagnostic icon with the maintenance state "Maintenance 
alarm".

You can use the diagnostic icon to open the associated faceplate.
You can find information about the display in the section "Maintenance status and 
maintenance group display (Page 169)".
The redundancy state is displayed for redundant components.
You can find information on this in the section "Maintenance status of redundant 
components (Page 173)".
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● Active memo
The following figure shows the display if a note is active.

You can find information on this in the section ""Note" view (Page 200)".

● Maintenance group display of the lower-level hierarchy
The following figure shows the display of the maintenance group display as AS process 
control fault.

Various statuses are displayed in the maintenance group display, depending on the 
maintenance group displays of the components of the lower-level hierarchy.
You can find information on this in the section "Maintenance status and maintenance group 
display (Page 169)".
If you click on the maintenance group display in the process control, the lower-level process 
picture in the hierarchy is displayed.

Display of input/output modules
The following figure shows a section from a block icon for an I/O module:

The signal state of the individual channels is shown as follows:

Display Explanation
No display Channel not interconnected/deactivated

No diagnostics can be acquired for the channel

"Good" channel state

"Bad" channel state

Display of channel and module information: 
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If you hover the mouse over a channel in the process control, the symbolic name from the 
symbol table is shown as a tooltip. Requirement: Use of the PCS 7 Basis Library >=V9.0.

If you hover the mouse over the module in the process control, the module comment from the 
hardware configuration is shown as a tooltip.

6.8 Block icon for redundant components

Introduction
Information for a redundant component is displayed in different ways:

● In one block icon

● In several block icons

You can use the block icon to open the associated faceplate.

Block icons
The following table shows the possible types of display:

Redundant 
component

Display Explanation

IM 153-2 The redundancy state is displayed for the component and 
its partner in a diagnostic icon.

I/O
module

The maintenance state of each component is indicated in 
the assigned diagnostic icon (top diagnostic icon).
A redundancy object is also displayed for the component 
with the lower address.
The redundancy state is displayed in the diagnostic icon 
of the redundancy object.
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Redundant 
component

Display Explanation

PC objects The role of master is indicated by an orange square.

The maintenance state of its partner is indicated in the 
diagnostic icon.

The redundancy state is indicated in the diagnostic icon 
in the redundancy object.

Additional information 
You can find additional information in the sections "Block icon (Page 165)" and "Maintenance 
status of redundant components (Page 173)".

6.9 Maintenance status and maintenance group display

Introduction       
The diagnostic icon represents the maintenance state of the component.

The maintenance group display represents the message state of the component and the lower-
level components.

Note

If the maintenance state is "Unchecked/unknown" in the faceplate, all other dynamic displays 
are irrelevant.
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Correlation maintenance state and maintenance group display
The following table provides an overview:

Maintenance state Maintenance group display
Display Remark Val‐

ue
Prior‐
ity

Display Message class/status Message state

Unknown/untes‐
ted

8 1 No message is pending -

Maintenance 
alarm

7 2 AS process control fault "S" display
● Flashing

Message not 
acknowledged

● Not flashing
Message 
acknowledged

Maintenance de‐
manded

6 3 AS process control error "F" display
● Flashing

Message not 
acknowledged

● Not flashing
Message 
acknowledged

Maintenance re‐
quired

5 4 Preventive maintenance "M" display
● Flashing

Message not 
acknowledged

● Not flashing
Message 
acknowledged

Local operator 
control

4 5 Status AS ● No display in the 
group display

● Message does not 
require 
acknowledgement 
and does not have the 
state "outgoing"

● Message is only 
entered in the history 
list

At least one proc‐
ess value is being 
simulated

3 6

Out of service 2 7 AS process control fault "S" display
● Flashing

Incoming message
● Static

Message 
acknowledged
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Maintenance state Maintenance group display
Display Remark Val‐

ue
Prior‐
ity

Display Message class/status Message state

Device passiva‐
ted

1 8 Status AS ● No display in the 
group display

● Message does not 
require 
acknowledgement 
and does not have the 
state "outgoing"

● Message is only 
entered in the history 
list

Configuration 
change detected

9 9

Good 0 10 No message -

Applies to all displays Message is locked "X" display
At least one message is 
locked;
applies only to objects 
from the areas AS, user 
and field devices

The number in the priority column indicates the priority of the display. The lowest number has 
the highest priority.

Note that unacknowledged messages have a higher priority than acknowledged messages.

Correlation maintenance state and maintenance job
The following table provides an overview:

Meaning Maintenance job Maintenance job state
Maintenance required has been requested, 
maintenance engineer has not yet created a mainte‐
nance job
Maintenance demanded has been requested, 
maintenance engineer has not yet created a mainte‐
nance job
Maintenance alarm has been requested, 
maintenance engineer has not yet created a mainte‐
nance job
Maintenance required requested,
The maintenance job was changed to the "Planned 
maintenance" state
Maintenance demanded requested,
The maintenance job was changed to the "Planned 
maintenance" state
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Meaning Maintenance job Maintenance job state
Maintenance alarm requested,
The maintenance job was changed to the "Planned 
maintenance" state
Maintenance required requested,
maintenance job was changed to the "Release request" 
state
Maintenance demanded requested,
maintenance job was changed to the "Release request" 
state
Maintenance alarm requested,
maintenance job was changed to the "Release request" 
state
Maintenance required requested,
maintenance job was set to the "In maintenance" state
Maintenance demanded requested,
maintenance job was set to the "In maintenance" state
Maintenance alarm requested,
Maintenance job was set to the "In maintenance" state
Maintenance job canceled
Maintenance engineer has canceled the maintenance 
job

Maintenance sta‐
tus, see table above

Maintenance job completed Maintenance sta‐
tus, see table above

Structure of the variable for the maintenance status
The value of the variable *.MS or *.MaintenanceState represents the maintenance state.

The variable is a DWORD type.

The table shows the basic structure of the variable.

Bit Explanation
0 to 7 Display of the maintenance state
8 to 15 Display of the maintenance state of the redundant partner
16 "1"= Redundant partner available
17 "0" = Primary partner is master

"1" = Redundant partner is master
18 SIMATIC PDM maintenance state worse than device status
19 to 20 Coding of cycle time for the cyclic update

Bit 19=0, Bit 20=0: 1 day
Bit 19=1, Bit 20=0: 12 hours
Bit 19=0, Bit 20=1: 1 hour
Bit 19=1, Bit 20=1: 10 minutes

21 "1" = Device is selected as "Selection for exports" in the maintenance view
22 SIMATIC PDM has detected a state change
23 Block takes part in the cyclical updating of SIMATIC PDM
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Bit Explanation
24 to 27 OS operation
28 to 31 SIMATIC PDM maintenance state

6.10 Maintenance status of redundant components

Introduction
In the faceplate header and in the block icon, the maintenance status of both components is 
displayed in one diagnostic icon for the redundant pair.

The maintenance status for this diagnostic icon is formed from the maintenance states of both 
components.

Forming the maintenance status with redundant components 
The table below lists the maintenance states that are formed because of this rule.   

Maintenance status 
Redundant component Component A Component B

Good Good Good

Good Unknown/untested Good

Good Component passivated Good

Maintenance demanded Out of service Good

Good At least one process value is 
being simulated

Good

Local operation Local operation Good

Maintenance required Maintenance required Good

Maintenance demanded Maintenance demanded Good

Maintenance demanded Maintenance alarm Good

Configuration change Configuration change Good

Good Good Component passivated

Component passivated Unknown/untested Component passivated

Component passivated Component passivated Component passivated
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Maintenance status 
Redundant component Component A Component B

Out of service Out of service Component passivated

At least one process value is being simulated At least one process value is 
being simulated

Component passivated

Local operation Local operation Component passivated

Maintenance required Maintenance required Component passivated

Maintenance demanded Maintenance demanded Component passivated

Maintenance alarm Maintenance alarm Component passivated

Component passivated Configuration change Component passivated

Maintenance demanded Good Out of service

Out of service Unknown/untested Out of service

Out of service Component passivated Out of service

Out of service Out of service Out of service

At least one process value is being simulated At least one process value is 
being simulated

Out of service

Local operation Local operation Out of service

Maintenance required Maintenance required Out of service

Maintenance demanded Maintenance demanded Out of service

Maintenance alarm Maintenance alarm Out of service

Out of service Configuration change Out of service

Good Good At least one process value is 
being simulated.

At least one process value is being simulated Unknown/untested At least one process value is 
being simulated.

At least one process value is being simulated Component passivated At least one process value is 
being simulated.

At least one process value is being simulated Out of service At least one process value is 
being simulated.

At least one process value is being simulated At least one process value is 
being simulated

At least one process value is 
being simulated.

Local operation Local operation At least one process value is 
being simulated.
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Maintenance status 
Redundant component Component A Component B

Maintenance required Maintenance required At least one process value is 
being simulated.

Maintenance demanded Maintenance demanded At least one process value is 
being simulated.

Maintenance alarm Maintenance alarm At least one process value is 
being simulated.

At least one process value is being simulated. Configuration change At least one process value is 
being simulated.

Local operation Good Local operation

Local operation Unknown/untested Local operation

Local operation Component passivated Local operation

Local operation Out of service Local operation

Local operation At least one process value is 
being simulated

Local operation

Local operation Local operation Local operation

Maintenance required Maintenance required Local operation

Maintenance demanded Maintenance demanded Local operation

Maintenance alarm Maintenance alarm Local operation

Local operation Configuration change Local operation

Maintenance required Good Maintenance required

Maintenance required Unknown/untested Maintenance required

Maintenance required Component passivated Maintenance required

Maintenance required Out of service Maintenance required

Maintenance required At least one process value is 
being simulated

Maintenance required

Maintenance required Local operation Maintenance required

Maintenance required Maintenance required Maintenance required

Maintenance demanded Maintenance demanded Maintenance required

Maintenance alarm Maintenance alarm Maintenance required
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Maintenance status 
Redundant component Component A Component B

Maintenance required Configuration change Maintenance required

Maintenance demanded Good Maintenance demanded

Maintenance demanded Unknown/untested Maintenance demanded

Maintenance demanded Component passivated Maintenance demanded

Maintenance demanded Out of service Maintenance demanded

Maintenance demanded At least one process value is 
being simulated

Maintenance demanded

Maintenance demanded Local operation Maintenance demanded

Maintenance demanded Maintenance required Maintenance demanded

Maintenance demanded Maintenance demanded Maintenance demanded

Maintenance alarm Maintenance alarm Maintenance demanded

Maintenance demanded Configuration change Maintenance demanded

Maintenance demanded Good Maintenance alarm

Maintenance alarm Unknown/untested Maintenance alarm

Maintenance alarm Component passivated Maintenance alarm

Maintenance alarm Out of service Maintenance alarm

Maintenance alarm At least one process value is 
being simulated

Maintenance alarm

Maintenance alarm Local operation Maintenance alarm

Maintenance alarm Maintenance required Maintenance alarm

Maintenance alarm Maintenance demanded Maintenance alarm

Maintenance alarm Maintenance alarm Maintenance alarm

Maintenance alarm Configuration change Maintenance alarm

Good Good Unknown/untested

Unknown/untested Unknown/untested Unknown/untested
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Maintenance status 
Redundant component Component A Component B

Component passivated Component passivated Unknown/untested

Out of service Out of service Unknown/untested

At least one process value is being simulated At least one process value is 
being simulated

Unknown/untested

Local operation Local operation Unknown/untested

Maintenance required Maintenance required Unknown/untested

Maintenance demanded Maintenance demanded Unknown/untested

Maintenance alarm Maintenance alarm Unknown/untested

Unknown/untested Configuration change Unknown/untested

Configuration change Good Configuration change

Unknown/untested Unknown/untested Configuration change

Component passivated Component passivated Configuration change

Out of service Out of service Configuration change

At least one process value is being simulated At least one process value is 
being simulated

Configuration change

Local operation Local operation Configuration change

Maintenance required Maintenance required Configuration change

Maintenance demanded Maintenance demanded Configuration change

Maintenance alarm Maintenance alarm Configuration change

Configuration change Configuration change Configuration change
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6.11 Faceplate

6.11.1 Faceplate display

Introduction   
Starting from a block icon in a diagnostics screen, the maintenance engineer can open the 
corresponding faceplate while the process is in operation; this faceplate provides him with 
access to more detailed information and facilitates operator control of the block. 

Displaying the faceplate view "Ident"
The figure below shows an example of a faceplate:

You can find information about this in the following sections.
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6.11.2 Screen window title and header

6.11.2.1 Displays and operator controls

Introduction       
The control bar always has the same structure. The appropriate displays and buttons are 
shown based on the component type and configuration.

Note

These display elements and operator controls are available for the Maintenance Station in the 
MS Standard and SIMATIC PDM MS versions.

The following figure shows an example of the display: 

Display
The following table provides an overview:

Posi‐
tion

Display Name Display for components from 
the area

Function/remark

(1) Screen window 
title

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Display of the local ID
You can find additional information about the lo‐
cal ID in the section "Origin of the identification 
data (Page 236)".

(2) Block comment ● AS/system
● Field devices
● User objects

Display of the block comment
The local ID is displayed in the tooltip.

(3) Maintenance 
group display 
(custom compo‐
nent)

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Displayed if a message relating to the compo‐
nent is pending
You can find additional information about the 
maintenance group display in the section "Main‐
tenance status and maintenance group display 
(Page 169)".
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Posi‐
tion

Display Name Display for components from 
the area

Function/remark

(4) Maintenance 
status / mainte‐
nance job (cus‐
tom compo‐
nent)

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Current maintenance status/maintenance job is 
displayed
You can find more information on this in the sec‐
tions "Maintenance status and maintenance 
group display (Page 169)" and "Maintenance 
status of redundant components (Page 173)".

(5) Maintenance 
job state

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Current state of the maintenance job
For additional information about the state of the 
maintenance job, see the section "Maintenance 
status and maintenance group display 
(Page 169)".

(6) Flutter suppres‐
sion

● AS/System: Input/output 
modules

● Field devices

Displayed when flutter suppression is activated

(7) Archive syn‐
chronization in‐
complete

● PC stations:
Redundant OS servers

Displayed until the archive synchronization is 
complete

(8) Lock messag‐
es, unlock mes‐
sages

● AS/system
● Field devices
● User objects

Locks or unlocks all messages for the block
You can find additional information about this in 
the section "How to lock and unlock messages 
(Page 186)".

(9) Acknowledge 
messages

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Acknowledges a message for the block

(10) Depassivation ● Field devices:
Redundant I/O modules

Displayed if a module or a channel is passivated
You can find additional information about this in 
the section "How to depassivate modules or 
channels (Page 188)".

(13) Link object 1 to 
link object 3

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls a Web page
Displayed if the call for a Web page is configured
You can find more information on this in the sec‐
tions "Configuring maintenance links (Page 65)" 
and "How to open websites via maintenance 
links (Page 188)".

(14) Diagnostics 
monitor

● PC stations:
SIEMENS IPCs

Calls the Diagnostics monitor diagnostics tool
You can find additional information about this in 
the section "How to call the Diagnostics Monitor 
diagnostic tool (Page 192)".

(15) Call hardware 
project

● AS/system
● Field devices

Calls HW Config
You can find additional information about this in 
the section "How to open the online view of HW 
Config (Page 189)".
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Posi‐
tion

Display Name Display for components from 
the area

Function/remark

(15) Call SIMATIC 
PDM

● Field devices
● User objects

Calls the configuration interface for the config‐
ured component
You can find additional information about this in 
the section "How to open the configuration inter‐
face of SIMATIC PDM (Page 190)".

(15) Call configura‐
tion data

● Network objects Calls the SCALANCE Web server
You can find additional information about this in 
the section "How to call up the Web interface of 
a network component (Page 191)".

(17) Active memo ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Displayed when a message is activated
You can find additional information about this in 
the section ""Note" view (Page 200)". 

(18) View
"Ident" 

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.

(18) View
"Message" 

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.

(18) View
"Performance"

● AS/System:
CPU

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Memo"
● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.

(18) View
"Diagnostics" 

● Field devices:
SIMATIC PDM devices, 
Switch and drive,
Compact field unit (CFU)

● PC stations:
SIEMENS IPC

● AS/System:
Devices with SIMATIC 
PDM configuration 

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
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Posi‐
tion

Display Name Display for components from 
the area

Function/remark

(18) View
"External diag‐
nostics"

● Field devices Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Maintenance"
● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.

(18) View
"LED display"

● AS/System:
CPU

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Diagnostics 
buffer"

● AS/System:
CPU or CP in the central 
rack and expansion rack

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Connections"
● PC stations:

MS client, OS/MS client 
and OS client

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Client connec‐
tions"

● PC stations:
MS server, OS server

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Connection 
load display" for 
CPU connec‐
tions

● AS/System:
CPU

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"Monitoring"
● User objects Calls the corresponding view

● When you left-click, the view appears in the 
same window

● When you right-click, the view opens in a 
new window.
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Posi‐
tion

Display Name Display for components from 
the area

Function/remark

(18) View
"Parameter"

● AS/System:
CPU

● Field devices:
SIMATIC PDM devices

Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) "OB3x" view ● AS/System:

CPU
Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) View

"OB8xOB1"
● AS/system,

applies to CPU
Calls the corresponding view
● When you left-click, the view appears in the 

same window
● When you right-click, the view opens in a 

new window.
(18) Calling addition‐

al views
● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls additional view selection keys
Can only be operated if additional views can be 
called

(19) Return ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the process picture
After a picture change, you see the process pic‐
ture in which the faceplate was called and pin‐
ned.

(20) Pin faceplate ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Pins the faceplate on the user interface
This allows you to change to another picture or 
area without closing the faceplate.

Additional information
You can find additional information in the section "Display elements and operator controls for 
the parameter data export".
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6.11.2.2 Display elements and operator controls for the parameter data export and the filtered 
complete export

Introduction 

Note

These display elements and operator controls are available for the Maintenance Station in the 
MS Standard and SIMATIC PDM MS versions.

The following figure shows an example of the display elements and operator controls:
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Display

Po‐
si‐
tion

Display Name Function/remark

(3)
 

● Status of the filtered 
manual or filtered cyclic 
parameter data export 

● Status of the manual 
filtered or cyclically filtered 
complete export 

The possible status displays can be found in the table 
below.
You can find additional information on the filtered pa‐
rameter data export in the following sections:
● Filtered manual parameter data export 

(Page 136)
● Filtered manual parameter data export via OPC 

access (Page 146)
You can find additional information on the filtered 
complete export in the following sections:
● Manually filtered complete export (Page 115)
● Manually filtered complete export via OPC 

(Page 121)
(4) ● Status of the first filtered 

cyclic parameter data 
export

● Status of the first cyclically 
filtered complete export

You can find additional information on the filtered pa‐
rameter data export in the following sections:
● Filtered cyclic parameter data export (Page 156)
● Cyclically filtered complete export (Page 125)

(5) ● Status of the second 
filtered cyclic parameter 
data export

● Status of the first cyclically 
filtered complete export

(6) ● Status of the second 
filtered cyclic parameter 
data export

● Status of the second 
cyclically filtered complete 
export

(18) "Manual parameter data ex‐
port" view 

You can find additional information in the following 
sections: 
● Filtered manual parameter data export 

(Page 136)
● Filtered manual parameter data export via OPC 

access (Page 146)
(18) "Cyclic parameter data export 

1" view
Additional information is available in the following 
section:
●  Filtered cyclic parameter data export (Page 156)

(18) "Cyclic parameter data export 
2" view

(18) "Cyclic parameter data export 
3" view
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Po‐
si‐
tion

Display Name Function/remark

(18) "Manual complete export" 
view

You can find additional information in the following 
sections:
● Manually filtered complete export (Page 115)
● Manually filtered complete export via OPC 

(Page 121)
(18) "Cyclic complete export 1" 

view
Additional information is available in the following 
section:
●  Cyclically filtered complete export (Page 125)(18) "Cyclic complete export 2" 

view

(18) "Cyclic complete export 3" 
view

Status displays

Status display Remark
The filtered manual or filtered cyclic parameter data export is enabled and running.
The manual filtered or cyclically filtered complete export is enabled and running.
The filtered manual or cyclic parameter data export is enabled and waiting for the 
next start time.
The manual filtered or cyclically filtered complete export is enabled and waiting for 
the next start time.
The filtered manual or filtered cyclic parameter data export is not enabled.
The manual filtered or cyclically filtered complete export is not enabled.

Additional information
You can find information on other display elements and operator controls in the header in the 
section "Displays and operator controls (Page 179)".

6.11.2.3 How to lock and unlock messages

Introduction   
Messages are locked or unlocked for components from the areas AS/system, field devices 
and user objects.

Messages can be locked or unlocked in the button set or in the faceplate.
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Locked messages are indicated by an X:

● In the group display in the overview area
You can find additional information about this in the section "Overview area (Page 107)".

● In the maintenance group displays in the overview screen, area overview screen, block 
icon, and faceplate
You can find additional information about this in the section "Maintenance status and 
maintenance group display (Page 169)".

Button on the user interface

Button Function Explanation Permission
Lock mes‐
sages

● Faceplate
Messages for component are locked

● Button set
Messages of all displayed components 
are locked

Process controlling (1)

Unlock 
messages

● Faceplate
Messages for component are unlocked

● Button set
Messages of all displayed components 
are unlocked

(1) The operator authorization level can be adjusted.

The operator authorization level is saved in the internal variable @LockMessageAuthLevel in 
WinCC variable management. This variable is created by the OS project editor.

The operator authorization level depends on the number saved as the initial value in the 
variable properties. The initial value is pre-assigned the value 5 by the system.

The number for the required authorization is provided in the User Administrator.

Note

Any change in the operator authorization level must be implemented in the project of each 
operator station in an MS multiple-station system.

Procedure for locking messages
1. Click the desired button.

2. Enter a text in the input box as a comment.

3. Click OK/Lock messages. 

Procedure for releasing messages
1. Click the desired button.
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Additional information
For more information on this, refer to the Process Control System PCS 7; Operator Station 
manual.

6.11.2.4 How to depassivate modules or channels

Introduction
The passivation button is displayed in the faceplate in order to ensure that the discrepancy of 
a redundant module or its failed channels can be detected by the maintenance engineer. 

As long as the discrepancy time is active, maintenance required and a message are displayed 
in the message system in the faceplate of the module.

If, moreover, a long-term discrepancy is detected, the module/channel is passivated. This 
results in a loss of redundancy. The module or the channel is indicated as "Faulty" in the block 
icon. The maintenance demanded, the button for depassivation and a message in the message 
system are displayed in the faceplate.       

If the cause of the discrepancy has been corrected, the depassivation can be carried out with 
the button in the faceplate.

Button on the user interface

Button Function Explanation Permission
Depassivation The module or channels are passiva‐

ted.
"Higher process con‐
trolling" for diagnostics 
area

Procedure
1. Click the "Depassivation" button.

2. Click the "Execute" button.

Result
The depassivation is executed. The button is hidden.

6.11.2.5 How to open websites via maintenance links

Introduction
Up to 3 Web pages which are used to provide support for diagnostics measures can be called. 
The buttons are displayed when the calls are configured.
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Requirements
● The Maintenance Station is available in the MS Standard version.

● The maintenance target (web address) has been configured.

● The maintenance target can be accessed via the network.

Button on the user interface

Button Function Explanation Permission
Open maintenance link 1 Open of the con‐

figured web ad‐
dress

"Higher process controlling" for diag‐
nostics area 

Open maintenance link 2

Open maintenance link 3

Procedure
1. Click the button.

Result
The web page is displayed in a screen window.

6.11.2.6 How to open the online view of HW Config

Introduction   
The "Call Hardware Project" button is used to call the online view of the hardware configuration 
(HW Config).

Note

This function is available for the Maintenance Station in the MS Standard version.

The hardware project can be called if the MS client is operated on the ES.

Button on the user interface

Button Function Explanation Permission
Call hardware project Calls the online view of the 

hardware configuration 
(HW Config)

"Higher process controlling" 
for diagnostics area

Display of the "Call Hardware Project" button
The button is displayed in the header in the faceplate for field devices (EDD) and AS objects.
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Requirement
The component is part of the hardware configuration.

Procedure
1. Click the "Call Hardware Project" button.

Note

Do not proceed until the online view of the hardware configuration (HW Config) is 
completely open, because HW Config online may otherwise be put in the background and 
can no longer be reached if key combinations are locked. In this case, press the button 
once again.

Result
The online view of the hardware configuration (HW Config) opens.

6.11.2.7 How to open the configuration interface of SIMATIC PDM

Introduction   
You use the "Call SIMATIC PDM" button to open the configuration interface for the device 
shown in the faceplate.

Button on the user interface

Button Function Explanation Permission
Call SIMATIC PDM Calls the parameter as‐

signment interface for the 
device

"Higher process controlling" 
for diagnostics area 

Display of the "Call SIMATIC PDM" button
The button is displayed in all views in the faceplate for field devices and user objects that are 
integrated using a device description (EDD).

Requirements
● SIMATIC PDM >= V8.2 is installed.

● The SIMATIC PDM Server is installed and set up.

● The component can be programmed with SIMATIC PDM.
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Procedure
1. Click the "Call SIMATIC PDM" button.

2. Enter your logon data in the input boxes of the logon dialog box.

Result
The configuration interface for the component displayed in the faceplate is opened.

Additional information
You can find information about the opened display in the manual Process Control System 
PCS 7; Help on SIMATIC PDM.

6.11.2.8 How to call up the Web interface of a network component

Introduction   
Use the "Call configuration data" button to open the Web interface for the component.

First, an attempt is made to establish a secure connection (HTTPS) to the device. If the secure 
connection is successfully established, the "Call configuration data" button is displayed for 
operator selection.

If the secure connection cannot be established, an attempt is made to establish a non-secure 
connection (HTTP). If the non-secure connection is successfully established, the "Call 
configuration data" button is displayed for operator selection.

If no connection can be established, the "Call configuration data" button is not available for 
selection.

Note

This function is not available for SIMATIC PDM MS.

Requirements
● The network objects must be accessible via the network.

● The "Trusted sites" security setting is in effect.
For additional information on this topic, refer to the SIMATIC NET; "Industrial Ethernet OSM/
ESM Network Management" Manual.

● The network component device profile corresponds to the OSM or SCALANCE device 
profile.
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Button on the user interface

Button Function Explanation Permission
Call configuration data Call of the Web Interface 

of the component
"Higher process controlling" 
for diagnostics area 

Display of the "Call configuration data" button
The button is displayed in the faceplate in all views for network components.

The button is also displayed when the network component is not accessible.

Procedure
1. Click the "Call configuration data" button.

Result
The Web Interface of the component opens.

6.11.2.9 How to call the Diagnostics Monitor diagnostic tool

Introduction   
You can open the "Diagnostics monitor" Web interface of the component with the 
"Diagnostics monitor" button.

First, an attempt is made to establish a secure connection (HTTPS) to the device. If the secure 
connection is successfully established, the "Diagnostics monitor" button is displayed for 
selection.

If the secure connection cannot be established, an attempt is made to establish a non-secure 
connection (HTTP). If the non-secure connection is successfully established, the "Diagnostics 
monitor" button is displayed for selection.

If no connection can be established, the "Diagnostics monitor" button is not available for 
selection.

Requirements
● The Diagnostics Monitor diagnostic tool is installed and configured.

● The web server is started and enabled in the Windows firewall.

● The PC stations can be accessed via the network.
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Button on the user interface

Button Function Explanation Permission
Call Diagnostics Monitor "Diagnostics monitor" 

Web interface call
"Higher process controlling" 
for diagnostics area 

Display of the "Call configuration data" button
The button is displayed in the faceplate for IPCs.

Procedure
1. Click the "Diagnostics monitor" button.

Result
The diagnostic tool is called.

6.11.3 Views

6.11.3.1 "Ident" view

Available
This view is displayed for all components.

This view is not available in the faceplate for the redundant server pair.

Note

This view is available for the Maintenance Station in the MS Standard and SIMATIC PDM MS 
versions.

Overview     
This view displays the configuration data or device data in the information box. The composition 
of the identification data depends on the component selected.

The structure of the view is identical for all faceplates; only the origin of the identification data 
is different.

The following figure shows an example of the view:
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Display
● Maintenance state

You can find more information on the maintenance status in the sections "Maintenance 
status and maintenance group display (Page 169)" and "Maintenance status of redundant 
components (Page 173)".

● Identification data
The identification data represents the electronic rating plate of a device. The identification 
data is refreshed manually in the faceplate using the operator control.
There is an automatic update following the change in status from "Maintenance alarm" to 
another maintenance status. The exception to this is the status "unknown/unchecked". 
You can find information about the sources of the identification data in the section "Origin 
of the identification data (Page 236)".

Note

Not every asset provides all identification data.

If certain identification fields in the "Ident" view are empty even though the time stamp in 
the "Last update" field has been updated, these data are not provided by the component. 
The causes may be as follows:
● There is no data stored in the component.
● The component does not recognize the data.

If, however, no time stamp is displayed in the "Last update" field, then either the 
identification data have not been updated or there are no online data available for these 
components.

● Comment
The comment is read from HW Config.
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● Last update
The timestamp of the last update of the identification data is displayed.

● State
The following table shows the icon representation for the origin of the data:

Display Meaning
Device data
The data source is the device.
Project data
The data source is the project. 
No data were read from the device.

No icon No information on the data source

Operator control

Button Explanation Permission
Clicking the button updates the display of iden‐
tification data.

"Process controlling" for the diagnos‐
tics area

Additional information
You can find information on displaying redundant components in the faceplate in the section 
"Display of faceplate for redundant components (Page 235)".

6.11.3.2 "Messages" view

Available
This view is displayed for all components.

Note

This view is available for the Maintenance Station in the MS Standard and SIMATIC PDM MS 
versions.

Overview     
This view contains all messages that are present for a component.

The following messages are displayed:

● Diagnostic/error messages

● Operating messages after selection of the long-term archive list in the toolbar

The following figure shows an example of the view:
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Display
Messages

● Currently pending messages, independent of acknowledgment status

● Unacknowledged messages went out

● In addition to the filter for the "Origin", only messages that belong to the "Diagnostics" area 
are displayed.

Operator control
Operation takes place the same way as operation on an operator station.

You can find additional information on this in the manual Process Control System PCS 
7, OS Process Control.
The following button is also displayed for switching between the "Journal" view and the 
"Operator message" view if the short-term archive list is selected.

Button Explanation Permission
Clicking the button calls the short-term archive list and 
the following button for switching between the "Jour‐
nal" view and the "Operator message" view is dis‐
played.

No access protection

Clicking the button switches the view.

6.11.3.3 "Maintenance" view

Available
This view is displayed for all components.

This view is not available in the faceplate for the redundant server pair.

Note

This view is available for the Maintenance Station in the MS Standard and SIMATIC PDM MS 
versions.
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Overview
This view allows the maintenance engineer to demand and manage a maintenance job for the 
specific component. The maintenance state of the demanded maintenance measure is 
displayed in the diagnostic screens in the maintenance group display. The maintenance state, 
the maintenance job and the state of the maintenance job are displayed in the header of the 
faceplate.       

In this view you can execute a single export, consisting of identification data, the maintenance 
state and the maintenance information of the respective component.

The following figure shows an example of the view for an input and output module:

The following figure shows an example of the view for a PC object:
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Display
● Sum status of the release for maintenance

The display is formed from the state of the maintenance release of the lower-level 
components and their own components.

Display Meaning
Release granted for all components/channels involved

Release not granted for at least one component/channel involved

Note

The Advanced Process Library must be used in order to display the maintenance release.

● Maintenance release for lower-level components/channels

Display Meaning
Not interconnected/used
Interconnected/used and release by the operator in the plant area not granted
Interconnected/used and release by the operator in the plant area granted

Note

The Advanced Process Library must be used in order to display the maintenance release.
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Operator control

Representation/
Designation

Explanation Operator permis‐
sion

"Maintenance job" 
area
● Alarm
● Prompt
● Request

A maintenance job is requested by clicking an option button. "Process control‐
ling" for the diag‐
nostics area

"Requested action" 
area

You select an action from the drop-down box.
An action, for example, can be "Disassembly".
You can find information on configuring an action in the 
section "Configuring maintenance actions (Page 69)".

"Time requested" 
area

The time of the request of the maintenance job is specified 
in the input box. The time is entered in the following format: 
YYYY.MM.DD - hh:mm.

"Maintenance sta‐
tus" area
● In maintenance
● Release request
● Planned 

maintenance
● Completed
● Cancel

By selecting an option button, the maintenance job is given 
a processing state.

"Passivate" check 
box

Available for PC and IPC objects
The PC object is passivated by clicking on the check box.
You can find information on passivation in the section "Pas‐
sivating PC objects (Page 248)". 

"Memo" area The maintenance engineer can enter a note for the service 
job in the memo field or change a saved note.
The text is applied to the individual export file. 
In order for the note text to be saved as a comment for the 
operator message and permanently displayed in the memo 
field, one of the following operator actions is required in 
addition to entering the note text:
● Change the type of maintenance job in the maintenance 

job area
● Switch between the service types "In maintenance" and 

"Planned maintenance" (bilateral) in the Maintenance 
status area

The note text is deleted when you complete or cancel the 
maintenance job. 

"Targets" area ● Check boxes
By selecting this check box, the single export file is 
stored in the selected target.

● Drop-down box
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Representation/
Designation

Explanation Operator permis‐
sion

Select the storage path for the single export file from the 
drop-down box. A maximum of two targets can be 
selected at the same time.

You can find information on configuration of a target in the 
section "Configuring maintenance targets for individual ex‐
port (Page 67)".
Clicking the button creates a maintenance job as a single 
export file or displays it as a print job.
The Print function is available if your plant is not operated 
via a PCS 7 Web client.   

Additional information
You can find information on single export in the section "Overview of individual export 
(Page 90)".

6.11.3.4 "Note" view

Available   
This view is displayed for all components.

This view is not available in the faceplate for the redundant server pair.

Note

This view is available for the Maintenance Station in the MS Standard and SIMATIC PDM MS 
versions.

Overview   
You can leave temporary messages for other maintenance engineers in this view. 

The following figure shows an example of the "Notes" view.
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Operator control

Display Explanation Permission
Free area Text box for the note "Process controlling" for the di‐

agnostics areaThe note is enabled or disabled by selecting the check 
box.
● Enabling

The note is enabled when the check box is 
selected.
The next time the faceplate is opened or there is a 
process picture change, you can see in the status 
bar of the block icon and the faceplate that there 
is a new message for you.

● Disabling
The display in the status bar of the faceplate and 
in the block icon is hidden.
The message is not deleted automatically.

Note

A full compilation of the MS (that is the MS for single-station systems and the MS server for 
multiple-station systems) and subsequent download of the MS server deletes the contents of 
the memo view.
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6.11.3.5 "Diagnostics" view for PC objects

Available
The view is displayed for the IPC component from the PC objects area.

Note

This view is available for the Maintenance Station in the MS Standard and SIMATIC PDM MS 
versions.
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Overview     
Up to 18 binary states of an IPC are displayed in this view.

● The following figure shows an example of the view for a component IPC with the profile 
V1.3:

● The following figure shows an example of the view for a component IPC with the profile 
V1.4 or higher:

The redundancy loss of channel A/B is only indicated in the case of a redundant connection 
to the terminal bus with Softnet IE/RNA in combination with the IPC Profile 1.5.
As soon as one of the two terminal bus cables is removed, this is visualized with a "red" 
state display.
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Display
● Status of the component

The following table shows the icon representation of the statuses:

Display Meaning
No detail information pending or available

Pending fault

There was a fault for a time

No icon No state

Operator control

Button Explanation Permission
Clicking the button opens the legend.
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

With Profile V1.4 and higher, the stored states are re‐
set when you click the button.

"Process controlling" for the 
diagnostics area

6.11.3.6 "Connection display" view for client components

Available
The view is displayed for all OS clients, MS clients and OS/MS clients from the area of the PC 
objects.

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
This view shows all servers, the server data of which are downloaded to the client.

Servers are OS servers, MS servers and OS/MS servers.

The following figure shows an example of the view:
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Display
● The symbolic computer name of all servers

● The computer name of all servers

● The computer name of the redundant partner

● Configured and currently connected preferred servers
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● Current connection

● State
The following table shows the icon representation of the statuses:

Display Meaning
Configured preferred servers

Currently connected server is preferred server and connection is 
available
Connection available

Connection not available

Connection has failed in the meantime

Currently connected server is preferred server and connection has 
failed in the meantime
The server does not assume the "Error" state and waits until its part‐
ner can take over again. Only then does the server assume the 
"Fault" state.
The currently connected server is the preferred server. The server 
does not assume the "Error" state and waits until its partner can take 
over again. Only then does the server assume the "Fault" state.

Operator control

Button Explanation Permission
Clicking the button opens the legend. 
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

Clicking the button resets the selection for server con‐
nections that have failed in the meantime.

"Process controlling" for the 
diagnostics area

6.11.3.7 "Connection display" view for server components

Available 
The view is displayed for all OS servers, MS servers and OS/MS servers from the area of the 
PC objects.

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
This view displays all clients connected to the server.

Clients are OS clients, MS clients and OS/MS clients.
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The server data of the server must be assigned to the clients.

The partner is displayed for a redundant server.

The following figure shows an example of the view:

Display
● The computer name of all clients assigned to the server

● The computer name of the redundant partner

● Configured and currently connected preferred servers

● Current connection

● State
The following table shows the icon representation of the statuses:

Display Meaning
Configured preferred servers

Currently connected server is preferred server and connec‐
tion is available
Connection available

Connection not available

Connection has failed in the meantime

Currently connected server is preferred server and connec‐
tion has failed in the meantime
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Operator control

Button Explanation Permission
Clicking the button opens the legend. 
The legend shows the icons designating the possi‐
ble statuses and their meaning.

No access protection

Clicking the button resets the selection for client 
connections that have failed in the meantime.

"Process controlling" for the di‐
agnostics area

6.11.3.8 "Diagnostics" view for AS objects

Available     
The following views are shown for devices of the type Switch, Drive and EnergyMeter from the 
field devices area.

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
Information on Switch, Drive and EnergyMeter type devices is displayed in these views. 
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● The following figure shows an example of the view for Switch:

● The following figure shows an example of the view for Drive:
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● The following figure shows an example of the view for Drive in accordance with the NAMUR 
standard:

● The following figure shows an example of the view for EnergyMeter:

Display
● Statuses for the device

The following table shows the icon representation of the statuses:

Display Meaning
No detail information pending or available

Problem exists

There was a fault for a time

There is a warning

There was a warning for a time

No icon No state
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Operator control

Button Explanation Permission
Clicking the button opens the legend. 
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

Clicking the button resets the saved states. "Process controlling" for the 
diagnostics area

6.11.3.9 "Performance" view for AS objects

Available   
This view is displayed for the AS station in the AS/system area for CPU types that support the 
SFC78 and have the following firmware versions:

● Standard CPU 41x >= firmware version V5.0

● H-CPU 4xx >= firmware version V4.5

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
This view graphically displays the overall situation of the CPU utilization. All values in the bar 
chart are given as percentages. The reference value is the assigned maximum cycle 
monitoring time of the CPU.

All of the displays of the overall situation are mean values. because displaying actual values 
of the most recent cycle in each instance would result in a widely fluctuating reduction ratio 
display in the screen refreshing cycle.

The following figure shows an example of the view:
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Display
● Total runtime

The values in the bar diagram are specified in %, relative to the set maximum cycle 
monitoring time.
Its numeric magnitude is displayed under the bar.

– Mean value
Mean value of the actual value in % (TOTALPER block parameter)

– Actual value
Mean value of all net run times in % OB3x/OB8x + OB1 (TOTALCUR block parameter)

– Max. value
Formed from the net run times in % of all the OB3x/OB8x + OB1 net run times from the 
most recent cycle (TOTALMAX block parameter)

– Min. value
Formed from the net run times in % of all the OB3x/OB8x + OB1 net run times from the 
most recent cycle (TOTALMIN block parameter)

● Horizontal bar diagrams for OB3x
The values refer to the respective OB cycle time.
The graphic display of the OB3x times is expanded by an indicator that signals buffered 
and lost start events.

– Net value

– Gross value

– Start event lost

● Horizontal bar diagrams for OB8x and OB1
The values refer to the configured maximum cycle monitoring time.

– Net value

● Scan rate:
Display of the scan rate for all cyclical OBs of the user program

Operator control

Button Explanation Permission
Clicking the button opens the legend. 
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

Clicking the button resets the values. "Process controlling" for the 
diagnostics area
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Avoiding a CPU stop
Functions have been integrated into the CPU to ensure that the user programs can continue 
running even when the CPU becomes overloaded and to prevent the CPU from switching to 
"STOP" mode. The "Emergency mode" parameters are assigned in the "CPU function block" 
faceplate, "Parameters view".

NOTICE

Utilization limit

When the CPU gets close to full capacity, the user programs will become sluggish. If this 
starts to affect process mode, the user program will need to be reconfigured.

You can find additional information about this in the section ""Parameters" view for AS 
objects (Page 215)".

6.11.3.10 "OBx..." view for AS objects

Available     
This view is displayed for the AS station in the AS/system area for CPU types that support the 
SFC78 and have the following firmware versions:

● Standard CPU 41x >= firmware version V5.0

● H-CPU 4xx >= firmware version V4.5

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
This view displays the utilization of the OBs in a CPU with diagnostics functionality.

The following figure shows an example of the "OB3x" view .
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The figure shows an example of the "OB8x/OB1" view.

Display
● The utilization of the OB3x organization blocks is shown in the "OB3x" view:

– The absolute gross and net value, and the average value over a number of cycles of 
the OB 3x, related to the configured maximum cycle monitoring time of the OB in each 
case.

– The minimum and maximum values reached since the last reset of the OBs

● The utilization level of the OB8x organization blocks is shown in the "OB8x/OB1" view:

– The absolute net value and the average value over a number of cycles of the OB8x and 
OB1, related to the configured maximum cycle monitoring time of the OB in each case.

– The minimum and maximum values reached since the last reset of the OBs.

Operator control

Button Explanation Operator permission
Clicking the button resets the counter states. "Process controlling" for the diagnos‐

tics area
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6.11.3.11 "Parameters" view for AS objects

Available
This view is displayed for the AS station in the AS/system area for CPU types that have the 
following firmware versions:

● Standard CPU 41x >= firmware version V5.0

● H-CPU 4xx >= firmware version V4.5

Note

This view is available for the maintenance station in the MS Standard version.

Overview     
In this view, parameters can be assigned for the overload behavior.

The default cycle monitoring time for the CPU is 6 s. 

Failure to process all the OBs within this time will result in a cycle overload. 
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To prevent the CPU from switching to "Stop" mode, you can parameterize "Emergency mode".

● The following figure shows an example of the "Parameter" view of the CPU with SFC78.

● The following figure shows an example of the "Parameter" view of the CPU without SFC78.

Emergency mode
"Emergency mode" automatically reduces the speed of the configured cyclic tasks. The user 
programs then run more slowly.

"Emergency mode" should not be used on a continuous basis. The "Emergency mode" is 
signaled as a maintenance alarm with maximum priority setting.
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Display/Operation

Identifier Explanation Operator permission
OB3x reduction with overload In the event of an overload the OB is processed more 

slowly.
Reduction is enabled or disabled by selecting the check 
box.
In this display, reduction is enabled.

"Higher process control‐
ling" for diagnostics area

Max. number suppr. STOP demanded X (X is a number between 1 and 9999)
The number 50 is preset at the block for X by the sys‐
tem.
After the cycle monitoring time is exceeded for X+2 
times, the CPU switches to "STOP"

Alarm limit capacity If the total utilization, which equates to the sum of the 
mean values for all the net run times (in % for OB3x, 
OB8x + OB1), exceeds the alarm limit capacity, then 
the message "Net time consumption of all OBs exceeds 
max. limit" is output and the maintenance status is set 
to "Maintenance demanded".

Cancel reduction for Emergency mode is terminated automatically when the 
maximum total utilization of the controller as configured 
in the "Cancel reduction for x%" or "MAX_VAL 
(CPU_RT)" parameter is reduced accordingly and 
there is no longer any long-term violation of the cycle 
time.

Hysteresis alarm limit Hysteresis prevents the message "Net time required by 
all OBs exceeds max. limit" from "wavering".

Calculating the CPU load (Display) The CPU load for the display is calculated for the speci‐
fied number of cycles.

Calculating the CPU load (internally) The (internal) CPU load is calculated for the specified 
number of cycles.

Message as of request errors If the value is exceeded, an "OB3x request error" mes‐
sage is output.

CPU load increase to Once the slowest running OB has resumed "normal" 
running speed for 5 consecutive cycles, the reduction 
is canceled.

6.11.3.12 "Connection load display" for CPU connections

Available 
This view is displayed for the AS station in the AS/system area for the following CPU types:

● H-CPU 4xx >= firmware V6

Note

This view is available for the Maintenance Station in the MS Standard version.
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Overview
This view shows the 5 most heavily loaded connections of the CPU.

The connection types are displayed according to the maximum value of the load from the top 
down. 

The following figure shows an example of the view:

Note

The displayed actual values correspond to the values that are displayed on the "Connection 
statistics" tab in the "Module status" dialog of the CPU.
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Display
● Connection type:

The connection type corresponds to the configuration in NetPro.

– Invalid connection type

– S7 connection

– S7 connection (fault-tolerant)

– T connection (TCP native)

– T connection (UDP)

– T connection (ISO-on-TCP)

– Routed connection

– PG connection

– OP connection

– OMS connection

– Free connection

– Free connection (TCP)

– System connection

– RPC7 connection

– Connection for basic communication

● Partner / identification
Shows the partner ID from NetPro

● Load
Shows the utilization of the connection as a percentage

● Actual value

● Maximum value

Operator control

Button Explanation Permission
Clicking the button opens the legend. 
The legend shows the icons designating the possible statuses 
and their meaning.

No access protec‐
tion

Clicking the button resets the displayed values. "Process control‐
ling" for the diagnos‐
tics area
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6.11.3.13 "Diagnostic buffer" view for CPU and CP

Available     
The view is displayed for all CPUs and CPs in the central rack and expansion rack.

Note

This view is available for the Maintenance Station in the MS Standard version.

"Diagnostic buffer of the CPU/CP" overview
This view shows the last 20 events that occurred in the diagnostic buffer of a CPU or CP. 

The following figure shows an example of the information from the diagnostic buffer of a CPU:

Note

Access from the faceplate on the Maintenance Station is not possible if the diagnostic buffer 
on the Engineering Station is already open.
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Display
● Sequential number

● Time
Time when the event occurred

● Short text
Brief information about the event

● Error code
Error code for the event

● Detailed description
Detailed information on the event

● Last update
Time stamp of the last update of the data

Operator control

Button Explanation Permission
No display Additional information about the event is displayed in 

the "Detailed description:" area when you click on a 
line.

No permission

When you click the button, the events are read from 
the diagnostic buffer again and the table is updated.

"Process controlling" for the 
diagnostics area

6.11.3.14 "LED display" view for CPU

Available     
The view is displayed for all CPUs.

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview 
This view displays the LEDs of the CPU.

The following figure shows an example of the display for a redundant CPU:
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Display
● Frequency

The following table shows an example of the frequency at which the state flashes:

Display Meaning
0.5 The LED flashes at a frequency of 0.5 Hz.

● State
The following table shows the icon representation of the statuses:

Display Meaning
"Active" state

"Active" state

"Fault is present" state

No state pending / not relevant for this hardware 
configuration

6.11.3.15 "Diagnostics" view for field devices

Available
This view is displayed for all components from the field devices area.

Note

This view is available for the Maintenance Station in the MS Standard and SIMATIC PDM MS 
versions.

Overview     
This view displays data of field devices that are integrated using a device description (EDD).

The data are read in SIMATIC PDM and transferred to the Maintenance Station.
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The following figure shows an example of the view:

Display
● Communication via SIMATIC PDM

Displays the state of the communication connection between SIMATIC PDM and the device 
the last time communication was established

Display Meaning
Communication with SIMATIC PDM established

Communication with SIMATIC PDM not established

● Write protection
Shows the time stamp for when the "Project-specific write protection" parameter was set 
in SIMATIC PDM for this device

Display Meaning
Write protection is set

No icon Write protection is not set
Time stamp for write protection
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● Loop check
Shows the time stamp for when the "Device tested" parameter was set in SIMATIC PDM 
for this device

Display Meaning
Loop check was performed

No icon Loop check was not performed
Time stamp of the last "Loop check".

● Device state 
Indicates the possible state of the relevant device (standard diagnostics based on the PA 
Profile of the "PROFIBUS & PROFINET International" organization)

Display Meaning
The state "Good" is indicated by a green symbol before the cor‐
responding text.
The individual error states are indicated by a red symbol before 
the corresponding text.

No icon No state pending

● Detailed diagnostics:
Shows the time stamp of the last reading of the diagnostics data in SIMATIC PDM

Display Meaning
Time stamp of the last update of the data

The content of the text box is read and displayed for the current state from the EDD of the 
device supplied by the manufacturer.
The information displayed in the text field shows messages of the respective field device. 
The texts are manufacturer-specific. 
The texts are only displayed in the language configured in SIMATIC PDM or in the default 
language specified by the manufacturer. 
The language change in process control has no effect.
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Operator control

Display Explanation Permission
● Cyclical update

Cyclical update is enabled or disabled by 
selecting the check box. Update is disabled in 
this display.

● Selection for parameter data export:
By clicking the check box, the device can be 
recorded through the selection of the "Selected 
devices" filter for filtered complete export and 
filtered parameter export data.

"Process controlling" 
for the diagnostics 
area

The device-specific update interval can be selec‐
ted from the drop-down list.
Four update intervals are available.
The default values are:
● 1 day
● 12 hours
● 1 hour
● 10 minutes
The selected update interval is displayed.
The system default for the update interval is one 
day.
If the cyclic update is disabled, the update interval 
can be changed. 
The configured time does not indicate the exact 
cycle of the update. It only means that after updat‐
ing a device, the next update for this device will be 
performed after the selected time. If other devices 
have to be processed beforehand at this time, the 
update can be delayed.
Click the button to update the displayed informa‐
tion.

Additional information
You can find information on the displayed error texts for updating the diagnostics data in the 
section "Error texts for field devices/user objects (Page 233)".

You can find information on the loop check function and project-specific write protection in the 
SIMATIC PDM manual.
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6.11.3.16 "Parameters" view for field devices

Available
This view is displayed for all components from the field devices area.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.

Overview
This view displays the device parameters saved in the project for field devices that are 
integrated using a device description (EDD).

The following figure shows an example of the view:

Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 233)".

6.11.3.17 "External diagnostics" view

Available
This view is displayed for components from the field devices area.
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The view is only displayed for the diagnostic block that is interconnected directly with the 
channel block.

If you are operating a module redundantly, the signals are transmitted to the upstream 
diagnostic block via the "OR block".

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
External diagnostic information for the component is displayed in this view.

The following figure shows an example of the view:

Display
● State

The following table shows the icon representation of the statuses:

Display Meaning
No external detail information pending or available

No external detail information pending or available

No icon No state pending

● Display text
You configure the texts in the "Advanced Diagnostic Settings".

Additional information
You can find information on configuring the texts in the section "Configuring maintenance 
information (Page 72)".
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You can find information on configuring maintenance information in the section "Configuring 
the display of maintenance information (Page 81)".

6.11.3.18 "Diagnostics" view for user objects

Available     
The following views are displayed for components from the user objects area.

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview 
In this view, information on the user object are displayed. 

The following figure shows an example of the view:
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Display
● State

The following table shows the icon representation of the statuses:

Display Meaning
No external detail information pending or available

Detail information pending

Detail information existed for a time

No icon No state pending

● Display text
The texts are configured by the user in the SIMATIC PDM object of the AssetM block in the 
EDD.

Operator control

Button Explanation Permission
Clicking the button opens the legend. The legend 
shows the icons designating the possible statuses and 
their meaning.

No access protection

Clicking the button resets the saved states. "Process controlling" for the di‐
agnostics area

Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 233)".

6.11.3.19 "Monitoring" view for user objects

Available
This view is displayed for all components from the user objects area.

Note

This view is available for the Maintenance Station in the MS Standard version.

If a designation for at least one process value is entered in the EDD, the view can be selected.
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Overview     
PCS 7 offers the option of setting up, in a user diagnostics structure, monitoring functions for 
objects that are not automatically integrated in the diagnostic screens of the Maintenance 
Station. These objects include, for example:

● Values defined by rules or calculations

● Objects that do not support diagnostics (e.g., field devices not recognized in PCS 7)

● Technical areas

● Groups of components

You can show the following monitoring functions in a diagnostics screen:

● Operating hours meter

● Service interval

● Calibration interval

The following figure shows an example of the view:
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Display
If a designation for the process value is entered in the EDD, the corresponding area is displayed 
in the view.

● Label for the process value e.g. PV1
The text is configured by the user in the SIMATIC PDM object of the AssetM block in the 
EDD.

● Signal status
The number in the priority column indicates the priority of the display. The lowest number 
has the highest priority.

Display Priority Remark
1 Bad, device-related

2 Bad, process-related

3 Local functional check, simulation

4 Uncertain, device-related

5 Uncertain, process-related

6 Maintenance demanded

None 7 Good
None - Input not connected

● Actual value
The value is read from the AssetM block.

● Remaining value
The difference between the actual value and the next limit value is formed in the AssetM 
block.

● Units of measure
The unit of measurement is configured in the AssetM block.

● Alarm limits
The alarm limits are configured in the AssetM block.

Operator control

Button Explanation Permission
The alarm limits are enabled or disabled by selecting the check 
box.
In this display, the alarm limits are disabled.

"Process control‐
ling" for the diagnos‐
tics area

Clicking the button outputs a pulse at the block. This pulse can 
be processed further, for example, to reset the counter value 
at the following technological block (counter).
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Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 233)".

6.11.3.20 "CFU diagnostics" view for the compact field unit

Available
The view is displayed for the compact field unit from the field devices area. 

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
This view displays the maintenance states of the individual CFU channels. 

The eight binary input/output channels are displayed on the left half of the screen.

The right half of the screen shows the eight Spurs for connecting the field devices.

The following figure shows an example of the view:

Display
Status display, channels/spurs

The following table shows the icon representation of the states:
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Display of icons with black border line 1, 2 and 3

Display Meaning
Maintenance required pending

Maintenance demanded pending

Maintenance alarm pending

"Good" state

Maintenance status was pending and has not yet 
been reset

No icon Channel not in use.

Operator control

Button Explanation Permission
Clicking the button opens the legend.
The legend shows the icons designating the possible 
states and their meaning.

No access protection

Clicking the button resets the saved maintenance 
states.

"Process controls" for the di‐
agnostics area

6.11.3.21 Error texts for field devices/user objects
The following table shows possible error texts in the views:

● "Diagnostics" view for field devices (Page 222)

● "Parameters" view for field devices (Page 226)

● "Diagnostics" view for user objects (Page 228)

● "Monitoring" view for user objects (Page 229)

Error code Output In the faceplate Possible measures
A0040110
80010108

Connection to SIMATIC PDM could 
not be established. 
Possible causes:
- Archiving is active on the ES
- Communication error
- Access to the project is blocked

Check:
● Whether the ES is accessible via the terminal bus
● Whether an archiving job is running on the ES

Wait until the end of the archiving job.
● Whether the SIMATIC PDM Asset Service is stopped and the 

"automatic start/stop" is not activated
Allow the "automatic start/stop".
Start the SIMATIC PDM Asset Service.

A0040001 General error has occurred. A general SIMATIC PDM error is indicated.
Contact Technical Support.

A0040006 Internal error - Incorrect call parame‐
ter

The transferred XML string is incorrectly structured.
Contact Technical Support.
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Error code Output In the faceplate Possible measures
A0040101 Command cannot be run because 

PDM Asset Service is being stopped.
Check whether the SIMATIC PDM Asset Service is currently being stop‐
ped and "automatic start/stop" is not activated.
Allow the "automatic start/stop" and start the SIMATIC PDM Asset Serv‐
ice.

A0040102 Command cannot be run because 
PDM Asset Service is stopped.

A0040103 Internal error - Error when parsing the 
XML transfer parameters

The transferred XML string is incorrectly structured.
Contact Technical Support.

A0040002 Not enough memory. Check whether the error is still indicated after a restart of the ES.
A0040104 Maintenance path not found or emp‐

ty.
● Check whether the maintenance project is entered correctly in the 

settings for SIMATIC PDM.
● Stop and start the SIMATIC PDM Asset Service.

A0040105 Timeout for current command. Error in the SIMATIC PDM Asset Service when executing the jobs.
Check whether the error is still indicated after a restart of the ES.A0040106 Internal error - Command could not 

be executed
A0040107 Internal error - Timeout for current 

command
The SIMATIC PDM Asset Service should be stopped, but this is not 
possible because jobs are still queued or are still being processed.
● Wait a little longer.
● Then reboot the computer.

A0040108 PCS 7 project cannot be opened. ● Close SIMATIC Manager on the ES and open the project again.
● Stop and start the SIMATIC PDM Asset Service.

A0040109 Internal error - Command could not 
be executed

● Stop and start the SIMATIC PDM Asset Service.
● Restart the ES if necessary.

A004010A PCS 7 project could not be opened. ● Close SIMATIC Manager on the ES and open the project again.
● Stop and start the SIMATIC PDM Asset Service.A004010B PCS 7 project could not be opened.

A004010C Incorrect project PLT ID ● Re-enter the maintenance project in the settings for SIMATIC PDM.
● Stop and start the SIMATIC PDM Asset Service.A004010D Object (PLT ID) not found

A004010E ASSET export path incorrect ● Check whether the export path entered in the SIMATIC PDM settings 
can be accessed via the terminal bus.

● Re-enter the export path in the SIMATIC PDM settings.
A004010F ASSET export could not be written - 

Access error
Check:
● Whether the export path entered in the SIMATIC PDM settings can 

be accessed via the terminal bus.
● The necessary access authorizations

A004000B License error Check the required SIMATIC PDM licensing on the ES.
A004000A Access denied. Check the access authorizations.
A004000D Object locked. Check whether the device is already open on another computer or by 

another application.
A0040008 Object not found. A general SIMATIC PDM error is indicated.

Contact Technical Support.80000003
A0040201
80004001
80070057
80600009
8000FFFF
80004003

Functional error, SIMATIC PDM 
Server not accessible
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Error code Output In the faceplate Possible measures
A0040111 Command cannot be run

because PDM Asset Service is stop‐
ped and not in automatic mode

Check:
● Whether SIMATIC PDM Asset Service is already stopped
● That the "Allow automatic start/stop" option is set

A0040112 Internal error - Object not found Check the SIMATIC PDM Web configuration.

Note

If the suggested measures are not successful or an error code is output that is not further 
specified in the table, contact Technical Support.

6.11.4 Display of faceplate for redundant components

Introduction
Various displays are available for redundant components:

● The information is displayed in one faceplate.

● The information is displayed in several faceplates.

Display in several block icons/faceplates
The associated faceplate is opened by each block icon.

In all views:

The custom maintenance state is displayed in the faceplate for the component and for the 
partner in the relevant diagnostic icon.

The redundancy state is displayed in the faceplate for the redundancy object.

Display in a block icon/faceplate
The associated faceplate is opened by the block icon.

The redundancy state is displayed in the header in one diagnostic icon.

"Ident" view:

● In this view, if the component is redundant, one diagnostics icon is displayed for the active 
component and one for the passive component. The respective diagnostic icon displays 
the custom maintenance state.

● An orange square is displayed between a diagnostic icons. The square identifies the active 
component. The active component is the component with the master role.

● When the faceplate is opened, the information box always shows the data of the active 
component. 

● By clicking on a diagnostics icon, the diagnostics icon is given a colored border and the 
corresponding data is displayed in the information box.
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● Refreshing data with the "Refresh" button only affects the active component. This may have 
the result that only project data is displayed for the passive component. 

● If the passive component was active and the data was refreshed with the "Refresh" button, 
device data is also displayed for the passive component.

● If the passive component is selected in the faceplate, when the "Refresh" button is clicked, 
the diagnostics icon of the active component is given a colored border and the data of the 
active component is displayed in the information box.

The following figure shows an example of the "Ident" view for a redundant component:

Additional information
You can find information on the redundancy state in the section "Maintenance status of 
redundant components (Page 173)".

6.12 Origin of the identification data

6.12.1 Identification data for IPCs

Where does the identification data for IPCs come from?
In the case of the faceplate for IPC objects, the identification data is read from the device via 
an SNMP connection. 

The device must be configured in the SNMP OPC Server of the maintenance station for this. 

These data are prepared for display on the maintenance station with the "Export tags for 
WinCC" function.
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The following table shows the assignment of the identification data displayed on the MS to the 
origin. 

Identification data Origin
SNMP Profile V1.5 for IPC PC with support of the SNMP 

Profile MIB-II
TAG / HID SNMP tag ".sysName" Not available
LID Object properties of the PC station "Name"
Address HW Config/OPC server "IP address" / 

SNMP tag "&ipAddress()"
IP address terminal bus 
CCAgent

Description Not available
 Message

Device type SNMP tag ".ProductName" Not available
Manufacturer SNMP tag ".Manufacturer" Not available
Article number 1) SNMP tag ".StationMLFB" Not available
Serial number SNMP tag ".StationSerialNumber" Not available
Installation date Not available
HW revision SNMP tag ".HwVersion" Not available
SW revision SNMP tag ".SwVersion" Not available
Last update Time stamp of the updating of the identification data
Comment Object properties of the PC station "Comment"

1) Article number = also order number or MLFB

6.12.2 Identification data for PCs

Where does the identification data for PCs come from?
In the case of the faceplate for PC objects, the identification data is determined directly in the 
PC if the PC does not support an SNMP connection.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Object properties of the PC station objects "Computer name"
LID Object properties of the PC station "Name"
Address IP address terminal bus CCAgent
Description Not available
Message
Device type IWbemService (Win32_ComputerSystem_Model)
Manufacturer IWbemService (Win32_ComputerSystem_Manufacturer)
Article number 1) IWbemService (Win32_ComputerSystemproduct_IdentifyingNumber)
Serial number IWbemService (Win32_BaseBoard_SerialNumber)
Installation date IWbemService (Win32_OperatingSystem_InstallDate)
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Identification data Origin
HW revision IWbemService (Win32_BaseBoard_Version)
SW revision IWbemService (Win32_BIOS_SMBIOSVersion)
Last update Time stamp of the updating of the identification data
Comment Object properties of the PC station "Comment"

1) Article number = also order number or MLFB

6.12.3 Identification data for network objects

Where does the identification data for a network object come from?
In the case of the faceplate for network objects, the identification data is read from the device 
via an SNMP connection. 

The device must be configured in the SNMP OPC Server of the maintenance station for this. 

This data is prepared for display on the maintenance station with the "Export variables for 
WinCC" function.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
For example, Profil_OSM_V10.txt Profile MIB-II

TAG / HID WBM1) "automationFunctionTag" Not available
LID HW Config/OPC server "Name"
Address HW Config/OPC server "IP address" / 

SNMP variable ".&ipAddress()"
Description Not available
Message
Device type2) WBM1) "Device Type" / 

SNMP variable ".sysDescr"
Manufacturer WBM1) "automationManufacturerId" Not available
Article number3) SNMP variable ".snInfoOrderNr"
Serial number SNMP variable ".snInfoSerialNr"
Installation date Not available
HW revision SNMP variable ".snHWVersion" Not available
SW revision SNMP variable ".snSWVersion" Not available
Last update Time stamp of the updating of the identification data
Comment HW Config/OPC server "Comment"

1) WBM = Web based management (Web interface of the network object)
2) If the SNMP variable ".sysDescr" contains identification information in addition to the device 
type, this will be displayed in the corresponding field. The "Device type" field only displays 
information about the device type.
3) Article number = Also order number or MLFB
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6.12.4 Identification data for AS objects

Where does the identification data for an AS object come from?
In the case of the faceplate for AS objects, the identification data is read from the properties 
of the module or dynamically from the CPU.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
HID / TAG

static
dynamic

 
HW Config "Higher level designation" (HID)
I&M data (SZL), (I&M1 Tag_Function)

LID
static

 
HW Config "Designation" or "Name"

Address HW Config
"Slot/address information"

Description
static

dynamic

 
HW Config "additional information"
I&M data (SZL), (I&M3 Descriptor)

Message Not available
Device type HW Config "type" or "short description"
Manufacturer

static
dynamic

 
HW Config - Not accessible 1)

I&M data (SZL), (I&M0 Manufacturer_ID)
Article number 2)

static
dynamic

 
HW Config "Article number" 2)

I&M data (SZL), (I&M0 Order_ID)
Serial number

static
dynamic

 
Not available
I&M data (SZL) (I&M0 Serial_number)

Installation date
static

dynamic

 
HW Config "installation date"
I&M data (SZL), (I&M2 Installation_date)

HW revision
static

dynamic

 
Not available
I&M data (SZL) (I&M0 Hardware_revision)

SW revision
static

dynamic

 
HW Config - Not accessible*
I&M data (SZL) (I&M0 Software_revision)

Last update Time stamp of the updating of the identification 
data

Comment HW Config "Comment"

1) Not accessible means that the user cannot make an entry or modification here.
2) Article number = also order number or MLFB
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6.12.5 Identification data for devices that are integrated using a device description (EDD)

Where does the identification data for devices that are integrated using a device description (EDD) 
come from?

In the case of the faceplate for devices that are integrated using a device description (EDD), 
the identification data is provided via SIMATIC PDM.

The data are provided if the device description is created in conformance with the specifications 
of the PROFIBUS & PROFINET International organization, the Hart Communication 
Foundation, or the Fieldbus Foundation.

The information is largely based on the tag names used in the EDDs. These tag names can 
be optionally displayed in the configuration interface of PDM. The display is activated in the 
settings of SIMATIC PDM.

PA profile according to PNO
The data are displayed if they can be determined explicitly using the EDD of the device.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Profile tag "TAG_DESC"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Profile tag "DESCRIPTOR"
Message Profile tag "DEVICE_MESSAGE"
Device type Profile tag "DEVICE_ID"
Manufacturer Profile tag "DEVICE_MAN_ID"
Article number 1) Not available
Serial number Profile tag "DEVICE_SER_Num"
Installation date Profile tag "DEVICE_INSTAL_DATE"
HW revision Profile tag "HARDWARE_REVISION"
SW revision Profile tag "SOFTWARE_REVISION"
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB

I&M profile according to PNO
The data are displayed if they can be read from the device.
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The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Profile tag "TAG_FUNCTION"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Profile tag "DESCRIPTOR"
Message Not available
Device type Profile tag "PROFILE_ID"
Manufacturer HW Config Type or Short description
Article number 1) Profile tag "ORDER_ID"
Serial number Profile tag "SERIAL_NUMBER"
Installation date Profile tag "INSTALLATION_DATE"
HW revision Profile tag "HARDWARE_REVISION"
SW revision Profile tag "SOFTWARE_REVISION"
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB

HART information according to HCF
The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Profile tag "TAG"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Profile tag "Description"
Message Profile tag "Notification"
Device type Profile tag "Device Type"
Manufacturer Profile tag "Manufacturer ID"
Article number 1) Not available
Serial number Not available
Installation date Not available
HW revision Profile tag "HW Revision"
SW revision Profile tag "SW Revision"
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB
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FF profile according to Fieldbus Foundation
The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Tag "TAG_DESC"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Not available
Message Not available
Device type Tag "DEV_TYPE" 
Manufacturer Tag "MANUFAC_ID"
Article number 1) Not available
Serial number Not available
Installation date Not available
HW revision Not available
SW revision Not available
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB

6.12.6 Identification data for objects in the user area

Where does the identification data for objects in the user area come from?
In the case of the faceplate for objects in the user area that are integrated using a device 
description (EDD), the identification data is provided via SIMATIC PDM.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification 
data

Origin

TAG / HID Parameter "TAG"
LID Parameter "Installation location"
Address Not available
Description Parameter "Description"
Message Parameter "Message"
Device type Parameter "Product name"
Manufacturer Parameter "Manufacturer"
Article number 
1)

"Article number" parameter 1)

Serial number Parameter "Device serial number"
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Identification 
data

Origin

Installation 
date

Parameter "Installation date"

HW revision Parameter "Hardware revision"
SW revision Parameter "Software revision"
Last update Time stamp of the updating of the PDM database
Comment CFC "Block comment"

1) Article number = also order number or MLFB

6.13 Overview of maintenance

6.13.1 Introduction and status diagram

Introduction 
The operators of the Maintenance Station and the Operator Station can be different individuals 
and can work in physically separate locations. 

As a result, the information flow between the Maintenance Station and Operator Station is not 
guaranteed.

Maintenance takes place in agreement with the plant operator.

Communication is supported by means of icons and messages.

This enables a coordinated maintenance sequence.

The maintenance sequence is documented and can be tracked.

Maintenance is initiated and edited in the faceplate in the "Maintenance" view       

Status diagram
The possible status transitions are explained in the diagram below.
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Actions of the maintenance engineer cause status changes. 

The next section provides detailed instructions for activating and deactivating a maintenance 
job.

Additional information
You can find additional information on the release for maintenance and on configuring the 
technological blocks in the online help Process Control System PCS 7; Advanced Process 
Library.

6.13.2 Sequence for maintenance

Introduction   
This section provides an overview of the sequence for maintenance.
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Maintenance can be initiated from the maintenance status "Good" of the component or after 
a message regarding the component.

Requirements
● The technological block has been interconnected in the CFC.

You can find information on interconnecting in the section "Engineering for maintenance 
(Page 91)".

● "Manual" or "On" mode is active for the technological block.

● The operator has the operator authorization "system operation".

Procedure for activating

Step 1
Maintenance engineer requests mainte‐
nance job

Result
Maintenance job requested

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. In the "Maintenance job" area, 

select, for example, the "Alarm" 
option button.

5. Click "On" in the operator panel for 
activating the maintenance job.

In the header of the faceplate and in the block icon, the 
"Maintenance alarm requested" status is displayed in the 
maintenance group display.

In addition, the maintenance job status "Maintenance engi‐
neer has not yet created a maintenance job" is displayed in 
the faceplate header.

An operator message is triggered.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 
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Step 2
Maintenance engineer schedules main‐
tenance job 

Result
Maintenance job scheduled

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "Planned maintenance" 

option button in the "Maintenance 
status" area.

5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "Maintenance engineer has not yet 
created a maintenance job" to the status "Planned mainte‐
nance".

An operator message is triggered.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 

Step 3
Maintenance engineer requests mainte‐
nance release

Result 
Maintenance release requested

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "Release request" option 

button in the "Maintenance status" 
area.

5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "Planned maintenance" to the status 
"Release request".

An operator message is triggered.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 
The following is displayed on the technological faceplate:
● Display of the release request (operator prompt)
● Message of "Request for operator input - General" class

Step 4 - Plant operator
Plant operator issues the release for 
maintenance 

Result
Release for maintenance is issued

1. Open the technological faceplate.
2. Select the "Parameter" view.
3. Activate "Release for maintenance".
4. Click "Yes" in the operator panel.

An operator message is triggered.
The release for maintenance is displayed in the diagnostic 
faceplate in the "Maintenance" view.
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Step 5
Maintenance engineer puts the compo‐
nent into "Maintenance status" 

Result
Maintenance of the component can be performed

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "In maintenance" option 

button in the "Maintenance status" 
area.

5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "Release request" to the status "In 
maintenance".

An operator message is triggered.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 
Depending on the configuration of the technological block, 
the following is displayed on the technological faceplate:
● Display of the maintenance demand and release
● "Out of service" mode and the "Maintenance demanded 

and maintenance release" icon
Maintenance can be performed. 

Procedure for deactivating

Step 1
Maintenance engineer completes main‐
tenance

Result
Maintenance complete

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "Completed" option 

button in the "Maintenance status" 
area.

5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "In maintenance" to the status 
"Good".
The text in the Memo area is deleted in the "Maintenance" 
view of the faceplate.
An operator message is triggered.
The entered text in the "Memo" area is displayed as a com‐
ment for the message in the operator input list of the faceplate 
and message system.
The "Maintenance demanded and Maintenance release" 
icon is hidden in the technological faceplate.
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Step 2
Plant operator ends the release for 
maintenance

Result
Release for maintenance is ended by the plant operator

1. Open the technological faceplate.
2. Select the "Parameter" view.
3. Disable the "Release for 

maintenance".
4. Click "No" in the operator panel.

An operator message is triggered.
The technological block is set to "Manual" mode.

6.14 Passivating PC objects

Introduction
With the "Passivate" function, a PC object is temporarily excluded from the monitoring during 
process control.

Overview
A PC object is passivated by the following operator actions:

● Operator actions in the faceplate in the "Maintenance" view
The operator actions are stored retentively and are retained even if there is a complete 
download to the OS station.
You can find additional information on this in the section ""Maintenance" view (Page 196)".

● Disabling/enabling process control
If the process control of a monitored OS station is deactivated, its PC object is automatically 
set to passivated. 
As soon as this OS station is restarted, the passivation is canceled again.

Available
This function is available on all IPC/PC stations.

Display 
If a PC object is passivated, "Passivated" is displayed as the maintenance state in the block 
icon and faceplate.

No group alarm is displayed in the maintenance group display of the PC object.

Messages
If a PC object is passivated by an operator input in the faceplate, an operator message is 
generated.
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All messages pending for this PC object are acknowledged automatically when the PC object 
is passivated.

As long as the PC object is passivated, no new messages are generated for this PC object.

Any pending events are signaled when the PC object is depassivated. 
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Integration of options 7
7.1 Integration by the Alarm Control Center

7.1.1 Application of the "Alarm Control Center"

Alarm Control Center   
The Alarm Control Center (ACC) is a SIMATIC PCS 7 add-on. With the available options, it 
can be customized for everything from stand-alone solutions to company-wide communication 
solutions.

Messages of the monitored components of the maintenance station can be forwarded to the 
Alarm Control Center for further processing.

The Alarm Control Center offers the following functions:

● Forwarding of messages to specific recipients

● Integrated shift and personnel management for time-dependent delivery of messages to 
different persons

● Extensive escalation system for reliable delivery of messages even when individual 
recipients cannot be reached

● Network-wide operator control and configuration through web capability

Note

You can use the Alarm Control Center only in the MS Standard and SIMATIC PDM MS 
versions.

Forwarding of messages to specific recipients
The following messages from an individual component can be forwarded:

● Diagnostic messages

● Messages about operations

● Messages about maintenance demanded

Recipients of messages that can be sent automatically via the ACC include, for example:

● SMS to mobile telephone

● Pager

● Voice output to a telephone

● E-mail

● LAN message to PC
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Integrating data into the Alarm Control Center
You can find information about the integration of the ACC in the MS as follows:

● In the documentation of the ACC

● Using the contact information in the catalog "Add-ons for the SIMATIC Process Control 
System PCS 7"

● From SIMATIC PCS 7 support

Exporting data for the Alarm Control Center
The export of component data to the Alarm Control Center takes place in the "Maintenance" 
view of the component in process control.

Select the relevant target in the "Target" area.
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"PC stations" area, 19
"User objects" area, 24

Configuring
Engineering station, 40
MS Client, 44
MS server, 41
MS single station system, 39
Redundant partner, 43

Create/update diagnostic screens
Procedure, 93
Settings, 75

Cyclically filtered complete export
Behavior, 128
Canceling, 132
Filter settings, 126
Function, 125
Starting, 131

D
Depassivation, 188
Device profiles, 56
Diagnostic screens

generating, 93
updating, 93

Diagnostic structure, 60, 63
deleting, 102
generating, 61
updating, 61
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Diagnostics
MS multiple-station system plant 
configuration, 27
MS single-station system plant configuration, 25
SIMATIC PDM, 89
SIMATIC PDM MS, 30

Diagnostics data
Exporting, 114

Diagnostics monitor
Call, 192

Diagnostics Monitor, 54
Display elements and operator controls

Faceplate, 179, 184
Documentation, 33

Access options, 12
Call, 11
for planning and configuration, 12

Downloading
Maintenance station, 95
SIMATIC PDM MS, 96

E
Engineering station

configuring, 40
Export

Individual export, 90
SNMP variable, 59

Exporting
Complete export, 89

F
Faceplate, 165

"CFU diagnostics" view, 232
"Connection display" view for client 
components, 204
"Connection display" view for server 
components, 206
"Connection load display" view for CPU 
connections, 217
"Diagnostics" view for AS objects, 208
"Diagnostics" view for field devices, 222
"Diagnostics" view for PC objects, 203
"Diagnostics" view for user objects, 228
"External diagnostics" view, 226
"Ident" view, 193
"Maintenance" view, 197
"Messages" view, 195
"Monitoring" view for user objects, 230
"Notes" view, 200

"OBx..." view for AS objects, 213
"Parameters" view for AS objects, 215
"Parameters" view for field devices, 226
"Performance" view for AS objects, 211
"Status" for CPU, 220
Display, 178
Display elements and operator controls, 179, 184
Display elements and operator controls for 
SIMATIC PDM MS, 185
Header, 179, 184
Header SIMATIC PDM MS, 185
LED display for CPUs, 221

Filtered cyclic parameter data export
Canceling, 163
EDD-based devices, 160
Filter settings, 157
Function, 156
Starting, 162

Filtered manual complete export
OPC/variables, 121

Filtered manual parameter data export
Behavior, 118
Canceling, 144
EDD-based devices, 140
Filter settings, 137
Function, 137
OPC/cancel, 153
OPC/for a selected device, 155
OPC/start, 153
OPC/Start time-controlled synchronization, 154
OPC/Stop time-controlled synchronization, 155
OPC/variables, 146
Starting, 143

Filtered manual parameter data synchronization
Stop time-controlled synchronization, 145

Filtered manual parameter export
Start time-controlled synchronization, 144

G
Group display

Overview area, 109

H
Hardware project

Calling, 189
HART modules, 89
Highest priority messages

Overview area, 107
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I
Identification data

AS objects, 239
Devices with device description (EDD), 240
IPCs, 236
Network objects, 238
Objects in the user area, 242
PCs, 237

IE/PB Link PN IO
Using, 52

Individual export
Executing, 197
Export file, 90
Overview, 90
Target directory, 67, 90

L
Lifebeat monitoring

Sign-of-life monitoring, 15
Locking

Messages, 110
Log of the diagnostic screens

Display, 94

M
Maintenance

Plant-specific, 81
Sequence, 244
Status diagram, 243
User-specific, 72

Maintenance actions
Configuring, 69

Maintenance demanded, 243
Maintenance group display

Display, 169
Maintenance information

Configuring, 72, 81
Maintenance job, 243

Display, 169
Maintenance links

Configuring, 65
Maintenance required, 243
Maintenance state

Display of components, 169
Messages, 108
Structure of the variable for the maintenance 
status, 172

Maintenance station
Compile, 95
Downloading, 95

Maintenance Station
Application, 15
Configuration, 18
PCS 7 Web client, 18
Version, 15

Maintenance Station Basic
Application, 15

Maintenance Station Standard
Application, 15

Maintenance status
Display for redundant components, 173

Maintenance targets
Configuring, 67

Manually filtered complete export
Filter settings, 116
Function, 115
OPC/start, 124
Starting, 120

Message correction, 133
Messages

Deleting, 133
Locking/unlocking, 110, 186
Maintenance state, 108
Without area information, 108

Module
Depassivation, 188

MS Basic
(See Maintenance Station Basic), 15

MS Client
configuring, 44
Installation on the ES, 27

MS multiple station system
Configure MS server, 36
Configure redundant MS server, 36
Maintenance Station, 27

MS multiple-station system
Configure MS client, 37
Configure OS/MS client, 37

MS server
Configure redundant partner, 43
configuring, 41

MS single station system
configuring, 39

MS single-station system
Configuring, 35
Maintenance Station, 25

MS Standard
(See Maintenance Station Standard), 15
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Multiproject
Setting, 38

N
NDIS adapter, 54

O
OPC Server, 54

Assign components, 57
Inserting in redundant partner, 59

OS simulation
Starting, 105

Overview area
Area button, 109
Group display, 109
Highest priority messages, 107
State of the areas, 107
User interface, 107

Overview screen, 111
Functions, 113

P
Parameter data export using the faceplate

Opening a faceplate, 137
Passivating

PC objects, 248
PC

Monitoring, 54
PC objects

Passivating, 248
PCS 7 Web client

"Maintenance"/print view, 200
Maintenance Station, 18
Message correction, 133

PDM Maintenance Station
Application, 15

Picture structure
create, 79

Plant configuration
MS multiple station system, 27
MS single-station system, 25
OS single-station systems, 29
SIMATIC PDM MS, 30

Plant hierarchy, 60, 63
Settings, 61

Preface, 11
Process control

Starting, 105

R
Redundant components, 235
Release request

Make interconnections, 91
Reset

Field devices, 135
PC stations, 133
User area, 136

Resetting field devices, 135
Resetting PC stations, 133
Resetting the user area, 136

S
Scope of the manual, 11
Server data, 28
Setting

Multiproject, 38
Sign-of-life monitoring

Lifebeat monitoring, 15
SIMATIC PDM, 89

Calling, 190
SIMATIC PDM MS, 30

(See PDM Maintenance Station), 15
Compiling, 96
Configuring, 37
Downloading, 96
Header, 185
Project, (Creating)
Sample project, (Overview), (use)

SNMP service, 54
SNMP variable

exporting, 59
State of the areas

Overview area, 107
Status diagram

Maintenance, 243
Structure of the variable

For the maintenance state, 172

U
Unlocking

Messages, 110
User diagnostic screens

Configure group display hierarchy, 88
Creating, 87

User diagnostic structure
Configuring AssetM, 86
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Creating, 84
Creating a CFC, 85
Overview, 82
Updating in the multiproject, 87

User interface
Button area, 110
Layout, 106
Overview area, 107
Working area, 110

V
Version, 60, 63

Maintenance Station Basic, 15
Maintenance Station Standard, 15
SIMATIC PDM Maintenance Station, 15
Specifying, 61

View
CFU diagnostics, 232
Connection display for client components, 204
Connection display for server components, 206
Connection load display for CPU 
connections, 217
Diagnostics for AS objects, 208
Diagnostics for field devices, 222
Diagnostics for PC objects, 203
Diagnostics for user objects, 228
External diagnostics, 226
Ident, 193
LED display for CPUs, 221
Maintenance, 197
Messages, 195
Monitoring for user objects, 230
Note, 200
OBx for AS objects, 213
Parameters for AS objects, 215
Parameters for field devices, 226
Performance for AS objects, 211
Status of the CPU, 220

W
Web page

Calling, 65, 191
Web pages

"Overview" button, 114
Faceplate, 188

Working area, 110
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